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Visual License Agreement
VISUAL® SOFTWARE LICENSE AGREEMENT

Set out below are the terms and conditions under which you (either an individual or a single business entity, collectively referred to as "You" or "Your") are permitted to use the software product
identified above in the title of this Agreement, which includes computer software (the “Program”) and, as applicable, associated media, printed materials and “on-line” or electronic documentation (the
“Documentation”). Carefully read all the terms and conditions of this Agreement before using the Software Application. BY USING THE SOFTWARE APPLICATION, OR BY CLICKING THE “I AGREE” OR
SIMILAR ICON, OR BY INSTALLING OR COPYING THE SOFTWARE APPLICATION, YOU AGREE TO BE BOUND BY THE TERMS OF THIS LEGAL AGREEMENT BETWEEN ACUITY BRANDS LIGHTING,
INC. ("ACUITY BRANDS LIGHTING") AND YOU AND YOU REPRESENT THAT YOU HAVE FULL POWER AND AUTHORITY TO ENTER INTO THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS
OF THIS AGREEMENT, DO NOT USE OR INSTALL OR COPY THE SOFTWARE APPLICATION.

1.0 Ownership

The Program is proprietary to Acuity Brands Lighting and its licensors, and is protected under applicable copyright and/or trade secret laws. All right, title and interest in and to the Program shall remain
with Acuity Brands Lighting, Inc. and its licensors. This Agreement does not constitute a sale of the Program, but only conveys to You a limited right to use the Program in accordance with the terms of
this Agreement. Acuity Brands Lighting and its licensors retain all rights in the Program not expressly granted.

2.0 License Grant and Termination

You are granted a limited, revocable, nonexclusive, nontransferable license to use the Program on a single computer in accordance with the Documentation only in connection with Acuity Brands
Lighting ‘s products and services. All proprietary notices in or on a Program shall be duplicated by You on all copies of the Program and shall not be altered or removed. Except as expressly permitted
herein, You may not alter, modify, copy, disassemble, decompile, reverse engineer, create derivative works from, or sell, sublicense, rent, or otherwise transfer to any other person or entity, the Program
or the Documentation. Your right to use the Program shall terminate upon Your failure to comply with any term or condition of this Agreement. Upon termination of the licenses granted herein, You must
cease all use of the Program and destroy the Program (including all copies thereof) and all Documentation, and certify to Acuity Brands Lighting that all Program and Documentation have been so
destroyed. All other rights and obligations set forth herein shall survive termination of the licenses granted herein.

3.0 Privacy

When You order and/or interact with this Program through the Visual® website, Your ordering and interaction is subject to the terms of the Acuity Brands Privacy Policy accessible from the site. In
addition, when You use this Program, Acuity Brands Lighting may collect and store some or all of the following: (1) log-in data and (2) information about how You use the Program, such as information
about products with respect to which the Program is used. Acuity Brands Lighting, Inc. uses this information to operate and improve the Program and may use and share this information, but only in
anonymous, filtered, or aggregate form, for general business purposes. The information this Program collects may be stored locally on Your computer and may be transmitted to our servers in the
United States. The transmission of information over wireless and wired networks is not inherently secure. As a result, Acuity Brands Lighting. does not guarantee, and You should not expect that Your
information will always remain private when using this Program. Acuity Brands Lighting reserves the right to make changes to these privacy practices from time to time. Any changes will take effect upon
the expiration of thirty (30) days after notification via the Visual website. If You do not agree to any changes, You have the right to uninstall and discontinue using the Software. Any use of the Software
after the thirty (30) day notice period constitutes Your acceptance of any change.

4.0 Disclaimer of Warranty

THE PROGRAM LICENSED HEREIN IS LICENSED "AS IS" AND ACUITY BRANDS LIGHTING MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, WHICH MIGHT
OTHERWISE APPLY TO THE PROGRAM OR DOCUMENTATION. ALL WARRANTIES AND CONDITIONS OF ANY KIND, PAST OR PRESENT, WHETHER STATUTORY, COMMON-LAW OR FROM A
COURSE OF DEALING OR USAGE OF TRADE, INCLUDING, WITHOUT LIMITATION, IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE, ACCURACY, RESULTS, OUTPUT, OR SECURITY ARE HEREBY EXPRESSLY DISCLAIMED TO THE FULLEST EXTENT PERMITTED BY LAW. Acuity Brands Lighting. does not warrant that
the operation of the Program will be uninterrupted or error-free,, or that the Program will meet Your requirements. Program calculations and lighting equipment design specifications are determined
based on methods recommended by the Illuminating Engineering Society (IES) and/or or standard industry practice, but Acuity Brands Lighting. does not warrant that the layout for any project will
comply with IES standards.

5.0 Limitations

The Program includes lighting design and analysis tools and performs general lighting and ultra-violet germicidal irradiation (“UVGI”) calculations, using publicly available sources of data and/or user
provided data. Calculated values are based on such input data, although photometry extrapolated from a test using a different lamp than indicated may be used. End-user environment and application
(including, but not limited to, voltage variation and dirt accumulation) can affect uniformity, glare or other photometric issues, and can cause actual performance to differ from calculated values. As the
user of the Program, You are solely responsible for the selection of the Program to achieve your intended results, for the installation and use made of the Program, and for the results obtained from the
Program. For clarity, You are solely responsible for selection of appropriate lighting products and applications that meet the applicable project requirements for lighting and illumination, including
requirements for lighting system suitability and safety. The designs, analyses and calculations provided by this Program are not a substitute for independent engineering analysis and testing, whether
for lighting safety, system performance, suitability of products, or effectiveness of analyses for use in a particular application.

IN NO EVENT SHALL ACUITY BRANDS LIGHTING, INC., ITS AFFILIATES OR LICENSORS (THE “ACUITY PARTIES”) OR THE NEW YORK STATE ENERGY RESEARCH DEVELOPMENT AUTHORITY
(“NYSERDA”), ST. VINCENT'S HOSPITAL OR MOUNT SINAI HOSPITAL (WHO, UNDER NYSERDA AGREEMENT 9425, PERFORMED A VALIDATION STUDY OF THE UVGI CALCULATIONS) (THE “UVGI
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PARTIES”) BE LIABLE WHETHER IN CONTRACT OR IN TORT, FOR ANY LOSSES, INJURIES OR DAMAGES OF ANY KIND,TO ANY PERSON OR ENTITY (INCLUDING WITHOUT LIMITATION, ANY
DIRECT, INDIRECT, CONSEQUENTIAL, SPECIAL, MULTIPLE, EXEMPLARY, PUNITIVE OR INCIDENTAL DAMAGES WHATSOEVER) ARISING OUT OF OR RELATING TO ANY USE, INABILITY TO USE,
CONDITION, PERFORMANCE, DEFECT OR FAILURE IN, OR IMPROPER APPLICATION OF, THE PROGRAM OR THE RESULTS OF THE PROGRAM (INCLUDING, WITHOUT LIMITATION, DAMAGES
RESULTING FROM DIFFERENCES BETWEEN MEASURED LIGHTING SYSTEM PERFORMANCE AND LIGHTING SYSTEM PERFORMANCE PREDICTED BY USING THE PROGRAM, DAMAGES
RELATED TO SAFETY ISSUES THAT MAY ARISE FROM USE OF THE RESULTS OF THE PROGRAM, DAMAGES RELATED TO USE OF THE PROGRAM TO CREATE LIGHTING DESIGNS FOR
HAZARDOUS ENVIRONMENTS, DAMAGES FOR LOSS OF BUSINESS PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHER PECUNIARY LOSS, OR DAMAGES FOR
LOST OR CORRUPTED DATA), PROGRAM EVEN IF THE ACUITY PARTIES OF THE UVGI PARTIES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL THE TOTAL
LIABILITY OF THE ACUITY PARTIES OR THE UVGI PARTIES TO YOU OR ANY OTHER PARTY FOR ANY LOSSES OR DAMAGES RESULTING FROM ANY CLAIMS, DEMANDS OR ACTIONS ARISING
OUT OF OR RELATING TO THIS AGREEMENT OR YOUR USE OF THE PROGRAM OR DOCUMENTATION EXCEED THE LICENSE FEES PAID FOR USE OF THE PROGRAM OR $10, WHICHEVER IS
GREATER. Some states or jurisdictions do not allow the exclusion or limitation of certain damages. The limitations provided in this License Agreement are intended to apply to the fullest extent allowable
under applicable law.

You release and waive all claims against the Acuity Parties and the UVGI Parties, and the directors, trustees, officers, shareholders, employees, agents and representatives of each of the foregoing,
from any and all claims, damages, liabilities, costs and expenses arising out of Your use of the Program. If You are a California resident, You waive any rights You may have under §1542 of the
California Civil Code, which reads: “A general release does not extend to claims which the creditor does not know or suspect to exist in his favor at the time of executing the release, which if known by
him must have materially affected his settlement with the debtor.” You agree to release unknown claims and waive all available rights under California Civil Code §1542 or under any other statute or
common law principle of similar effect. To the extent permitted by applicable law, this release covers all such claims regardless of the negligence of the Acuity Parties or the UVGI Parties.

6.0 Export

You acknowledge that the Program is subject to restrictions and controls imposed by the United States Export Administration Act (the "Act") and the regulations thereunder. You agree and certify that
neither the Program nor any direct product thereof is being or will be acquired, shipped, transferred or re-exported, directly or indirectly, into any country prohibited by the Act and the regulations
thereunder or will be used for any purposes prohibited by the same.

7.0 Government Users

The Program is provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by or on behalf of the United States of America, its agencies and/or instrumentalities is subject to restrictions as set
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013, or subparagraphs (c) (1) and (2) of the Commercial Computer-Restricted Rights
at 48 CFR 52.227-19.

8.0 Miscellaneous

This Agreement shall be construed in accordance with the laws of the State of Georgia. You agree that the exclusive jurisdiction for any claim or action arising out of or relating to this License
Agreement shall be filed only in the state or federal courts located in the State of Georgia, and You further agree and submit to the exercise of personal jurisdiction of such courts for the purpose of
litigating any such claim or action. This Agreement may not be altered or amended except by a written document signed by an authorized officer of Acuity Brands Lighting, Inc. You may not assign this
Agreement or any rights or obligations hereunder to any other person or entity without the prior consent of Acuity Brands Lighting, Inc.

Should you have any questions concerning this Agreement or the Programs, or the Documentation, please contact Acuity Brands Lighting, Inc. by calling (800) 279-8043.



System Requirements
Visual has been developed for the Microsoft Windows operating system. The minimum system requirements for Visual 2.7 are:

Operating System: Microsoft Windows XP/Vista/Windows 7/ Windows 8

Processor: Intel Dual or Quad Core (2.4 GHz minimum) 32 or 64 bit

Memory: 2GB minimum, 4 GB recommended

Video Card: 256MB RAM, 512MB recommended, supports Open GL

Hard Drive: 80 MB to 120 MB available space

Virtual Memory: Minimum set to 3000 MB Learn how to change your virtual memory

 

http://www.visual-3d.com/Support/TechInfo/VirtualMemory.aspx


Windows Firewall
One of the security features that Microsoft provides to keep your information private is the Windows 7/8 Firewall. To get the most out of the firewall, you need to tell Windows to allow certain trusted
programs to break through. Images from Windows 7 are shown. Individual system configuration may vary, but the commands necessary are in the same place(s).

A firewall is designed to keep your computer safe from outsiders by preventing anyone
or any program from entering or exiting your computer via the Internet. Programs that
you have that need to access the Internet, such as Visual Lighting Software, are going
to be stopped dead in their tracks. To keep things running smoothly, you need to tell
Windows Firewall which programs are safe.

 

Open the Windows Start Menu and select Control Panel.  

Select System and Security .  

Select Allow a program through Windows Firewall .  
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Click Allow Another Program  at the bottom of the dialog.  

Locate the entry “Visual 2012” and select Add.

Close Control Panel by clicking the red X.

 

Use of other security and/or firewall software may impact program operation. Modification of settings in non-Windows applications is the responsibility of individual users and is not supported.
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Proxy Servers
If you have a proxy server, you need to set it to work properly with Visual.

Open the Windows Start Menu and select Control Panel.  

In the Control Panel, select Network and Internet.  

In the Network and Internet settings dialog, select Internet Options.  

In the Internet Properties dialog, select the Connections tab. Then select LAN Settings
at the bottom of the dialog.

 

In the Proxy Server section of the dialog that appears, click the checkbox if necessary
and then click the Advanced button.
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In the Exceptions section, add an entry for Visual that includes the separating
semicolon and "*.visual-3d".

 

Close all dialogs that remain open by clicking OK as necessary. This setup is independent of the web browser(s) used on the computer.



Installa�on, Registra�on and Technical Support
Installa�on

1. Download the setup program from www.visual-3d.com/Software/Download.aspx .

2. The Visual Installation program will begin running. Follow the instructions that appear on your screen.

3. Visit www.Visual-3D.com to check for program news and updates.

 

Manual Comments

Comments on the User's Guide are welcome at: support@Visual-3D.com

If you search for an Index topic and it isn't there, please Email us your Index topics

 

Registra�on

It is important that we keep all users informed of updates for Visual. To register as a Visual user, please create an account on the Visual website: www.Visual-3D.com

 

Technical Support

For technical support questions, please visit the Support section of the Visual website or contact the Visual Support Center via email or telephone:

Internet: www.Visual-3D.com

Email: support@Visual-3D.com

Phone: 1-800-279-8043, Monday - Thursday 7:30 AM-5:30 PM EST and Friday 8:00 AM - 12:00 PM

 

http://www.visual-3d.com/Downloads/Software/Software.aspx
http://www.visual-3d.com
mailto:support@Visual-3D.com?Subject=Visual Help Manual Comments
mailto:support@Visual-3D.com?Subject=Visual Help Manual - Please add this Index topic
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Chapter 1 - Visual Interface
The Visual interface consists of the Ribbonbar, Design Window, Status Bar, and Sidebar. The following chapter is meant to provide an overview of the basic functionality and graphical
layout of each of these program components. Details will be discussed in subsequent chapters.



1.1 Design Environment
The Design Environment is the central element of the Visual interface and is where most user interaction takes place. It also serves as the gateway to all of the other elements. This is where
the lighting model is constructed and analyzed to develop a final design.

The Design Environment has four components;
Ribbonbar, Design Window, Sidebar, and Status bar.
 The Quick Access Toolbar is additionally located at the
upper left to hold common commands. Each element handles
a specific function that remains consistent throughout program
operation.

An overview discussion of each is provided in this chapter,
while specific command execution is discussed in other
chapters.
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1.1.1 Quick Access Toolbar
The Quick Access Toolbar in the upper left corner of the Design Environment provides convenient access to common commands in the Visual title bar.

Default commands are Save, Open, Print Editor, Undo, Redo, Calculate, and
Properties. The Quick Access Toolbar can be customized with commands
useful to each user by clicking the down arrow on the right side of the buttons.

 

See Customize Dialog for more information.

 

file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_10_Tools/10.1_Customize_Dialog.htm


1.1.2 Ribbonbar
The Ribbonbar is the graphical menu interface housing all Visual commands. The commands on each tab are sub-grouped into panels to make navigation easier. Using a Ribbonbar style
allows easier location of commands via images and text that then allows for more commands to be shown.

Common commands are located on the Home tab.
Subsequent tabs group commands into different function
families.

 

The presence of a small downward arrow below the button
graphic indicates a sub-menu is available for more detailed
selection.

For example, there are four options for placing a Calculation
Zone as shown at right.

 

When executing a command, the context-sensitive Properties
tab will appear. The Properties tab provides an interface for
the specification of command parameters.  As an example, the
Properties tab that appears after executing the Line
command is shown at right. This allows for the specification of
object parameters at creation.

 

The Lock in the upper right corner of the Ribbonbar makes
the Ribbonbar behave more like a menu system in that after
navigating to a tab and executing a command, Visual will return
to the Home tab. Otherwise, the selected tab continues to have
focus.

 

While executing Modify commands (Copy, Move, Erase,
etc) the Properties tab will display the Selection and Object
Filters panels. These buttons and checkboxes allow you to
decide which objects Visual  will "grab" if selected. For more
information about object selection, reference Selecting Objects.
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On command tabs, the View panel is shown to enable quick
use of those functions as the design is completed.

 

Visual shows the Instructions panel on the Properties tab to
provide step-by-step instructions related to commands.

 

For more information about navigation, reference Getting Started. For more information on each tab see The Command Tabs.
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1.1.3 File Menu
The File menu is a part of the Ribbonbar but functions like a traditional menu instead of as part of the ribbon. The File menu is where new projects are created, VSL files are opened and saved,
projects are verified with the Audit command, DWG and DXF files are imported and exported, and the Print Editor is accessed.

After clicking the File menu button, a drop-down menu will appear allowing further
selection of several commands.

The presence of an ellipsis (...) following a menu command indicates that the
command provides access to a dialog form, most of which should be familiar to users
of other Windows-based applications.

The presence of a small right-arrow indicates that further command specification is
required in the form of a sub-menu, and placing your mouse over that item will cause
the sub-menu to appear at which point a selection can be made.

 

For more information see specific File Commands in the Chapter 12.
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1.1.4 Command Tabs
Tabs group commands into different function families that align with the modeling process; construct objects, possibly modify them, then define luminaires, place calculation zones, and finally view
the model. The commands on each tab are sub-grouped into panels to make navigation easier.

The Home tab contains common commands and sub-menus
used the most. Remember that the presence of a down arrow
means there is a sub-menu present; hover the mouse over
buttons to see the sub-menu.

 

The Construct tab contains commands used to build a model.
There a panels for both solid object commands and reference
object commands. The Navigation panel is included to change
the view.

 

The Modify tab contains two kinds of commands to modify the
design: some commands create objects from other objects and
others modify the base object. The Navigation panel is
included to change the view.

 

The Luminaire tab contains commands to build a Luminaire
Schedule, place Luminaires, and modify Luminaire display.
The View panel is included to change the view.

 

The Calculations tab contains commands to place Calculation
Zones and remove (Mask) points from those zones to fit
detailed scenarios, insert Power Density Zones, and sub-divide
Calculation Zones into different Statistical Zones if necessary.
This is also where the design is Calculated and Rendered. The
Navigation panel is included to change the view.

 

The View tab contains commands to change how the model
appears, provides access to saved views, and provides  in-depth
navigation commands to manipulate how the model is viewed.
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The Tools tab contains links to web-based design tools,
measurement commands, and buttons to initiate dialogs to
change Visual options.
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1.1.5 Design Window
The Design Window comprises the majority of the Design Environment screen. This is where lighting models are constructed, displayed and analyzed.

Think of the Design Window as the view port to the lighting
model. There are a number of ways to manipulate the view
port. It can be translated (left, right, up, or down), moved
rotationally around the lighting model (also referred to as
"orbiting"), and zoomed in and out. See View.

In Visual, the mouse cursor is a set of crosshairs colored for
identification. The cursor changes to the standard arrow when
it is outside the Design Window. See Mouse Pointer
Navigation.

The Global Axis icon in the lower left of the Design
Window can be turned on or off as desired. See
Environment Settings.

 

 

For more information, reference Getting Started.
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1.1.6 Status Bar
The Status bar is located at the bottom of the Design Environment screen, and provides continual feedback, handy tools, and command entry. The Status bar is always present at the bottom
of the screen and contains various buttons and feedback mechanisms to make designing easier. A toggle button with a gold color indicates the mode associated with that button is in operation as
is shown below for Snap Mode.

The purpose of the Command Line is to provide dynamic feedback and allow
coordinate entry related to commands during program operation. Once a command
has been initiated, the Command Line prompts the user for subsequent information
such as coordinate and object selection. In certain cases, numerical coordinate entry
is supported and the Command Line will convert to a text box to allow such data to
be entered manually (as shown for the Move command).  For more information,
reference Entering Coordinates.

 

Absolute Coordinates reports the exact location (Cartesian X,Y,Z) of the mouse
crosshairs within the modeling space with respect to the origin (0,0,0). For more
information see Cartesian Coordinates.

 

Relative Coordinates reports the location (Cartesian X,Y,Z) of the crosshairs within
the model space relative to a previously selected coordinate while in a command.
Visual additionally displays polar coordinates (distance and an angle). Relative
Coordinates are only reported for subsequent coordinate selections and are useful
when relative distances are more convenient or intuitive than absolute locations. For
more information also see Cartesian Coordinates.

 

The View Angles section shows reference angles for how the lighting model is
currently being viewed.

 

The Orthogonal Mode button allows the Orthogonal Mode to be turned on or off
and indicates the mode is active when it has a gold background. This mode restricts
movement to being perpendicular or parallel to the coordinate axes.

 

The Snap Mode button is a toggle button that allows the Snap Mode to be turned
on or off and indicates the mode is active when it has a gold background. The Snap
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Increment combo box indicates what increment Visual will use if that mode is
activated. Clicking the small down arrow initiates the list box for common selections
(part of which is shown at far right. Custom values can be typed into the box. See
Incremental Snap for more information.

The Object Snap buttons allow specific modes to be activated that help to draw
objects more accurately. The icons provide visual cues to the modes of: endpoint,
midpoint, center, intersection, and perpendicular. A mode is active when it has a gold
background. See Entering Coordinates for more information.

 

The Zoom buttons allow the quick change of the view by: Zoom All, Zoom
Window, Zoom Previous, Zoom In, Zoom Out, and Zoom to Center. For more
information see Zoom and Basic Viewing.

 

The Align Cursor to Plane and Align Cursor and Plane to Current View
buttons allow for easier construction of objects in specific planes. See

 

The Calculation Status and Mode indicates whether an interior or an exterior
scheme will be used and if only direct illuminance will be calculated or if interreflected
illuminance will also be calculated and presented. This field also displays units that are
used; this can be feet or meters for length and footcandles or lux for illuminance. Left-
click this field to display information about the last calculation time.

 

Calculation Type shows if electric lighting only or electric and daylighting is/are
calculated. Daylighting is an additional module that can be included in Visual. See
www.visual-3d.com for more information on installing daylighting capability.

 

Luminaire Counter as the name implies, provides an up-to-date count of the total
number of luminaires in the lighting model.
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1.1.7 Proper/es Tab
When executing commands, Visual will display the Properties tab in the Ribbonbar. This part of the Ribbonbar is a dynamic feature that allows unique attributes such as text description,
reflectance, and height to be assigned to objects as they are being created.

The Properties tab is considered dynamic because its
contents change depending on the active command.

Specific elements of the Properties tab are discussed in the
related section for each command that displays the tab.

 

The Properties tab works in conjunction with the Command Line in the Status bar to provide complete command specification while holding parameters constant that might be used with that
command upon the next execution.

For example, specifying a 9ft luminaire mounting height when
placing luminaires in one instance is likely to be applicable the
next time the command is used.

Specifying a parameter does not change the Visual defaults.

 

In commands where objects need to be selected, the Properties tab will include the Selection, Selection Filters, and View panels.

The Selection and Selection Filters panels assist in
selecting objects. See Selecting Objects for more information.

The View panel is simply the Navigation panel as described
in Basic Viewing.

 

The Properties tab is separately shown when executing the Properties command. In this mode, additional tools are provided for advanced object selection.

In addition to the Selection and Selection Filters panels, the Properties tab will
contain the Filters and Selection Modes panels that allow for further refinement of
what objects Visual will add to the selection set. See Ribbonbar Properties Tab for
more information.

 

More information on specific Properties tab tools and function is included as necessary in this document as commands are discussed.
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1.1.8 Sidebar
The Sidebar provides convenient access to three tabs of information that also allow for the modification of model object parameters and the display of calculation results.

The Layers tab contains the Layer Manager that controls the basic system layers
as well as user-defined layers related to properties and visibility. See Layer Manager
for more information.

Most layer functionality is considered an advanced topic; layer functionality in Visual
can be quite robust and complex. Complex designs can however be completed with
simply the default System Layers and modest if any use of this dialog.

 

The Properties tab displays context-sensitive fields to control the four object types
individually or in groups. When objects are selected, all parameters that can be user-
modified will be displayed. See Properties for more information.

As with the Layers tab, most use of this dialog is an advanced topic.

The display name on the tab itself will change depending on which object type is being
edited; for example, the tab will display "Luminaires" when Luminaires have been
selected for modification. When different object types are selected, the tab will display
"Shared Properties".

 

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_4_New_Features/Layers/4.3.5_Manager.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_4_New_Features/Properties/4.4_Properties.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


The Statistics tab displays information related to the various Calculation Zones
and Statistical Zones placed in the model.

The typical statistical information is displayed, but additional fields can be added in the
Settings dialog. See Calculations Settings.

Clicking on a zone name will show the basic properties for that zone at the bottom of
the tab. See Statistics for more information.

Use of the Statistics tab is a basic function in the use of Visual.

 

The Sidebar can be resized by left-click-drag after clicking the divider between the
Design Window and the Sidebar. The cursor will change to a "double slider" to
indicate the operation can occur.

 
       (shown 2x normal size)

On occasion, Microsoft Windows and Visual don't communicate properly. This most
often results in the tabs at the bottom of the Sidebar disappearing. To fix this issue
see Reset Windows. This also resets the width of the Sidebar if it has been changed.
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 1.1.9 Command Line
One of the most important parts of the Status Bar is the Command Line. The Command Line provides feedback for each command related to necessary user inputs and allows for the input
of coordinate information if desired.

Commands have a step-by-step process that must be followed. The Command
Line provides text cues related to what type of input Visual needs to proceed.
Examples being "Select Objects" and "Base Point (X Y Z)".

Reading the Command Line provides on-the-fly command reference as does the
Instructions panel on the Properties tab of the Ribbonbar. Related information
can be found in Selecting Objects.

 

Note that all commands are moved from one step to the next by right-clicking the
mouse or pressing the Enter key.

See Using the Mouse and Keyboard Commands for detailed information.

 
  

The Command Line is where coordinate information is input via the keyboard. It may
be necessary to left-click on the Command Line to tell Visual to place focus there to
accept input if focus has been previously placed somewhere in the Properties tab.

See Command Line Entry for detailed information.
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 1.2 Se3ngs Form
The Settings form is accessed through the Tools tab of the Ribbonbar. This is where parameters affecting the global operation of Visual are found.

The Settings form provides a means for customizing the interface to meet specific
needs and/or user preferences.

Category selection is made from the tabs and the available options are shown in
panels in each tab. Settings are logically grouped and labeled for easy identification
within each category tab.

Graphics are included where appropriate.

 

For more specific information related to the use of the Settings form or any of the Visual options, reference Settings Dialog.
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1.3 Customize Form
The Customize form is accessed through the Tools tab of the Ribbonbar.

This multi-tab form is where you set the more program-specific options such as
making a custom toolbar, modify Quick Access toolbar buttons, assign or change
keyboard shortcuts, and change how menus behave.

 

For more specific information related to the use of the Customize form or any of the Visual options, reference Customize Dialog.
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1.4 Luminaire Schedule
The Luminaire Schedule is accessed through the Luminaire tab of the Ribbonbar. This is where the luminaire schedule is constructed to establish the various luminaire configurations
available for use within the Design Environment.

Luminaire Types are arranged in a scrolling spreadsheet format for easy and
intuitive assignment of photometric information, symbols, descriptions, and design
templates.

Photometric and descriptive information is accessed by selection of a valid
photometric file, and you may then modify the symbol, assign templates as
appropriate, and view a photometric report. Schedules can also be imported and
exported in a VSC format only useful in Visual or exported in a CSV format for use in
various spreadsheet programs.

 

When selecting a new Luminaire, Visual opens the Select a Photometric File
dialog that is more complex but yet considerably more useful than the standard
Windows dialog used for file selection elsewhere.

Visual includes an Acuity Brands photometric database but IES files from any
manufacturer can be selected. When using Acuity Brands files, the dialog shows
additional product information and graphics to make selection easier.

All IES files in a directory chosen in the left pane will be displayed in the upper right
pane in a list format showing key parameters. After left-clicking a filename, Visual will
display basic photometric information in the lower panel.

 

Once a photometric file has been chosen, it is possible to modify the Symbol by left-
clicking the Symbol in the Luminaire Schedule, which initiates the Luminaire
Editor. Visual chooses a Symbol that most closely resembles the basic form of the
luminaire based on the luminous dimensions in the IES file, but any Symbol can be
chosen.

 

The Luminaire Editor additionally allows for the selection and basic modification of
complex solid models for Shaded and Rendered views. Models are included and
automatically selected for Acuity Brands products. The inclusion of models for other
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manufacturers is a manual process that first requires a valid model file to be available;
creation is explained in the Luminaire Solid Models appendix.

For more specific information related to the use of the Luminaire Schedule, reference the Luminaire chapter.
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1.5 Print Editor
The Print Editor is accessed through the File option in the main menu. This separate window that opens on top of the main Visual window is where printable Pages are composed to illustrate
the lighting design built in the Design Environment.

Multiple Pages can be built with different to-a-scale views, snapshots, schedules,
notes, and statistics. Images, text, and PDF files can be placed, as well as
specification sheets and images for Acuity Brands products.

The Title Block is customizable with graphics, borders, and other elements to
provide a unique printed Pages if desired.

The layout and content of some elements can be saved as the default for future use.

 

For more specific information related to the use of the Print Editor, reference Print Editor.

file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/11_-_Print_Editor.htm


1.6 Upda/ng Visual
Updates to Visual are continually posted in order to improve program performance and address issues related to specific lighting model creation resulting from different user approaches to
construction.

When Visual is started, a license check is done via the internet. In that process,
version numbers are compared and Visual will display an Update Available button at
the right end of the Ribbonbar.

Clicking the button launches the Visual download page in a web browser to allow for
download.

 

 

javascript:TextPopup(this)
javascript:TextPopup(this)


Chapter 2 - Ge�ng Started
The Visual user interface incorporates standard elements of software design to allow for easy basic operation of the program. There are many elements that will be familiar to users of Windows-
based programs in general, and users of Computer Aided Design (CAD) software will find further similarities to those programs in both how Visual looks and how it operates.

This chapter discusses basic navigation using the mouse and keyboard as well as some of the basic file functions necessary to work with Visual.
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2.1 Cartesian Coordinates
The Cartesian coordinate system is the basis for location information in Visual. This system uses 3 numbers to describe point locations from an origin.

The X and Y-axes generally correspond to dimensions of length and width while the Z-
axis corresponds to that of height as indicated in the diagram at right.

Distances are given in a triplet of dimensions written as (X,Y,Z). As defined (noting it is
dependent on view angle as in the view at right), the X-axis is oriented left-to-right, the
Y-axis is oriented top-to-bottom, and the Z-axis is oriented up-to-down (or in and out of
the plane of the screen).

Visual assumes a Z-dimension of zero if coordinates are specified as a couplet (X,Y).

Positive dimensions are to the right, toward the top, and up or out of the screen.
Conversely, negative dimensions are to the left, toward the bottom, and out of the
screen.

Isometric views that are from an angled vantage point are labeled like a compass. In
the example to the right, the diagram is viewed from the NE direction.

 

The origin (0,0,0) is not labeled in Visual and it is not necessary to construct objects
starting at the origin. Objects can be placed anywhere in the model space.

An Axis can be drawn for reference in the Design Environment as is shown at
right for all three axes, noting that the color of each axis has been changed to
coordinate to the axis colors used in Visual.

 

Absolute Coordinates are those that are specified and entered with reference to
the origin (0,0,0). These coordinates are displayed in black in the top of the Status
Bar. Visual displays the coordinates of the cursor in this part of the Status Bar at all
times. Absolute Coordinates can be displayed at/with the mouse crosshairs, see
Environment Settings.

 

Relative Coordinates are displayed in the Status Bar while in a command. The
origin for Relative Coordinates is the initial point of user input. For example, Visual
will display an (X,Y,Z) of (10,5,0) in the blue coordinates on the bottom of the Status
bar if the mouse is moved 10 units to the left (+X) and 5 units up (+Y). The Z-
dimension is 0 because the drawing is assumed to be done in a plane unless user
input changes that.  Relative Coordinates can be displayed with the mouse
crosshairs, see Environment Settings.

 

As an additional part of Relative Coordinates, Visual displays the polar coordinates
as a length and an angle. These reference a line created by extending from the first (or
last) selection point made in the command to the current mouse position.  The angle
shown is between this same line and the X-axis.   The "line" may be imaginary
depending on the command executed; e.g. when drawing a rectangle.
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Coordinate entry is further explained in Entering Coordinates and as required for specific commands.

javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_2_Getting_Started/Entering_Coordinates/2.10_Entering_Coordinates.htm


2.2 Using the Mouse
Users with Computer Aided Design (CAD) experience will find the manner in which Visual uses mouse clicks to be very familiar. Mainly, left-clicking selects objects, and right-clicking ends
commands or initiates context-sensitive menus.  The advanced user should have no trouble seeing where and what to click and when to click to provide the input indicated in the Status Bar.

In Visual, the following mouse operations are recognized:

Left-click - Click the left mouse button once
Double-click - Click the left mouse button twice rapidly
Right-click - Click the right mouse button once
Roller wheel (if equipped)

  

Use left-click to:

Select a menu item, Ribbonbar button, or other graphical control
Select a coordinate location
Select an object
Begin a selection fence or window
End a selection fence or window
3D orbit in the Design Window (holding the left button down while orbiting)

 

Use double-click to:

Select and open/import a file
Select all text in a field for editing

 

Use right-click to:

End the current command
Move to the next segment of a command, such as closing a polygon
Reissue the previous command when inside the Design Window
Initiate context-sensitive menus in the Sidebar
Pan in the Design Window (holding the right button while panning)

 

Use roller wheel to:

Zoom In (roll forward) and Zoom Out (roll rearward) when the mouse cursor is in
the Design Window
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Holding a mouse button while dragging the mouse is referred to in this manual as left-
click-drag or right-click-drag.

  

As the mouse cursor traverses the screen, the pointer changes from crosshairs while
inside the Design Window, to an arrow when outside. Upon selecting a text field
(left-click), the pointer becomes an I-beam. This indicates that text information can be
entered or edited. Occasionally, the mouse pointer will change to the "wait cursor" as
set by the operating system to indicate that the system is currently busy and that data
entry is momentarily suspended; the exact behavior is dependent on the operating
system and the settings therein.

The crosshairs size can be small as at right or can be modified to fill the screen; see
Drawing Aids Settings. Absolute Coordinates and Relative Coordinates can be
displayed at the mouse crosshairs. See Environment Settings.

 

While executing a command, holding the Ctrl key and the left mouse button will 3D
Orbit without ending the command. Likewise, holding the Ctrl key and the right mouse
button will Pan in the Design Window.

 

When coordinate selection is required in a command, Visual will indicate alignment
with an existing (Background or Solid) object based on the Object Snap
properties selected in the Design Environment. See Entering Coordinates.

 

The view in the Design Environment can be manipulated with the mouse as described in Mouse Navigation.
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2.3 Keyboard Commands
Visual incorporates a number of keyboard commands (hotkey) to make navigation and command execution easier. Since operating the mouse is a single-handed operation, it can be very efficient
to execute common commands with the other hand in lieu of using the Ribbonbar.  For any hotkey, reference the section related to that command for more information. In the Help manual,
keyboard keys are shown in italics.

The Hot Keys command found after clicking Help on the Tools tab of the
Ribbonbar opens a PDF of shortcut keys as it is currently available on the Visual
website.

 

Generic hot keys:

Hot Key Description
Tab Cycles the Active Plane through the three Cartesian planes of movement
Home Returns the Active Plane to X-Y at Z=0

Up Arrow Moves the location of the mouse crosshairs one unit of the Snap Increment in the positive direction of the inactive coordinate axis. For example, if working
in the X-Y plane, the up arrow will move the Z- coordinate up one snap increment. If Snap is not on, the mouse crosshairs move one unit distance.

Down Arrow Converse of the Up Arrow
Esc Cancels the current command
Numpad "+" Increase mouse sensitivity; mouse movement causes more movement on screen
Numpad "-" Decrease  mouse sensitivity; mouse movement causes less movement on screen
Shift + Numpad "+" Increase display gamma factor; default is 2.2
Shift + Numpad "-" Decrease display gamma factor; default is 2.2
F1 Help
F2 Endpoint object snap on/off
F3 Midpoint object snap on/off
F4 Center object snap on/off
F5 Intersection object snap on/off
F6 Perpendicular object snap on/off
F8 Orthogonal mode on/off
F9 Snap mode on/off

 

Default command shortcut hotkey:

Hot Key Command Tab Group
A Array, Rectangular Construct
Shift + C Calculate Calculations
Ctrl + C Circle (background not solid) Construct
C Copy Modify
D Distance Tools
Numpad 6 East Elevation View
E Erase Modify
Shift + E Explode Modify
Ctrl + Shift + E Export File
X Extend Modify
Ctrl + E Extrude Modify
G Group Modify
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Ctrl + I Import File
J Join Modify
L Line Construct
Ctrl + M Mirror Modify
M Move Modify
Numpad 8 North Elevation View View
Numpad 9 Northeast Isometric View View
Numpad 7 Northwest Isometric View View
Ctrl + O Open File
Numpad 5 Plan View (Top View) View
Ctrl + P Print Editor File
P Properties Tools
Ctrl + R Redo n/a
R Rotate Modify
Ctrl + S Save File
S Scale Modify
Numpad 2 South Elevation View View
Numpad 3 Southeast Isometric View View
Numpad 1 Southwest Isometric View View
Shift + S Statistics Tools
T Trim Modify
Ctrl + Z Undo n/a
Numpad 4 West Elevation View View
Z, Numpad 0 Zoom All View

When a command is not being executed, the numeric keypad provides hot keys that mimic the 9-button View panel. When in a command, the numeric keypad will provide the numeric input
expected. See Basic Viewing for more information on the View panel. Hot keys can be completely defined by the user; see Customize Dialog for more information.

 

Selection Hot Keys - The following keyboard commands are only available when selecting objects in a command.

Hot Key Description
A Add objects to the selection set, changes the selection mode toggle to add when selecting objects
P Previously selected objects will be added to the selection set
R Remove objects from the selection set, changes the selection mode toggle to remove when selecting objects
L All objects in the Design Window will be selected
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2.4 Opening a Project
Because of the complexity and the related tax on computer system resources, only one Visual project can be open at any one time. The File menu can be used to make new projects or otherwise
operate on existing project files. It is possible to have multiple instances of Visual open at the same time, but this may lead to confusion and may over-tax more basic hardware.

When Visual is started, a new interior project is already created.

The difference between the appearance and operation of Visual in the Interior and
Exterior modes is minimal and primarily a matter of convenience. The Calculation
Mode is set to calculate direct and interreflected light for an Interior Project, and to
calculate only direct light for an Exterior Project.  Assumptions regarding user intent
are made to speed the design process and certain terminology is modified to reflect
tradition. However, there is nothing that precludes either type of application from being
modeled in either mode.

There are two ways to start a project in Visual: start a new project or open an existing
project.

To open an existing VSL project file, select Open from the File menu and a standard
Windows dialog will appear to navigate to an select the file desired.

Alternately, Visual lists the most recent files in the Recent Documents list on the
right of the File menu.

 

 

To begin a new project while Visual is already open, select New and then Interior
Project or Exterior Project as appropriate.

 

Another important aspect of starting a new project is entering project information. For
administrative reasons, Visual allows project information to be entered and saved with
the electronic file. Selecting Project from the File menu will launch the Project
Properties Form.

All fields are optional and this information may be entered at any stage of the modeling
process. Project information is used to uniquely identify Visual lighting models and to
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expedite the documentation process as field input are transferred to the Print Editor
automatically.

 



2.5 Saving a Project
Visual projects may be saved at any time.

To save a project, simply choose Save or Save As from the File menu. Visual will
initiate a standard dialog common in other Windows-based software.

The Save command will only prompt for a file name and directory the first time that it
is issued because the file has not been previously saved. Subsequently, the Save
command will assume that the same file name and directory are intended, thus over-
writing the file automatically.

The Save As command always prompts for a file name and directory. The Save As
command is useful to save the file without over-writing the previous version.
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2.6 Automa'c Recovery and File Backup
Visual automatically saves project files and it is possible to recover information in the event of an unexpected program closure.

Visual is equipped with an Auto-Save feature that periodically saves the current project. Should Visual be unexpectedly terminated, the program will automatically be restored to the last
auto-saved state upon re-entry if the user so desires; Visual asks about restoring the file at restart. This feature may be turned on or off and the time interval between auto-saves may be
modified in Environment Settings.

Visual creates a backup copy of every saved file that is made as <filename>.VBK.
 These files can be found in the directory x:\Documents and Settings\All
Users\Shared Documents\Visual\Support, where "x" is the drive on which the
Windows operating system is installed.

To open a backup file, select the "Visual Backup Files (*.VBK, *.VAS)" option from the
"Files of type" list in the Select File to Open dialog.  Otherwise, Visual only searches
directories for VSL files as the default.

Visual automatically removes any backup files that are older than a given number of
days, which is specified in the Settings form.

 

For more information on the Settings form, see Environment Settings for more information.
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2.7 Impor'ng and Expor'ng Files
Electronic information exchange is an important aspect of the overall architectural design process. Visual has the ability to import and export DWG and DXF format CAD files to allow for
integration with other architectural software.

To import DWG and DXF files, choose Import from the File menu and a standard
dialog will be opened to allow for file selection.

 

Visual imports objects on their original Layers and creates a Static Group to house
those Layers which will be visible in the Layers tab of the Sidebar. Objects are
imported in 3-D. Each Layer can be controlled individually to allow for clarity of
display.

 

Visual is also capable of exporting the Design Environment to DXF and DWG
format files. Selecting Export from the File menu while in the Design
Environment will open a standard file dialog. The result is the creation of a file
containing all 3-D model geometry and text as it exists within the Design
Environment.

Objects in any Dynamic Group (including System Layers) are placed on the "0"
Layer in the DWG file. Objects on other Layers are placed on that Layer in the
DWG file. Objects on Layers in Static Groups are placed on a Layer named
"<groupname> - <layername>".

 

Visual can additionally export print pages from the Print Editor environment. When in
the Print Editor, selecting Export from the File menu will result in the creation of a
file containing the 2-D information as it appears within the Print Editor for plotting and
not 3-D objects.
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Visual can create PDF files, but this operation is not strictly an export function. PDF
files are created by printing to a PDF-capable printer driver from within the Print
Editor.

 

For more information on layers in Visual, see Layer Manager.  For detailed information on using the Print Editor, see the Print Editor chapter.
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2.8 Undo and Redo
As with many Windows-based applications, Visual incorporates Undo and Redo commands to minimize the potential loss of information due to an inevitable "oops".

The twenty commands previously issued in the Design Environment can be
undone, one at a time and in reverse order, by repeatedly choosing Undo from the
Quick Access bar or using the Ctrl-Z hotkey to execute the Undo command.

The Redo command tracks the last twenty Undo operations performed by the Undo
command allowing that operation to be restored in the event that too many Undo
operations were inadvertently performed. The Redo command resides adjacent to the
Undo command in the Quick Access bar.

 

During any command, executing the Undo command will remove the last specified
coordinate (vertex); for example, when specifying the vertices of a Polygon.

 

Saving the current project file resets the Undo register. The auto-save process leaves the Undo register intact.
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2.9 Incremental Snap
Incremental Snap is a feature incorporated in most graphical software systems to allow precision location of the mouse cursor.

Incremental Snap means that the graphics pointer is only permitted to occupy
distinct locations and that mouse movement causes the mouse pointer to "snap" to
the next valid location rather than glide continuously.

A Snap Increment of five, for instance, would only allow the mouse pointer to move
in increments of five feet or meters  starting from the global origin of (0,0,0);
5,10,15,20, etc.

Snap Increment is important because it allows rapid selection of exact locations
(especially with 2x2 and 2x4 ceiling grids) and can help to keep lines truly parallel and
perpendicular. In Visual, Snap Increment is used for coordinate selection and object
alignment in both the Design Environment and the Print Editor.

Learning to set the Snap Increment to an appropriate value while entering
information in Visual will dramatically affect both the speed and quality of data entry.
Too large an increment disallows detailed data entry while too small an increment can
result in tedium. It is common to change the Snap Increment periodically during the
course of constructing a lighting model.

 

The Status Bar has been designed to include elements to provide a convenient
mechanism for toggling the snap on/off, and for choosing the Snap Increment.

To toggle Snap Mode on and off, left click on the Snap Button. A gold background
on the button indicates Snap Mode is on.

To change the Snap Increment, simply click on the down arrow on the right side of
the Snap Increment Combo Box and select an appropriate value. Alternately, any
value may be entered, including decimal fractions, by left clicking on the text box and
entering the desired increment.

 

It is best to choose a Snap Increment that represents the finest level of detail
required for a given task. It is possible to set Snap Increments that differ in each
cardinal dimension (X,Y,Z). For more information on this, reference Drawing Aids
Settings.

For example, an increment of two feet would be appropriate for entering a 2 X 4 ceiling
grid. This 2ft increment can easily be set from the Status Bar, whereas setting a 2ft
and a 4ft increment would require opening advanced dialogs and doesn't necessarily
yield a better result.
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A further restrictive element of Incremental Snap is Orthogonal Mode. In
Orthogonal Mode, the mouse pointer moves only in the cardinal directions (X,Y,Z).
Orthogonal Mode is useful when constructing models whose elements lie only in
the cardinal planes (no skewed or angled surfaces). In Orthogonal Mode, most
standard architectural geometry can be entered very quickly.

To toggle Orthogonal Mode on or off, left click on the Orthogonal Button in the
Status Bar.
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 2.10 Entering Coordinates
Entering coordinate information is fundamental to the use of Visual. Coordinates define the location of all entity types.

Coordinate information can be entered in one of three ways discussed in this chapter:   

- Mouse Pointer Navigation allows for movement of the cursor to a specific
location where a left-click will cause Visual to use that location as input.   

- Object Snap allows for the specification of a location that is related to an
existing entity.   

- Command Line Entry allows for keyboard entry of specific absolute and
relative coordinates.   

Advanced Visual users will fine-tune productivity by using all three input methods where appropriate and convenient.
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2.10.1 Mouse Pointer Naviga'on
Coordinates are most often selected by moving the mouse pointer within the Design Window while referencing imported Background Objects.  

The mouse crosshairs can be a fraction of the screen or extend to the Design
Window boundary. See Drawing Aids Settings.

The values at the bottom of the screen are the (X,Y,Z) triplet location of the mouse
pointer, and to the right of that, the horizontal and vertical viewing angles.

In this section of the manual, note the crosshairs in each view. The colored solid-line
axes indicate that the mouse pointer is currently moving in that plane. Red is always
the X-axis, green the Y-axis, and blue the Z-axis.

The solid crosshairs are a reminder showing the positive direction in those axes.

 

The mouse pointer always moves in two orthogonal (perpendicular) dimensions
defined by the mouse crosshairs. The mouse crosshairs can appear perpendicular or
skew on the screen depending on the view.

For example, the left image is a plan view and on the right the image is of the
SouthEast 3-D view of the same object.

 

It is possible to change the plane of movement in 3-D views as depicted in the figures
at right. Pressing the Tab key while the mouse pointer is in the Design Window
causes the pointer to cycle through the three cardinal planes of movement (X-Y, X-Z,
and Y-Z).

In both the 3-D views at right, the mouse pointer is in precisely the same location but
the plane of movement is different. The crosshairs indicate the plane of movement.
When the Tab key is pressed to change the plane of movement, the coordinate of the
inactive dimension becomes fixed at its present value. The mouse pointer is said to be
moving in X-Y, for instance, at Z = 10. This is referred to as the working plane.
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It should be apparent that any 3-D location can be pinpointed from a single view by moving sequentially through different working planes. A floodlight mounted at grade, for instance, can be
aimed into the plane of a vertical facade by moving the mouse pointer in the horizontal (X-Y) plane to the base of the wall. Then, by pressing the Tab key to change the working plane to that of
the wall, the mouse pointer can be simply moved upward to locate the desired aiming point.

Occasionally it is convenient to remain in the same cardinal plane of movement such as X-Y, but a different location in the fixed Z dimension is desired. Pressing the Up Arrow and Down
Arrow keys changes the working plane in this way. It shifts the working plane one snap increment at a time in the direction of the perpendicular axis. The Up Arrow is positive and the Down
Arrow is negative as defined by the coordinate axis in question.

Another important key to remember is the Home key. Pressing the Home key at any time returns the working plane to X-Y, at Z = 0 (ground level).

In a command, Visual displays the relative coordinates of the crosshairs with respect
to the last coordinate entered. These values are shown in blue at the bottom of the
Status Bar. Cartesian and polar coordinates are always provided.

At right, in the Line command, Visual shows (in blue) that the mouse has moved 50
units in the X-axis, 5 units in the Y-axis, and 0 units in the Z-axis since drawing is done
in plan view. Note that the global coordinates are also (50,5,0) because the origin of the
Line is at (0,0,0).

 

Visual can display both Absolute and Relative Coordinates in conjunction with the
crosshairs. See Environment Settings for more information.

 

See Using the Mouse for additional information.
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2.10.2 Object Snap
At times it is convenient to point to an object that already exists in the Design Environment and select a coordinate location that corresponds to a point on the object. Object Snap is
particularly useful when importing drawings because the imported Background Objects can be easily chosen as points of reference. Object Snap is supported for all Background and
Solid Objects as well as the insertion point of Luminaires.

Object Snap modes may be accessed in the Status Bar. Multiple Object Snap
modes can be activated at once. Active modes are highlighted in gold; at right,
Midpoint and Intersection are active.

 

Visual illustrates which Object Snap has been located by adding to the mouse
pointer and crosshairs. The mouse cursor additions are shown below next to the
buttons for each Object Snap mode.

At right, Visual has found the Intersection of two Lines. Note that the Intersection
Object Snap button is highlighted in the lower right corner.

Visual will show Object Snaps when the mouse cursor is in the vicinity of a viable
"target". The mouse cursor does not have to be exactly at the point.

Lines that comprise Rectangles, Polygons, Polylines, and Solid Objects are
valid.

Object Snap modes can be turned on and off with the keyboard using the keys F2
through F6.

 

Endpoint selects the nearest endpoint of a Line, Polyline segment, or Arc.  

Midpoint selects the point midway between endpoints of the nearest Line or Line
segment.

 

Center selects the center point of the nearest Arc or Circle. Note that Arcs may in
fact be Polylines and therefore a Center is invalid; i.e. an entity may look like an
Arc, but it might not be an Arc.

 

Intersection selects the nearest intersection of two lines. The Objects (the
bounding edges) must truly intersect in 3-D space however; apparent Intersections
are not valid.
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Perpendicular selects the point on the nearest Object that is perpendicular to the
previously selected point.

 

Luminaire selects the insertion point of the Luminaire on which the mouse is
placed.
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2.10.3 Command Line Entry
Entering coordinates via the Command Line is useful whenever exact coordinates or distances are known. This method is useful when entering information from a dimensioned drawing or
sketch.

The Command Line appears in the Status Bar anytime Visual is expecting a
coordinate location to be entered. Coordinates are entered in the format X Y Z
separated by a single space or as X,Y,Z separated by a comma and followed by the
Enter key or a right-click of the mouse.

In the examples at right, the coordinates X = 10, Y = 20, and Z = 5 were entered. Note
that the global coordinates are random values related to where the mouse cursor
happens to be located; they have nothing to do with the coordinate entry with the
keyboard.

When entering coordinates with the keyboard, Visual will assume the Z-value is "0"
relative to the Active Plane if no other value is given. If the global coordinates are
such that Z = 10 globally, entering only X = 5 and Y = 20 will indicate to Visual that the
global coordinates (5,20,10) are to be used for input.

 

An alternative way to enter coordinates with the keyboard  is to indicate the relative
coordinates to the previous location entered.

The at symbol "@" is entered first to indicate relative coordinate entry, providing an
analog to the English concept of "draw a line at a distance of..." The @  is either
followed by the relative X Y Z coordinates or a distance followed by the "

 

Note that relative coordinates can be used to reference the last coordinate entered in the previous command whether that coordinate was input with the mouse, Object Snap, or the
keyboard.

Direction angles are measured positive in a counterclockwise manner starting from
the positive X-axis in the X-Y and X-Z planes and the positive Y-axis in the Y-Z plane.
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2.11 Selec'ng Objects
Many Visual commands require that objects within the lighting model be selected either for modification or reference. Generally speaking, these commands may be applied to objects either
individually, or in groups. The process typically consists of object selection followed by the specification of any information necessary to complete the particular command. Because the object
selection process is a common occurrence, Visual incorporates a consistent routine for the sake of simplicity.

Upon initiating any command involving object selection, the Status bar will prompt for
the selection of objects. For example, the Move command at right.

 

The mouse crosshairs will temporarily change to a pick-box indicating that Visual is
using the Pick selection method. To select Background objects, Solid objects, and
Calculation Zones, simply place the pick-box over any element of the desired
object and left-click the mouse.

 

In Transparent and Rendered Display Modes, Visual allows both the perimeter
and interior of Solid Objects to be clicked to indicate selection.

 

The object will turn the selection color (the system default is red, but can be user-
modified in Environment Settings) to indicate that it is selected. If more than one object
is in the pick-box area then only a single object will be selected. To toggle through the
objects under the pick-box simply left-click the mouse again and the next object will be
selected while the previous object will be unselected. Continue clicking until the
desired object is selected.

 

The selection order of objects is based on the Z-order. This means that the object closest to the camera is selected first. If a second click is made on visually coincident objects, the next farthest
object will be selected, and so on. For example, in a Top View, when clicking as in the above example, the object selected would be the "ceiling", a second click in the same spot would select the
"wall" below, and a third click would select the "floor". If a fourth click where made, the cycle is completed by the "ceiling" being the selected object again.

In Transparent, Shaded, or Rendered display mode, Solid objects can be selected by clicking on any part of the surface. In Wireframe display mode, a bounding edge must be clicked.

The selection order of objects is based on the Z-order. This means that the object closest to the camera is selected first. If a second click is made on visually coincident objects, the next farthest
object will be selected, and so on. For example, in a Top View, when clicking as in the above example, the object selected would be the "ceiling", a second click in the same spot would select the
"wall" below, and a third click would select the "floor". If a fourth click where made, the cycle is completed by the "ceiling" being the selected object again.

Moving to the right after the first left-click creates a rectangle with a solid border and
light blue shading, indicating the Window  selection method. When using the
Window  selection method, any object that resides entirely within the window will be
selected.  

In the example at right, the square is fully contained and the triangle and circle are not;
thus only the square is made part of the selection set.
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Moving to the left after the first click creates a rectangle with a dashed border and a
light green shading, indicating the Fence selection method. When using the Fence
selection method, objects having any portion within the fence will be selected.

In the example at right, the triangle is fully contained, the square is not contained, and
the fence crosses the circle; thus the triangle and the circle are made part of the
selection set.

 

The Properties tab will include the Selection panel to assist in selecting objects for
Modify tab commands. Visual defaults to adding clicked objects to the selection set,
signified by the Add Selection button being highlighted in yellow.

 

The Properties tab will include the Object Filters panel to assist in selecting
objects for Modify tab commands and other times when objection selection is
required; e.g. specifying a surface on which to place a Calculation Zone. A
checkbox is present for each of the four object types. Unchecking a box tells Visual to
ignore objects of that type when selecting objects.

 

As both an example of Object Filters and a usage tip: Power Zones and
Calculation Zones are often created such that they are coplanar. When selecting
either type for modification, it is likely to be unclear which zone type has been selected.
To be sure which is selected, change to Transparent Display Mode. Secondly, use
the Object Filters to remove Solids. This allows selection of a calculation point to
select a Calculation Zone or simply selecting "empty space" as shown at far right to
select the coplanar Power Zone. (This example is selecting first the Calculation
Zone and alternately the Power Zone.)

 

The selection process also allows objects to be removed from the selection set. To
toggle to the Remove selection mode, press the Remove Selection button or
press the R key on the keyboard while the pick-box is active.

 

          

In addition to the Remove Selection button being highlighted in yellow, the Status
bar will also indicate that the subsequently selected items will be removed from the
current selection set.

 

Click the Add Selection button or press the A key to return to the Add selection
mode if necessary.
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Clicking the Select All button selects all objects in the Design Environment.
Pressing the L key while in selection mode also causes all objects to be selected.

 

          

Clicking the Previous Selection button or pressing the P key while in selection
mode causes objects previously selected (in the last command executed) to be
selected again for use in the currently active command.

 

          

The Pick, Window, and Fence methods can be used repeatedly in both Add and Remove modes until the selection set contains only the desired objects. The process is terminated with
a right-click of the mouse, and Visual ends the command or moves to the next step in the command depending on the command executed.

Command-specific information about selecting objects is found later in the manual where necessary.
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Chapter 3 - Visual Objects

There are four fundamental types of objects that may be included in a Visual lighting
model. They are Background Objects, Solid Objects, Luminaires, and
Calculation Zones. With these four fundamental elements, virtually any type of
interior and/or exterior lighting system can be modeled to include the effects of
obstructions and diffusely reflective surfaces.
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3.1 Background Objects
Background Objects, as the name would imply, are graphical elements that may be included in the lighting model for visual reference only.

Background Objects consist solely of lines, rectangles, polygons, circles, arcs and
text.

The most common kind of Background Objects are those imported from CAD
files.  Imported CAD files are automatically converted to Background Objects
exclusively.

Lines identifying the location of islands or stalls in a parking lot, for instance, would
classify as Background Objects. They are useful for establishing valid locations for
Luminaire placement and for communicating such placement in relation to other
objects or pertinent elements of the model.

Visual includes a variety of commands to create and manipulate Background
Objects to aid in model construction and otherwise describe a lighting model.

 

Valid Background Objects (closed areas such as circles, rectangles, and
polygons) may be converted to Solid Objects if desired. For more information on
converting object types, reference Convert to Solid.

 

Background Objects do not affect lighting calculations in any way nor do they change with changes in Display Mode. See Display Modes for more information.
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3.2 Solid Objects
Solid Objects (Solids) are planar surfaces, and/or collections of planar surfaces, that impede or alter the flow of light.

Solids may simply block light (Direct Only Calculation Mode) or they may reflect
or transmit it according to an assigned Reflectance or Transmittance value. The
specified Reflectance value, applies to both sides of a Solid Object and is related
to Color.

As implied by the term "surface" that is often used to describe them, Solid Objects
must be comprised of an enclosed area such as a circle, rectangle, or polygon.  A line,
for instance, cannot be a Solid Object because it has no two-dimensional area.

Solids are used to model physical objects such as walls, ceilings, and partitions
among other architectural elements and can be created in a group using the Room or
Structure commands.

 

Transparent Display Mode

 A Transmittance can be assigned (after creation) by editing the object Properties.

Solid Objects may be calculationally inactivated, individually or in groups, from within
the Properties tab of the Sidebar as well.

 

Solids are always drawn with thick, black lines and they can be converted to
Background Objects, if desired. For more information on converting object types,
reference section Convert to Background.

 

The appearance of Solid Objects in the Design Environment can be changed
with the Shaded, Rendered, and Transparent Display Modes.

 

Note that Solids are shown in this manual as they appear in Transparent Display Mode and are therefore shaded/filled.
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3.3 Luminaires
In Visual, the term Luminaire applies to the photometric, graphical, and descriptive characteristics of objects (Luminaire Types) created within the Luminaire Schedule Editor.

In the most simple case, Luminaires are a single entity like a downlight.

For more information on Luminaire configuration, reference the Luminaire chapter.

 

A Luminaire can also be a more complex assembly of multiple optical assemblies
("heads") arranged in a particular manner at the top of a pole.

The most complex assembly uses different photometric files for different heads.

 

Once placed, Luminaires are treated like any other graphical object within the
Design Environment in that they can be manipulated with most commands on the
Modify tab of the Ribbonbar.

Move, Copy, Erase, Array Polar, Array Rectangular, Mirror, and Rotate are
commands that operate on Luminaires .

 

Luminaires may be calculationally inactivated in the Layer Manager.

Luminaire Properties can be modified in the Properties tab of the Sidebar.
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3.4 Calcula!on Zones
Calculation Zones are regions where calculations are computed and reported. These zones may be lighting-based or power-based.

Calculation Zones can be lighting-based (Illuminance,
Luminance, etc) or power-based (Lighting Power Density). By
default, Visual shows Lighting Calculation Zones in dark red and
Lighting Power Density Zones are shown with a olive border and
are furthermore shaded.

 

Lighting Calculation Zones can be defined by rectangular areas,
areas bounded by a polygon, or can be locations along a linear path.
Calculation Zones can also be placed directly on surfaces (Solid
Objects).

The boundary of the Calculation Zone is indicated by a dashed line
and points indicated by crosses are placed in an array defined by the
user.

Visual assumes the light meter orientation to be perpendicular to the
defining (bounding) plane. This can be modified at creation or by editing
Properties after creation.

 

Lighting Calculation Zones can be modified to remove points that
are unwanted using the Masking commands. Points can be Masked
with rectangles, polygons, by surface, or individually.

Mask boundaries are shown with a dashed purple line.

The display of the Mask boundary can be turned on or off in the
Settings dialog.
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Statistical Zones can be created to report information about part of a
Lighting Calculation Zone. Statistical Zones are displayed in the
Statistics tab of the Sidebar separately from their parent zone.

Statistical Zones can be created with rectangles, polygons, or by
selecting surfaces. Statistical Zones can be grouped in the Sidebar
for an additional level of reporting and analysis.

Statistical Zone boundaries are shown with a dashed dark green line.
Notice how the internal points are omitted by astute boundary selection.
Calculation points included in the Statistical Zone have a different
symbol.

For example, only the paved area could be shown for a parking lot.
Points in the Statistical Zone are indicated with green asterisk
symbols by default.

 

Lighting Power Density (LPD) Zones can be defined by
rectangular areas, areas bounded by a polygon. They have associated
luminaires specifically applied to the calculation. LPD Zones can also
be placed directly on surfaces (Solid Objects).

 

Calculation Zones may be calculationally inactivated in the Layer
Manager.

 

The Properties of Calculation Zones can be modified in the Properties tab of the Sidebar (see Calculation Zone Properties). Global changes can be made to attributes, like default color, in
the Settings dialog (see Calculation Zones Settings ).
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Chapter 4 - New Features
Visual 2.7 incorporates new features to increase productivity and allow for easier use with the most complex models:

The Sidebar provides convenient access to three tabs of information that also allow for the modification of model object parameters and the display of calculation results.

The Layers tab is located in the Sidebar and contains the Layer Manager. The Layer Manager shows System Layers and user-defined Layers and allows control of Layer
behavior to provide lighting model organization based on what is appropriate for a project or useful for a user.

The Design Manager provides quick access to all objects in the lighting model in a floating dialog window. The dialog lists all objects in a treed fashion based on object type. Objects can
be selected and identified or modified.

An Audit is performed before each Calculation and provides feedback related to known and possible problems with the lighting model. Audits can be done at any point to verify model
components. The Audit window dialog sits on top of the Design Environment.

The Properties tab is located in the Sidebar. The tab is dynamic in that the content will change depending on which of the four object types is chosen in the selection process.

Several videos have been produced to illustrate features. The currently available videos can be found at:

http://www.visual-3d.com/support/TrainingVideos/2012.aspx
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4.1 Audit
The Audit command is located on the File menu. An Audit is performed before each Calculation and provides feedback related to known and possible problems with the lighting model. Audit
results do not preclude a calculation from being performed; results are an alert that the calculation result may not be what was expected.

An Audit can be performed without a calculation by executing the command from the
File menu.

 

If Visual finds no issues, a pop-up is displayed.  

If issues are found, Visual displays a notification bar at the top of the Design
Window. Clicking the View Audit Results button initiates the Audit Results
dialog. Clicking an entry will highlight the objects related to the issue in the Design
Environment.

 

To identify an element in the Audit, left-click the name of an object. Visual will
highlight the object in red in the Design Environment, just as in any other selection
process.

The Properties tab of the Sidebar will be populated with the parameters for the
selected object for verification or modification.

The Audit Results dialog is closed by clicking the "X" in the upper right corner of the
dialog.

 

Visual provides different symbols for the various issues that can be analyzed.  

Possible Problem issues:

Audit Message Description
Luminous Dimensions Conflict A luminaire symbol and its luminous dimensions are different
Luminaires Intersect Multiple luminaires are detected to overlap
Luminaire Intersects a Surface A luminaire intersects a surface
Incorrect Luminaire Mounting A luminaire has luminous surfaces on or behind the mounting surface
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Possible Information issues:

Audit Message Description
Invisible Objects Objects that participate in the lighting calculation are on invisible layers
Objects Intersect A closed room or object intersects or overlaps another closed room or object
Luminaire Outside Project Extents A luminaire may be outside of the project extents
Calculation Zone Not Illuminated A calculation zone is inside an unilluminated closed room or object
Surfaces Intersect A surface is intersecting another surface
Identical Surface A surface is identical to another surface

Possible Critical issues:

Audit Message Description
Duplicate Luminaires Multiple luminaires are detected at the same location
Large Drawing Coordinates Drawing coordinates are too large to perform a calculation. Move the entire drawing closer to 0,0.

The Audit tool does not ensure that the lighting model is free of errors or that the resultant calculation is "correct" given the many possible intents of user input. It is ultimately the responsibility of
the user to ensure the lighting model approximates reality in an appropriate way.
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4.2 Design Manager
The Design Manager provides quick access to all objects in the lighting model in a floating dialog.

The Design Manager is opened by clicking the button in the Tools panel of the
Home tab of the Ribbonbar the button in the Windows sub-menu of the Tools
tab.

 

The Design Manager dialog is always on top of the Design Environment
window and can be repositioned with a left-click-drag motion of the title bar as with all
Windows applications.

The number after each main entry is the quantity of that type currently placed in the
model.

Each section (branch of the tree structure) is opened and closed by either double-
left-clicking the branch names or clicking the "+" and "-" buttons.

The Design Manager is closed by clicking the "X" in the upper right corner of the
dialog.

 

To identify an element in the model, left-click the name of an object. Visual will
highlight the object in red in the Design Environment, just as in any other
selection process.

The Properties tab of the Sidebar will be populated with the parameters for the
selected object for verification or modification.

 

Clicking a Calculation Zone name will highlight the zone in the Design
Environment.
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Power Zones involve both luminaire and an attributed area, so both are included.
This allows for easy verification of the luminaires included in a Power Zone
calculation. Clicking the zone name highlights the attributed area in the Design
Environment. Clicking the Luminaire name highlights the Luminaire in
the Design Environment.

 

The Luminaires section includes all Luminaires placed in the Design
Environment. Clicking a Luminaire name highlights the Luminaire in
the Design Environment.

 

The Luminaire Types section shows all Luminaires defined in the Luminaire
Schedule and the sub-branch shows each Luminaire placed in the Design
Environment. This provides the same functionality as the Luminaires branch but
with different organization. Clicking a Luminaire Type name has no function.
Clicking a Luminaire name highlights the Luminaire in the Design
Environment.

 

Solids are grouped in the Design Manager if they are grouped in the Design
Environment; i.e. Rooms and Structures will be shown by the names given to
them upon creation and Solids will be shown below that object name.

Clicking a Solid name highlights that Solid in the Design Environment.

Individually created Solids will be shown without a Collapse/Expand button since
it is a single entity and has no sub-branches in the tree; e.g. "Divider" shown at right.

The number of Solids in each Group is shown after the Group name.

 

Since Background objects are for reference, they are not displayed in the Design Manager.
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4.3 Layers
Layers can be used for complex projects to organize as well as control display and calculatability.

All Visual models have the default System Layers Group in the Layer Manager
and therefore in the model. The Group and its associated Object Layers cannot be
deleted.  A complete and complex model can be constructed without using Layers;
Visual uses Layers as necessary in a transparent fashion if the user doesn't need or
want to use the feature.

 

Layers are controlled in the Layer Manager discussed in this section.
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4.3.1 Calcula�on State
The Layer Calculation State is controlled in the Layer Manager found in the Layers tab of the Sidebar.

The Calculation State button controls whether or not objects associated to that
Group or Layer are included in calculations.

The Calculation State button has different states than can be assigned and
therefore different symbols will appear indicating the different states. The position of
the Calculation State button remains constant.

 

The default state for all Layers is Calculated. This means objects on that Layer will
be included in calculations.

 

The Inactive state tells Visual to not include objects associated to that Layer or
Group when performing calculations.

 

The default state for all Groups is By Layer. This means that the Calculation
State for each Layer in the Group is set individually.

 

Choosing an Calculation State at the Group level means that all Layers in that
Group will have the same state.

Individual Layer Calculation State cannot be modified in this case, which Visual
indicates with lock symbols on top of each Layer Calculation State button.

To modify Layer Calculation in this situation, set the Group Calculation State to
By Layer, and then modify the Layer Calculation State(s) as desired.

 

There are two methods for changing Calculation State:

Left-clicking the Calculation State button will change to the next state type.
Continually left-clicking will cycle through the four Calculation States.

Note that By Layer is not a valid state for Layers; it only applies to Groups.

 

Alternately, right-clicking the Calculation State button for a Layer or Group will
pop-up a menu showing the three states and a choice can be made by left-clicking the
desired state.
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The ability to control the Calculation State for Background objects is included for completeness. It is of course the case that Background objects do not contribute to calculations.



4.3.2 Colors
Layer Colors are controlled in the Layer Manager located in the Layers tab of the Sidebar.

The Color of each Group or Layer is controlled with the Color button.

The Color button has different states than can be assigned and therefore different
symbols will appear indicating the different states. The position of the Color button
remains constant.

Clicking the Color button opens the Color Dialog for selection. See Using the Color
Dialog for more information.

 

The default state of the Color button for  all Layers is "By Entity"; Properties of
the Object control the Color.

 

Assigning a Color to a Layer will override Object Properties Color choices; the
Color of Objects will be the Color of the Layer.

 

The default state of the Color button for all Groups is "ByLayer"; each Layer has a
separate Color and can be assigned

 

The Group Color can be chosen by clicking the By Group Color button, which
opens the Color Dialog. Assigning a Group Color overrides Color selection for all
Layers and Visual will show a lock symbol on the Group member Color buttons
indicating this.

In the example at right, the Group Color is set to blue and the Color of the Layers
in the Group are locked due to that choice.

Layer Colors can be assigned (unlocked) by choosing "By Layer" as the Color for
the Group.
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4.3.3 Editability
The Layer Editability State is controlled in the Layer Manager found in the Layers tab of the Sidebar.

The Editability of each Group or Layer is controlled with the Editability State
button.

The Editability State button has different states than can be assigned and therefore
different symbols will appear indicating the different states. The position of the
Editability State button remains constant.

 

The default state for all Layers is Editable. This means objects on that Layer can
be selected and are of course visible.

 

The Uneditable state makes objects gray in color, and they cannot be selected.  

The Invisible state makes objects on that Layer Invisible.  

The By Layer state is applicable only to Groups and means that the Editability
State of Layers in the Group is set for each Layer.

 

Choosing an Editability State at the Group level means that all Layers in that
Group will have the same state.

Individual Layer Editability State cannot be modified in this case, which Visual
indicates with lock symbols on top of each Layer Editability State button.

To modify Layer Editability in this situation, set the Group Editability State to By
Layer, and then modify the Layer Editability State(s) as desired.

 

There are two methods for changing Editability State:

Left-clicking the Editability State button will change to the next state type.
Continually left-clicking will cycle through the four Editability States.

Note that By Layer is not a valid state for Layers; it only applies to Groups.

 

 

Alternately, right-clicking the Editability State button for a Layer or Group will pop-
up a menu showing the four states and a choice can be made by left-clicking the
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desired state.

 



4.3.4 Groups
Layer Groups are controlled in the Layer Manager found in the Layers tab of the Sidebar. Groups provide many ways to organize a project but the use of Groups is not required for even
complex projects.

A New Group can be created to organize Layers. The Group type can be
selected as Static or Dynamic in the Properties panel at the bottom of the
Layer Manager.

 

All Visual files contain the Dynamic System Layers Group.  

Dynamic Groups are those that have the four Object Layers :
Background, Calculation Zones, Luminaires, and Solids.

Objects created when a Dynamic Group is active are automatically
associated to the appropriate Object Layer; i.e. Solids will be associated to
the "Solids " Layer of the System Layers Group .

Example1: a future phase of a project could be placed in a Dynamic Group
, and then removed from the first phase presentation very easily at printing by
turning off the entire Group. At right, the Phase 2 Layer is made
Uneditable.

 

Static Groups are those where Layers can be clustered in a logical
fashion. Layers can be associated to Static Groups and controlled
collectively. Any of the four Object types can be created on a layer and may
then be part of a Static Group.

Example2: in a conference room, the Background and Solid Objects for
the "meeting" and "audiovisual" schemes would be the same and could be
created on the System Layers . Different lighting systems (and possibly
different Calculation Zones) could then be created on different Layers and
made visible individually in the Print Editor to clearly illustrate the lighting in
both schemes.

 

Note that in the two above examples that it is possible to achieve the same or similar results using  Static Groups, Dynamic Groups, and Layers in many different ways. Layer
Groups are provided to allow the user to segment a project in the way that is most logical for a project or is favored by the user.
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When CAD files are Imported, Visual automatically creates a Static Group
and all Background Objects will be placed on Layers just as they are in
the CAD file otherwise.

The Static Group will have the name of the CAD file.

Layer Color is set to By Entity to then further preserve the look of the file
as it was last saved in the creating program.

Note that some Layers may be set to Inactive based on the Layer State in
the creating program.

 

Layers can be associated to a Static Group by clicking the Layer name to
make it active and then editing the Classification Properties at the bottom
of the Layer Manager to assign it to the desired Group. The process is
undone by assigning the Layer to the "None" Group.

Layers can also be converted to a Dynamic Group such that all Objects
on the selected Layer will be separated into the four Visual Object types.

 

The use of Static and Dynamic Groups is largely one of user preference in that to a large degree either can be used to achieve an efficient design process, clear lighting model construction,
and clear presentation.
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4.3.5 Manager
The Layer Manager is located in the Sidebar and synonymous with the Layers tab. The Layer Manager shows System Layers and user-defined Layers and allows control of Layer
behavior to provide lighting model organization based on what is appropriate for a project or useful for a user.

If it is not visible, the Layer Manager (Sidebar with Layers tab focus) can be
shown by clicking in one of two places:

- Home tab, Tools panel, Layers sub-menu, Layer Manager

- Tools tab, Options panel, Windows sub-menu, Layer Manager

 

After clicking Group and Layer names, Properties can be edited in the Properties
panel at the bottom of the Layer Manager.

The Layer Manager also contains a toolbar at the top with several buttons to add
and manipulate Layers and Groups.

 

To make a Layer or Group active, and therefore have new Objects associated with
it, double-click the Layer or Group name. Alternately, right-click and select "Active
Layer" from the menu; see information below.

The active Layer or Group is signified by the green icon next to the name. This is
separate from the yellow highlight.

Layers that are part of a Dynamic Group cannot be made active; the Dynamic
Group is what is active and Visual places Objects on the appropriate Object Layer
as they are created. Conversely, a Static Group cannot be made active; Layers that
are part of a Static Group are made active.

 

 

A New Group can be created to organize Layers. The Group type can be selected
as Static or Dynamic in the Properties panel at the bottom of the Layer Manager
. See Layer Groups for more information.
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Layers can be created by clicking the New Layer button at the top of the Layer
Manager. Visual creates the new Layer temporarily and populates the Properties
panel at the bottom of the Layer Manager with the preliminary name "New Layer".
Focus is placed on this preliminary name so it can be easily renamed to something
more meaningful to the current project.

 

Layers can be associated to a Static Group by clicking the Layer name to make it
active and then editing the Classification Properties at the bottom of the Layer
Manager to assign it to the desired Group. The process is undone by assigning the
Layer to the "None" Group.

Layers can also be converted to a Dynamic Group such that all Objects on the
selected Layer will be separated into the four Visual Object types.

 

To Copy a Layer or Group, select the desired items  and click the Copy button at
the top of the Layer Manager.

 

To Delete a Layer or Group, select the desired items and click the Delete button at
the top of the Layer Manager.

Visual presents a dialog to determine if the deleted objects are to be removed or kept
after the Layer is Deleted. Delete Layers Only will move the associated Objects
to the appropriate Layers in the System Layers Group (i.e. Luminaires are
placed on the Luminaires System Layer, etc.). Alternately, Delete Layers and
Entities removes all entities on the Deleted Layer and the selected Layer.

 

Display of Layer Groups can be compacted by pressing the Collapse button in the
upper right corner of the Layers tab to then only show Layer Group names. After
the button is pressed it changes to the Expand button and will be highlighted in
yellow. Pressing the Expand button reverts to the original state of showing all Layer
names.

Groups can also Collapse and Expand by clicking (alternately) on the "-" and "+"
next to the Group name.
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Right-clicking a Layer name will pop-up a menu showing multiple command
shortcuts:

Left-clicking a choice operates on the selected Layer. Active Layer changes the
Layer on which the right-click was initiated to the current Layer.

For more information on these and other Layer commands, see Layers Tools.
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4.3.6 Tools
Visual includes several Layers Tools to aid in working with Layers in complex projects. The Layers sub-menu button is located on the Home tab of the Ribbonbar, although the commands
are also found in the Layer Manager (Layers tab of the Sidebar).

Layers Tools are found in the submenu initiated with the Layers button on the
Tools tab of the Ribbonbar.

 

The Layer Manager command in the sub-menu activates the Layer Manager in
the Sidebar (the Layers tab) if it has been closed or switches to that tab in the
Sidebar if it is not currently active. See Layers or more information.

 

Identify Layers allows for selection of an object to determine the Layer on which it
resides. Select an object and then right-click to end the command. Visual will highlight
the Layer in the Layer Manager. If objects on multiple Layers are selected, Visual
will identify all Layers.

 

Isolate Layers allows for the selection of a on object, and the Layer on which it
resides will be left Visible while all other Layers will be made Invisible. Unisolate
Layers makes all Layers Visible.

 

Deactivate Layers allows for selection of an object, and the Layer on which the
object resides will be made Inactive. "Inactive" in this context is a coupling of both the
Inactive Calculation State and being Invisible.

 

Purge Empty Layers removes all Layers that have no associated objects. This is
particularly useful after a CAD Import to allow for more clarity since CAD software
add-ins can be elaborate. This operation cannot be undone, so Visual displays a
warning message as a reminder.
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4.4 Proper�es
The Properties tab is located in the Sidebar. The tab is dynamic in that the content will change depending on which of the four object types is chosen in the selection process.

Object properties can be accessed and modified by executing the Properties command in one of four ways:

1) Left-click the Properties button in the Tools panel on the Home tab of the
Ribbonbar.

 

2) Select the menu item from the Windows sub-menu in the Options panel of the
Tools tab in the Ribbonbar. Note that the letter "P" next to the command indicates
that the hotkey for the command is the "P" key.

 

3) Left-click the Properties button is located on the Properties tab of the Sidebar.

 

 

4) The Visual hotkey "P" can be pressed on the keyboard to execute the command.  

Executing the Properties command causes Visual to display the Properties tab in
the Ribbonbar discussed in the next sub-section.

 

After Properties have been suitably modified, click the right mouse button to end the  
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command and apply parameter modifications.

 



4.4.1 Ribbonbar Proper�es Tab
Properties of various entities are modified in the Sidebar as described in subsequent sections. Selecting objects to modify is done in the Properties tab in the Ribbonbar after the command
has been executed.

Executing the Properties command causes Visual to display the Properties tab in
the Ribbonbar. The tab includes a variety of ways to aid in selecting objects.

 

The Properties tab will include the Selection panel to assist in selecting objects for
Modify tab commands. Visual defaults to adding clicked objects to the selection set,
signified by the Add Selection button being highlighted in yellow.

 

The Properties tab will include the Object Filters panel to assist in selecting
objects for Modify tab commands and other times when objection selection is
required; e.g. specifying a surface on which to place a Calculation Zone. A
checkbox is present for each of the four object types. Unchecking a box tells Visual to
ignore objects of that type when selecting objects.

 

Placing a check in the Surface Color checkbox allows a Color to be chosen. When
selecting Solid objects with one of the various methods described here, Visual will
then filter the objects to include only those having the color specified. This selection
refinement (filter) works only with Solid objects.

 

Selection Modes allows for fine-tuning of how objects are selected.

Single Selection - Left-clicking an object makes that object the only member of the
selection set.

Multiple Selection - Each left-click of an object adds to the selection set. See
Selecting Objects for information on selecting objects that are "stacked".

Turning Surface Selection on by checking the box will select individual surfaces that
are part of Rooms, Structures, or Grouped Solid objects.

 

See Display Modes and Basic Viewing for information on the View panel.  
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Note that many selection and filtering methods can be combined to quickly select desired objects. Discussion of the use the Properties tab in the Sidebar for each of the four object types
follows in this chapter.
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4.4.2 Background Proper�es
Background properties are shown in the Sidebar when the Properties command is active and Background objects are selected.

To activate the Properties command, click the Properties button on the Home tab
of the Ribbon Bar or in the Sidebar, or press the "P" hotkey. When a
Background object is selected, Visual displays the properties for that object in the
Sidebar.

 

For Polyline objects Visual displays the following panels:   

The Layer panel indicating on which layer the object resides. The layer may be
changed by clicking the drop-down menu arrow on the right. "System Layers" is the
default and is in fact a Layer Group, which indicates the object is on the
Background layer of the System Layers group. See Layers for more information.

 

The Status panel contains a Visible menu that allows control of individual objects.
Selecting "Yes" means the object(s) will be visible. Selecting "No" means the object(s)
will not be visible. "ByLayer" indicates that control of object visibility is controlled by
selections made in the Layer Manager for Editability.

Once an object has been made not visible with this dialog, the only way to get access
to the object is through the Design Manager where the object can be selected and
made visible again, for example.

 

For Polyline objects, Visual displays the Polyline panel, which contains:

Line Color showing the currently selected Color and allows for modification with the
Color dialog.

Line Weight showing the current width in pixels and allows for modification with the
drop-down menu and the associated text box.

Line Style showing the currently selected style and the menu allows selection of one
of the 9 styles.

Length is the sum of all segments in feet or meters.

Since Background objects cannot be named, a reference number for identification
is displayed in square brackets in the panel title. This reference number is indexed for
Polylines and Polygons together.

 

For Polygon objects, Visual displays the Polygon panel, which  adds the following:

Area is shown in square feet or square meters inside the polygonal solid boundary.
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Center is the X,Y,Z triplet coordinates for the centroid of the Polygon. See
http://en.wikipedia.org/wiki/Centroid for more information.

Normal is the direction the perpendicular to the surface points in a unit vector. i.e.
(0,0,1) would indicate the front surface is in the positive Z direction. See
http://en.wikipedia.org/wiki/Surface_normal for more information.

The Coordinates panel shows the coordinates of each vertex  in  X,Y,Z triplets.
These are not editable.

 

Multiple objects can be selected and modified. Properties that do not have the same
value will have an ellipsis entry indicating multiple values. The ellipsis can be clicked
and parameters modified as normal, thus setting that value to all objects; for example,
color or layer.

 

After Properties have been suitably modified, click the right mouse button to end the
command and apply parameter modifications.

 

Drop-down menus in the Properties tab allow for parameter selection just as in the commands that create objects. Reference specific commands for detailed information on parameters.

javascript:TextPopup(this)
javascript:TextPopup(this)
http://en.wikipedia.org/wiki/Centroid
javascript:TextPopup(this)
http://en.wikipedia.org/wiki/Surface_normal
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


4.4.3 Calcula�on Zone Proper�es
Calculation Zone properties are shown in the Sidebar when the Properties command is active and Calculation Zone objects are selected.

To activate the Properties command, click the Properties button on the Home tab
of the Ribbon Bar or in the Sidebar, or press the "P" hotkey. When a Calculation
Zone object is selected, Visual displays the properties for that object in the Sidebar.

 

For Calculation Zone objects, Visual displays:   

The Status panel contains Calculate and Visible menus that allow control of
individual objects. Selecting "Yes" means the object(s) will be used in calculations or
will be visible. Selecting "No" means the object(s) will not be used in calculations and
will not be visible. "ByLayer" indicates that control of object visibility and use in
calculations is controlled by selections made in the Layer Manager for Editability and
Calculation State.

Once an object has been made not visible with this dialog, the only way to get access
to the object is through the Design Manager where the object can be selected and
made visible again, for example.

 

The Layer panel indicating on which layer the object resides. The layer may be
changed by clicking the drop-down menu arrow on the right. "System Layers" is the
default and is in fact a Layer Group, which indicates the object is on the
Background layer of the System Layers group. See Layers for more information.

 

The General panel contains:

Name is the user-specified name or the Visual default.

Area is shown in square feet or square meters inside the polygonal solid boundary.

Center is the X,Y,Z triplet coordinates for the geometric center of the Polygon.

Point Spacing shows the spacing of points in X and Y axes respectively and allows
modification with drop-down menus and the associated text boxes.

 

The Calculation Points panel contains:

Color shows the currently selected Color and allows for modification with the Color
dialog.
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Lower Limit defines the Color of the value highlight and allows specification of the
type of highlight. Minimum indicates only the lowest value is highlighted. Choosing a
value from the drop-down or typing a value will highlight values less than or equal to
that value.

Upper Limit defines the Color of the value highlight and allows specification of the
type of highlight. Maximum indicates only the highest value is highlighted. Choosing a
value from the drop-down or typing a value will highlight values greater than or equal to
that value.

Decimal indicates how many digits are displayed.

Point Style illustrates the selected symbol used to indicate each calculation point
and allows modification to one of 5 choices.

The Display panel contains:

Calculation Points is a checkbox indicating if points are shown or not.

Contours is a checkbox indicating if the iso-illuminance contours are displayed or not
on a per-zone basis. Once Contours are turned on in the Calculations tab of the
Ribbonbar, this allows for individual zone contours to be displayed or not.

Shaded is a checkbox indicating if pseudo-color shading is turned on or off.

 

The Calculation panel contains:

Type is a drop-down menu for selection of one of the 7 ways in which Visual handles
meter orientation.

Measurement is a drop-down menu allowing selection of one of 4 calculation
units/methods.

Reflectance is a text box for specification of the necessary parameter for
non-Illuminance calculations.

See Calculation for more information.

 

The Calculation Parameters panel contains:

Normal is the direction the perpendicular to the surface points in a unit vector. i.e.
(0,0,1) would indicate the plane of the Calculation Zone is in the positive Z direction.

Orientation indicates the rotation of the "meter" associated to each point of the
Calculation Zone with respect to the 0° X-axis.

Tilt is the angle of inclination of the "meter" associated to the Calculation Zone with
0° being straight up, 90° being at the horizon, and 180° being straight down.

 

When modifying a Calculation Zone created with the TV option, Visual displays the
location of the camera for modification. See Calculation Types
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The Flip button rotates the surface Normal 180°. When using the Calculation
Zone Surface command, Visual places the grid on the "front" face of the solid.
Depending on the order in which the vertices were chosen, the result of this command
may not place the grid on the desired side. Therefore, the Flip button would make the
other side of the solid the "front" and Visual would place the grid on the opposite side.

 

Multiple objects can be selected and modified. Properties that do not have the same
value will have an ellipsis entry indicating multiple values. The ellipsis can be clicked
and parameters modified as normal, thus setting that value to all objects; for example,
color or layer.

 

After Properties have been suitably modified, click the right mouse button to end the
command and apply parameter modifications.

 

Drop-down menus in the Properties tab allow for parameter selection just as in the commands that create objects. Reference specific commands for detailed information on parameters.
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4.4.4 Luminaire Proper�es
Luminaire properties are shown in the Sidebar when the Properties command is active and Luminaire objects are selected.

To activate the Properties command, click the Properties button on the Home tab
of the Ribbon Bar or in the Sidebar, or press the "P" hotkey. When a Luminaire
object is selected, Visual displays the properties for that object in the Sidebar.

 

For Luminaire objects, Visual displays the following panels:   

The Layer panel indicating on which layer the object resides. The layer may be
changed by clicking the drop-down menu arrow on the right. "System Layers" is the
default and is in fact a Layer Group, which indicates the object is on the
Background layer of the System Layers group. See Layers for more information.

 

The Status panel contains Calculate and Visible menus that allow control of
individual objects. Selecting "Yes" means the object(s) will be used in calculations or
will be visible. Selecting "No" means the object(s) will not be used in calculations and
will not be visible. "ByLayer" indicates that control of object visibility and use in
calculations is controlled by selections made in the Layer Manager for Editability and
Calculation State.

Once an object has been made not visible with this dialog, the only way to get access
to the object is through the Design Manager where the object can be selected and
made visible again, for example.

 

The Luminaire Type panel contains:

Luminaire Selector, which is a reduced drop-down version of the Luminaire
Schedule. showing Luminaire Label and Count. The drop-down menu shows the
truncated schedule Label, Count, and Catalog Number.

Candela Distribution showing the shape of the luminaire output with the name of
the photometric file below the polar plot.

 

The Position panel contains:

Aim Point is an editable X,Y,Z triplet indicating where the Luminaire is aimed.
Unless the Luminaire was inserted with Place & Aim, Visual assumes the aim point
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to be in the Z=0 plane.

Insertion Point is an editable X,Y,Z triplet indicating where the Luminaire is placed.
Unless the Luminaire was inserted with Place & Aim, Visual assumes the
placement to be in the Z=0 plane.

Mounting Height  of a Luminaire is set when a Luminaire is placed and can be
modified to any value to suit the design intent.

Orientation indicates the rotation of the Luminaire with respect to the 0° X-axis.
See 3.2 The Luminaire Editor for more information.

Tilt is the angle of inclination with 0° being straight down, 90° being at the horizon, and
180° being straight up.

The Display panel contains:

Aim Line is a checkbox that turns on or off the display of the line from the Luminaire
to the Aim Point. This can be very useful to illustrate where luminaires are aimed for
certain project types like facade lighting.

Photometric Web is a check box that turns on or off the display of a pseudo-scaled
3-D mesh illustrating the shape of the candela distribution for the selected Luminaire.

Label Location is a drop-down menu with 5 location choices to avoid possible
overlap of Labels when displayed in certain situations.

 

Multiple objects can be selected and modified. Properties that do not have the same
value will have an ellipsis entry indicating multiple values. The ellipsis can be clicked
and parameters modified as normal, thus setting that value to all objects; for example,
color or layer.

 

After Properties have been suitably modified, click the right mouse button to end the
command and apply parameter modifications.

 

Drop-down menus in the Properties tab allow for parameter selection just as in the commands that create objects. Reference specific commands for detailed information on parameters.
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4.4.5 Solid Proper�es
Solid properties are shown in the Sidebar when the Properties command is active and Solid objects are selected.

To activate the Properties command, click the Properties button on the Home tab
of the Ribbon Bar or in the Sidebar, or press the "P" hotkey. When a Solid object
is selected, Visual displays the properties for that object in the Sidebar.

 

For Solid objects, Visual displays the following panels:   

The Layer panel indicating on which layer the object resides. The layer may be
changed by clicking the drop-down menu arrow on the right. "System Layers" is the
default and is in fact a Layer Group, which indicates the object is on the
Background layer of the System Layers group. See Layers Tab for more
information.

 

The Status panel contains Calculate and Visible menus that allow control of
individual objects. Selecting "Yes" means the object(s) will be used in calculations or
will be visible. Selecting "No" means the object(s) will not be used in calculations and
will not be visible. "ByLayer" indicates that control of object visibility and use in
calculations is controlled by selections made in the Layer Manager for Editability and
Calculation State.

Once an object has been made not visible with this dialog, the only way to get access
to the object is through the Design Manager where the object can be selected and
made visible again, for example.

 

The General panel contains:

Name is the user-specified name or the Visual default.

Area is shown in square feet or square meters inside the polygonal solid boundary.

Normal is the direction the perpendicular to the surface points in a unit vector. i.e.
(0,0,1) would indicate the front surface is in the positive-Z direction. The Flip button
orients the Surface Normal 180° from its current position and thus changes the
"front" to the "back".

Reflectance is the numerical value and associated color of the solid.

Transmittance is set to 0% and diffuse by default when creating an object.
Transmittance can be modified to be higher and/or Transparent. Diffuse
Transmittance is like an opal acrylic where a clear image cannot be seen through
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the material.

The Render panel allows for one or both sides of a Solid Object to be hidden in
Rendered Display Mode. Placing a check in the box indicates that selection will be
hidden.

 

The Coordinates panel shows all vertex coordinates in  X,Y,Z triplets and is not
editable.

 

The Flip button rotates the surface Normal 180°. When using the Calculation
Zone Surface command, Visual places the grid on the "front" face of the solid.
Depending on the order in which the vertices were chosen, the result of this command
may not place the grid on the desired side. Therefore, the Flip button would make the
other side of the solid the "front" and Visual would place the grid on the opposite side.

 

The Link button connects the solid Reflectance to the Color. When Color and
Reflectance are Linked, Visual will adjust the Reflectance value based on the
chosen Color. In complex designs not involving Rendering, it may be advantageous
to color objects differently in the model for identification without impacting the
calculations.

 

When a Room or Structure is selected, Visual displays the associated Solids in
the Surfaces section of the Sidebar. Selecting one of the Surfaces in the Sidebar
populates the General and Coordinates sections with the associated information.

See Ribbonbar Properties Tab for information on how Single Selection and
Multiple Selection impact selection of Grouped objects.

 

Multiple objects can be selected and modified. Properties that do not have the same
value will have an ellipsis entry indicating multiple values. The ellipsis can be clicked
and parameters modified as normal, thus setting that value to all objects; for example,
color or layer.

 

After Properties have been suitably modified, click the right mouse button to end the
command and apply parameter modifications.
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Drop-down menus in the Properties tab allow for parameter selection just as in the commands that create objects. Reference specific commands for detailed information on parameters.
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Chapter 5 - Model Construc�on

Flexibility is one of Visual's most powerful attributes. Achieving maximal benefit of
flexibility without over-complicating the data entry process can be quite challenging
however.

A method was sought to provide a simple means of constructing lighting models to
any level of complexity without compromising the speed with which more common or
basic configurations can be entered.

The solution lies in a flexible, graphic-based system similar in function to CAD
programs. The following chapter introduces the basic components of a Visual lighting
model and describes the process by which they are created and located within the
model space.
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5.1 Construc�ng Background Objects
Background Objects are very useful for communicating visual information independent of the lighting analysis.

Background Objects can be invaluable as an aid in the construction of complex
models. Lines may be initially placed so that their endpoints terminate at key locations
in the model space. Solid Objects can then be added using the Endpoint Object
Snap method so that the Lines essentially act as a skeletal map for construction.

Since Lines may be extended and trimmed (see Modify), this is often the easiest way
to enter complex geometry such as multiple sloped planes. Lines used as a
construction aid are easily erased or made invisible once the model has been
completed.

 

A common use for Background Lines is to represent ceiling grid. The Lines can
be made Inactive (but still Visible) to disallow selection of them while moving
Luminaires but Luminaires may be placed with the Intersection Object Snap
and moved into the center of a "tile". See Placing and Orienting Luminaires.
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5.1.1 Arcs
Arcs are Circle segments constructed in Visual by selecting start and end coordinates, and a "bulge" vector.

To construct an Arc, select the command from the Reference panel of the
Construct tab in the Ribbonbar.

 

Select the Arc start and end coordinates by either navigating the mouse crosshairs to
the appropriate coordinate location, entering the coordinates numerically at the
Command Line, or by selecting an object using one of the Object Snap methods.

 

After both start and end points are specified, Visual displays the "bulge" vector that is
tangent to the Arc at the endpoint.

Visual also draws the implied Arc to show the result prior to final coordinate selection.

Moving the mouse to the opposite side of the line connecting the start and end points
will cause the mirror-image Arc to be drawn.

Left-click to select the coordinate location that results in the desired Arc and end the
command.

 

While executing the command, Color, Weight, and Style can be selected from the
Properties tab in the Ribbonbar that will automatically be shown. See Using the
Color Dialog for information on selecting Color.

 

Remember that construction of any object can occur in different planes by pressing the Tab key.
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5.1.2 Axis
Visual can draw numbered axes to allow for coordinate identification in the Design Environment and when making a printed Page in Print Editor.

The Axis button can be found on the Construct tab of the Ribbonbar.  

To create an Axis, select the Base Point with the mouse, keyboard, or Object
Snap.

 

Movement of the mouse in the command shows the implied Axis that will be drawn in
the Active Plane.

 

Axis Increment indicates how far apart Axis tick marks and labels are created.

At right, the Axis command has been used to draw an Axis from the (0,0,0) origin in
each of the x, y, and z cardinal directions.

 

Select the endpoint of the Axis line with the mouse, keyboard, or Object Snap.
Visual automatically ends the command and draws the Axis.

 

The Global Axis option restricts the Visual Axis to being parallel with one of the
Cartesian axes. Axis labels are coincident with the X, Y, or Z-dimension related to that
spot on the Axis.

 

The Relative Axis option allows for an Axis to be placed such that labels are based
on zero being the Base Point of the Axis as specified and labelling is independent of
global (X.Y.Z) coordinates. The Axis can be applied at any angle in the Active Plane.
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At right, the global coordinates are indicated for each Relative Axis, which then aligns
with the Global Axis example above.

After creation, Layer, Color, and visibility Properties can be modified.

Label, line, and tick mark use the same Color for each Axis.

 

The most common use for an Axis would be in conjunction with the insertion of a Luminaire Locations table on a printed page to allow for the end-user to discern (x,y) coordinates of pole
locations related to site lighting projects.
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5.1.3 Circles
Background Circles can be drawn in Visual.

The buttons for Background Circles can be found in the Construct panel on the
Home tab of the Ribbonbar or in the Reference panel on the Construct tab.

 

Color, Weight, and Style can be selected from the Properties tab in the
Ribbonbar that will automatically be shown. See Using the Color Dialog for
information on selecting Color. See Lines and Polylines for information on Weight
and Style.

Examples shown here are drawn with a Weight of "3".

 

To construct a Circle, specify the coordinates of the first vertex (the center of the
circle) using the mouse, keyboard, or Object Snap. In the command, moving the
mouse causes Visual to draw the implied radius vector and the implied Circle
showing what will be created when the command is completed. Specify the radius. To
end the command, right-click the mouse or press Enter.

 

During any command, Undo will remove the last specified coordinate (vertex).   

Background Circles can be converted to Solids if necessary. See Converting
Object Types. (Note that in the example at right, the Background object has a Line
Width of 3.)

 

Remember that construction of any object can occur in different planes by pressing the Tab key.
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5.1.4 Lines and Polylines
Lines and Polylines are constructed in an identical fashion and the separation of the two in Visual is purely semantics.

Polylines are a connected series of Line segments. A vertex is the connection of
two segments.

 

Lines are single segments with a start and an end point.  

To construct a Line or Polyline, click the Line button in the Construct panel of the
Home tab or in the Reference panel of the Construct tab in the Ribbonbar.

 

Specify the coordinates of the first vertex using the mouse, keyboard, or Object
Snap.

Specify additional coordinates as necessary.

Right-click the mouse or press Enter to end the command.

Even when Polylines appear to be closed (as at right), Visual does not consider
them to be closed and therefore Polygons. The Polygon command must be used
to make Polygons.

 

While executing the command, Color, Weight, and Style can be selected from the
Properties tab in the Ribbonbar that will automatically be shown. See Using the
Color Dialog for information on selecting Color.

 

Line Weight can be changed by selecting from one of the five values in the drop-
down list. Values are the width in pixels the line will be drawn regardless of Zoom
value.
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The available Styles for Lines and Polylines are shown at right.  

Remember that construction of any object can occur in different planes by pressing the Tab key.
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5.1.5 Polygons
Background Polygons can be created in Visual.

The buttons for Background Polygons can be found in the Construct panel on
the Home tab of the Ribbonbar or in the Reference panel on the Construct tab.

 

Color, Weight, and Style can be selected from the Properties tab in the
Ribbonbar that will automatically be shown. See Using the Color Dialog for
information on selecting Color. See Lines and Polylines for information on Weight
and Style.

Examples shown here are drawn with a Weight of "3".

 

To construct a Polygon, specify the coordinates of the vertices using the mouse,
keyboard, or Object Snap. In the command, moving the mouse causes Visual to
draw two types of implied lines: the small-dash line connects the cursor to the first
vertex and the large-dash line connects the cursor to the last vertex specified. Visual
also shows the implied connection between the first and last vertices to illustrate the
result if the command is ended. To end the command, right-click the mouse or press
Enter.

 

During any command, Undo will remove the last specified coordinate (vertex).   

Background Polygons can be converted to Solids if necessary. See Converting
Object Types. (Note that in the example at right, the Background object has a Line
Width of 3.)

 

Remember that construction of any object can occur in different planes by pressing the Tab key.
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5.1.6 Rectangles
Background Rectangles can be drawn in Visual.

The buttons for Background Rectangles can be found in the Construct panel on
the Home tab of the Ribbonbar or in the Reference panel on the Construct tab.

 

Color, Weight, and Style can be selected from the Properties tab in the
Ribbonbar that will automatically be shown. See Using the Color Dialog for
information on selecting Color. See Lines and Polylines for information on Weight
and Style.

Examples shown here are drawn with a Weight of "3".

 

To construct a Rectangle, specify the coordinates of the first vertex using the
mouse, keyboard, or Object Snap. In the command, moving the mouse causes
Visual to draw the implied Rectangle showing what will be created when the
command is completed. To end the command, right-click the mouse or press Enter.

 

During any command, Undo will remove the last specified coordinate (vertex).   

Background Rectangles can be converted to Solids if necessary. See Converting
Object Types. (Note that in the example at right, the Background object has a Line
Width of 3.)
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5.1.7 Text
Background Text is useful for annotating features of a lighting model or describing particular aspects of a lighting design.

To add Background Text to a design, select the Text command from the
Construct menu.

The Text Editor, will appear.

 

Type the desired text into the editing area of the Text Editor.

Height can be specified in the same units as used in the Design Environment for
other elements; feet or meters. To select the Height , choose one of the options from
the drop-down menu or enter a value (integer or decimal) with the keyboard. The
Height of the "tall" letters will be drawn to that size; for example "I",  "t", or "d".

Left, Center, or Right Alignment can be chosen. Examples of the output are
shown below.

The Wordwrap button will cause Text to be placed on multiple lines. Without this
button active (gold), Visual will place all Text on one line.

Pressing the Enter key inserts a carriage return, and unlike most other commands,
does not end the command, for obvious reasons.

Click the Insert button to continue.

 

Visual requires the specification of a line to know where to place the Text. Specify the
first and second points with the mouse, the keyboard, or with Object Snap. Visual
places the Text along that line. The specification of the second point ends the
command automatically and places the text. (Visual does not draw the line once the
text is placed.) Alternately, right-clicking the mouse ends the command and uses the
default (0 degrees) orientation.

 

Visual will place Text at any angle specified by the implied line between the two points.
For example, specifying the second point to the left of the first draws the Text inverted.

 

As mentioned above, Wordwrap can be set to Left (default), Center, or Right
Alignment  with respect to the two input points.

 

Text Color is set by the Layer on which it resides. Unlike other Background
objects, Text does not have Color unto itself.
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It is possible that characters entered into the Text Editor cannot be displayed by
Visual. In that case, a substitute symbol is inserted instead. This is rare.

 

The "Visual font" is shown at right for reference.  

Note that when importing CAD information in DWG or DXF format, any Text in the file is converted to the Visual font.

To place formatted text using typical fonts, colors, and other augmentation, see Text for information on placing text in the Print Editor.
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5.2 Construc�ng Solid Objects
Solid Objects (Solids) are an important component of lighting system analysis.

Rooms, Structures, and Walls (or other more complex obstructions like
modular furniture shown at right) can all have a dramatic impact on lighting system
performance and it is frequently important to model these features to then take
them into account in the calculation.

 

In Visual, such items are comprised of one or more Solid Objects in the form of
Rectangles, Polygons, or Circles.

Solids can be constructed in a pre-grouped fashion as Rooms and Structures.

 

Visual creates Solid Objects with a coplanar front and back having the same properties. There is no need to create extra surfaces to have a correct model, as is the case in some other
lighting software. A common wall can be created between two rooms without impacting the average noticeably in most cases if it is convenient. For example, a 60x40 room versus a 61x41
room will have 1% difference in average illuminance with the same lighting system, which is inside the 2% standard photometric test error. Imported CAD files almost always contain both
sides of a given wall, and when an enclosed Room is created, Visual's algorithms calculate succinctly so the seeming duplication is not a detriment. See Rooms and Structures for more
information.

Solids are created with a Surface Normal to discern the front face from the
back face. This is stored in the object Properties and accessed with the
Properties command. The Surface Normal is a unit vector indicating direction.
(0,0,1) indicates the positive-Z direction. (0,1,0) indicates the positive-Y direction.
(1,0,0) indicates the positive-X direction.

The Surface Normal is important in that Visual uses that information (which side
is the front side) when for example a Calculation Zone is placed on a Solid.
See Placing Calculation Zones on Existing Solid Objects

The Surface Normal can be "Flipped" by modifying object Properties. See
Solid Properties.

 

Solid Circles, Rectangles, and Polygons can be converted to Background
objects if necessary. See Convert to Background. (Note that the resulting
Background objects will have a Line Width of 1.)
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It is important to select Color and Reflectance to align with the properties of the
materials in the actual project. For example, 80% Reflectance is valid for a ceiling
composed of higher end acoustic tile, but is certainly not appropriate for raw
materials used in most "open to deck" scenarios or sprayed-on insulation,
especially when an indirect luminaire is used. The default is 50% Reflectance for
all Solids.  

 

The choice of a Color is only necessary if Color Rendering is a desired output
from Visual. Grayscale choices yield the same numeric results as "colored"
choices, assuming the Reflectance value is the same.

The Color and Reflectance chosen for Solids is independent of the Layer
Color. The Layer Color is used to provide user feedback in the Design
Environment and the Color and Reflectance is used for calculation.

On the right, the objects with a black border have different Color (and therefore
Reflectance ) on the Solids System Layer (Color is ByLayer) and those
with a green border are on a separate Layer, also with different Color (and
Reflectance ). In Shaded Display Mode shown at the bottom, borders (drawn
in the Layer Color) are not shown. The gray, red, and blue all yield the same
calculational result because they are all 50% Reflectance .

 

Solid Objects can be modeled to simply block the direct travel of light or reflect
light diffusely. See Solid Object Properties for more information.

 

Solids can be modified to transmit light diffusely or transparently. See Solid
Object Properties for more information.

 

The following section will detail the various methods used to construct and assign properties to Solid Objects along with some useful techniques for rapidly developing both common and
complex architectural geometry.
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5.2.1 Circles
The most basic means of entering Solid Objects (Solids and/or Surfaces) is by coordinate selection, building one surface at a time. Coordinates are identified, either graphically or by text
coordinate entry at the Command Line, to define the location and orientation of each Solid Objects.

The button for Solid Circles can be found in the Solids panel on the Construct tab
of the Ribbonbar.

 

Solid Circles share a similar interface in the Properties tab of the Ribbonbar that
is shown upon command execution.

Solids can be named for later reference. If no name is user-defined, Visual will call all
Solid Objects "Solid". Naming objects can be useful, but it is not required.

The Color and Reflectance of Solids are tied together in Visual. Specifying a
numeric Reflectance will cause Visual to choose the analogous gray shade to
match. Clicking the Color button will launch the Color Dialog to allow for more
detailed Color selection.

 

To construct a Solid Circle, specify the coordinates of the first vertex (the center of
the circle) using the mouse, keyboard, or Object Snap. In the command, moving the
mouse causes Visual to draw the implied radius vector and the implied Circle
showing what will be created when the command is completed. Specify the radius. To
end the command, right-click the mouse or press Enter.

 

Note that Visual creates faceted Circles based on system parameters. If large
Circles are being created, it may be necessary to modify the parameter to yield a
smooth Circle. See Drawing Aids Settings for more information.

 

See Constructing Solid Objects for important information about various parameters and behavior of Solid Objects.
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5.2.2 Polygons
The most basic means of entering Solid Objects (Solids and/or Surfaces) is by coordinate selection, building one surface at a time. Coordinates are identified, either graphically or by text
coordinate entry at the Command Line, to define the location and orientation of each Solid Objects.

The buttons for Solid Polygons can be found in the Construct panel on the Home
tab of the Ribbonbar and in the Solids panel on the Construct tab.

 

Solids can be named for later reference. If no name is user-defined, Visual will call all
Solid Objects "Solid". Naming objects can be useful, but it is not required.

The Color and Reflectance of Solids are tied together in Visual. Specifying a
numeric Reflectance will cause Visual to choose the analogous gray shade to
match. Clicking the Color button will launch the Color Dialog to allow for more
detailed Color selection.

 

To construct a Polygon, specify the coordinates of the vertices using the mouse,
keyboard, or Object Snap. In the command, moving the mouse causes Visual to
draw two types of implied lines: the small-dash line connects the cursor to the first
vertex and the large-dash line connects the cursor to the last vertex specified. Visual
also shows the implied connection between the first and last vertices to illustrate the
result if the command is ended. To end the command, right-click the mouse or press
Enter.

 

Solid Polygons cannot be self-crossing. Visual makes the determination at the
completion of the command and provides a message box. All coordinate input during
the command is lost; therefore careful selection of points should be made.

For example, the perimeter of a complex large parking lot is being traced with an
Imported CAD file as reference. There can easily be an improper selection when
Object Snap is used and the Polygon can be crossing without it being apparent.

 

See Constructing Solid Objects for important information about various parameters and behavior of Solid Objects.
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5.2.3 Rectangles
The most basic means of entering Solid Objects (Solids and/or Surfaces) is by coordinate selection, building one surface at a time. Coordinates are identified, either graphically or by text
coordinate entry at the Command Line, to define the location and orientation of each Solid Objects.

The buttons for Solid Rectangles can be found in the Construct panel on the
Home tab of the Ribbonbar and in the Solids panel on the Construct tab. The
Solid Circles button is only on the Construct tab.

 

Solids can be named for later reference. If no name is user-defined, Visual will call all
Solid Objects "Solid". Naming objects can be useful, but it is not required.

The Color and Reflectance of Solids are tied together in Visual. Specifying a
numeric Reflectance will cause Visual to choose the analogous gray shade to
match. Clicking the Color button will launch the Color Dialog to allow for more
detailed Color selection.

 

To construct a Rectangle, specify the coordinates of the first vertex using the
mouse, keyboard, or Object Snap. In the command, moving the mouse causes
Visual to draw the implied Rectangle showing what will be created when the
command is completed. To end the command, right-click the mouse or press Enter.

 

See Constructing Solid Objects for important information about various parameters and behavior of Solid Objects.
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5.2.4 Rooms and Structures
A large majority of projects will include Rooms and Structures that are Polygonal or Rectangular in plan view and will have flat ceilings and roofs. Visual includes the ability to quickly
construct these Rooms and Structures that are a pre-Grouped collection of Solid Objects (Solids and/or Surfaces).

Rooms and Structures can be created in Polygonal or Rectangular form. The
semantics of Surface Normals is the only difference: Rooms will have all normals
pointed inward. Structures will have all normals pointed outward; this aids surface-
based commands such as placing Calculation Zones.

Because of the orientation of normals, Rooms are normally used for Interior
calculations and Structures used in Exterior calculations. Structures could be
used to model details of an Interior project such as bookcases and desks.

 

The Room and Structure buttons can be found in the Construct panel of the
Home tab and the Solids panel of the Construct tab in the Ribbonbar.

 

The Room button is dual function; the upper portion executes the command, the
lower portion initiates a drop-down menu.

Once Polygonal has been chosen, the upper button portion will change to execute
that command with the next press and the graphic is changed accordingly. Selecting
Rectangular from the drop-down menu will revert the button to that mode.

 

The Structure button is dual function; the upper portion executes the command, the
lower portion initiates a drop-down menu.

Once Polygonal or Wall has been chosen, the upper button portion will change to
execute that command with the next press and the graphic is changed accordingly.
Selecting one of the other commands from the drop-down menu will revert the button
to that mode.

 

Rooms or Structures share a similar interface in the Properties tab of the
Ribbonbar that is shown upon command execution. Note the similarities to single
Solid construction.

Rooms and Structures can be named for later reference. If no name is user-
defined, Visual will call the Grouped Solid Objects "Solid". Individual Surfaces are
named "Floor", "Ceiling", and Wall x" accordingly.  Naming objects can be useful, but it
is not required.
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The Height of the Room or Structure must be specified. Note that the Height last
specified as input for the command will be used as the default (which can of course be
changed) upon the next execution of the command; the idea being that heights of
Rooms and Structures will be the same in most cases for a given project.

Parameters specified for one type of Room or Structure do not carry over to other
types.

The Color and Reflectance of Ceiling, Walls, and Floor are chosen individually.
Recall that Color and Reflectance and are tied together in Visual. Specifying a
numeric Reflectance will cause Visual to choose the analogous gray shade to
match. Clicking the Color button will launch the Color Dialog to allow for more
detailed Color selection.

To construct a Rectangular Room or Structure, specify the coordinates of the first
vertex using the mouse, keyboard, or Object Snap. In the command, moving the
mouse causes Visual to draw the implied Rectangle showing what will be created
when the command is completed. To end the command, right-click the mouse or
press Enter.

 

To construct a Polygonal Room or Structure, specify the coordinates of the
vertices using the mouse, keyboard, or Object Snap. In the command, moving the
mouse causes Visual to draw two types of implied lines: the small-dash line connects
the first point to the last specified point to illustrate the result if the command is ended
and the large-dash line connects the cursor to the last vertex specified. To end the
command, right-click the mouse or press Enter.

 

To construct a Wall, specify the coordinates of the vertices using the mouse,
keyboard, or Object Snap. Visual will extrude the specified polyline to the Height
chosen in the Properties tab. In the command, Visual will connect the mouse cursor
to the last point specified with a solid line. Right-click the mouse or press Enter to end
the command.

 

Note that these commands can be used when the Active Plane is set to Y-Z or X-Z.
Extrusion (the effective operation that gives Rooms and Structures their Height)
occurs in the positive direction perpendicular to the Active Plane.
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It is important to select Color and Reflectance to align with the properties of the
materials in the actual project. For example, 80% Reflectance is valid for a ceiling
composed of higher end acoustic tile, but is certainly not appropriate for raw materials
used in most "open to deck" scenarios or sprayed-on insulation, especially when an
indirect luminaire is used. The default values for Rooms are 80% ceiling, 50% wall,
and 20% floor Reflectance (often referred to as "80/50/20"). Structures and Walls
have 50% Reflectance for all Solids.  

 

The choice of a Color is only necessary if Color Rendering is a desired output
from Visual. Grayscale choices yield the same numeric results as "colored" choices,
assuming the Reflectance value is the same.

The Color and Reflectance chosen for Solids is independent of the Layer Color.
The Layer Color is used to provide user feedback in the Design Environment and
the Color and Reflectance is used for calculation.

On the right, the objects with a black border have different Color (and therefore
Reflectance ) on the Solids System Layer (Color is ByLayer) and those with a
green border are on a separate Layer, also with different Color (and Reflectance ).
In Shaded Display Mode shown at the bottom, borders (drawn in the Layer
Color) are not shown. The gray, red, and blue all yield the same calculational result
because they are all 50% Reflectance .

 

The Solids created by these commands are Grouped. See Group for more
information. Note that Solid Objects are named "Floor", "Ceiling", and Wall x"
accordingly.

Rooms and Structures can be modified with the Properties command just like
single objects. When a Room or Structure is selected, Visual displays the
associated Solids in the Surfaces section of the Sidebar (as shown at right). See
Ribbonbar Properties Tab for information on object modification and how Single
Selection and Multiple Selection impact selection of Grouped objects when
editing Properties.

 

Note that Rooms and Structures can be created, Exploded, and modified as part of the process of drawing more complex models. For example, a Structure could be created mimicking a
column then Exploded, the top and bottom (ceiling and floor) Erased, and then the objects re-Grouped for later ease of use. See Modify.
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Chapter 6 - Modify
Ease of modification is a critical factor when modeling lighting systems. This is partly due to the complexity of the overall architectural design process (project phases and revisions for example)
and the fact that lighting design is largely a matter of iterative process and analysis. The initially constructed model and the final design are rarely one and the same.

The Modify tab of the Ribbonbar contains
commands to alter the current model.

 

This chapter will introduce the concepts and commands used in Visual to permit modification of lighting designs. Discussion of the Copy, Extrude, Pull, Array Polar, Array Rectangular,
Mirror, and Offset are commands can be found in  Constructing by Reference.
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6.1 Array Polar
The Array Polar command applies to all object types and is used to create multiple copies of all selected objects in columns (x-direction), rows (y-direction), and/or levels (z-direction). The most
common use of the Array Polar command is with Solid Objects since they are most often placed in such Arrays to models circular, spherical, and cylindrical objects.

The Array Polar command can be found on the Modify tab of the Ribbonbar.  

To Array Polar objects, left-click the object(s) to be used as the basis for the Array
with the selection box or use a selection window to select a set of objects. Right-click
to complete the selection process of base objects.

See Selecting Objects for information on object selection methods.

 

Spacing information for Arrayed objects must be provided in the Properties tab.
Angular Separation spaces newly created objects at the angle specified and
creates a total quantity (including the original object) also as specified. Positive angles
yield clockwise arrays; negative angles yields counterclockwise arrays. See below for
information on Angular Extent.

 

Specify a Base Point with the mouse, keyboard, or Object Snap.  

After selecting the Base Point for the Array, Visual automatically completes the
command.

At right, 24 objects are arrayed in a polar fashion 15° apart as is shown in
the Properties tab input boxes above.

 

Angular Extent allows the user to define how many objects are created (including
the original object) and then specify the total angular extent to fill with objects. The
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process is the same as before: select objects, specify a Base Point, and Visual
automatically completes the command.

Two examples that create a full faceted circle (polygon) are warranted to illustrate the difference between the angular options. Once the radial lines are arrayed, the faceted circle is drawn
with the Polyline command:

Angular Extent option: an angle of 360 is specified, and the number of objects to
use to fill that angle is chosen. A quantity of 24 yields 15° wedges that might be the
base of the hemisphere shown above, 6 yields a hexagon, and 8 yields an octagon.

 

Angular Separation option : the inputs left to right in the examples are 15° angle
and quantity of 24. 60° angle and quantity of 6, or 45° of angle and quantity of 8. At far
right, 15° and quantity of 7 yields 90° of arc.

[Angular Separation] X [Quantity] = [Angular Extent] e.g. 15 X 24 = 360 as above.

 

Like many commands, Array Polar can be used on Luminaires, Background Objects, Solid Objects, and Calculation Zones.
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6.2 Array Rectangular
The Array Rectangular command applies to all object types and is used to create multiple copies of all selected objects in columns (x-direction), rows (y-direction), and/or levels (z-direction).
The most common use of the Array Rectangular command is with Luminaire Objects since they are most often placed in such Arrays in reality.

The Array Rectangular command can be found on the Modify tab and the Home
tab of the Ribbonbar.

 

To Array Rectangular objects, left-click the object(s) to be used as the basis for the
Array with the selection box or use a selection window to select a set of objects.
Right-click to complete the selection process of base objects.

See Selecting Objects for information on object selection methods.

 

Spacing information for Arrayed objects must be provided in the Properties tab.
Array By Spacing spaces newly created objects at the distance specified. The
limits of the Array are specified with the mouse; defined by the Base Point and
Destination Point. See below for information on Array By Quantity.

 

Specify a Base Point with the mouse, keyboard, or Object Snap.  

After selection of a Base Point, movement of the mouse crosshairs within the
Design Environment will display a graphical representation of the selected objects
as they will be arrayed with the specified spacing to aid in the proper selection of a
Destination Point.

In the example at right, Luminaire Objects are pre-spaced at 6ft in the x-direction
and 4ft in the y-direction. The crosshairs indicate the current extent of the Array.
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Select a Destination Point with the mouse, keyboard, or Object Snap.  

After selecting the Destination Point, Visual automatically completes the command.  

Array By Quantity allows the user to define how many objects are created and then
specify the X, Y, and/or Z-spacing with the mouse, keyboard or Object Snap.

 

As before, moving the mouse in the Array By Quantity mode illustrates how the
columns and rows would be placed if the mouse was clicked in that location with the
quantity fixed and the spacing variable with mouse movement.

For example, at right, the mouse has been moved 2x2 and the 6 columns and 2 rows
are shown more compact than is likely desired.

 

Select a Destination Point that defines the X, Y, and/or Z-spacing with the mouse,
keyboard or Object Snap. For example, specifying a quantity of X=6 and Y=2 and
then using the mouse to specify Base Point and Destination Point 6x4 apart
yields the same Array as was shown above.

 

Like many commands, Array Rectangular can be used on Luminaires, Background Objects, Solid Objects, and Calculation Zones.
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6.3 Convert To Background
Solid Objects can be converted to Background Objects.

The Convert To Background command can be found on the Modify tab of the
Ribbonbar.

 

To Convert To Background, select the Solid Object to be converted by left-
clicking the object or using a window selection method.

 

Right-click the mouse or press Enter to end the command and make the conversion.
The new Background Object(s) will reside on the same Layer as the original
Solid Object(s).

 

Grouped Solid Objects (Rooms, Structures, etc) can be converted in bulk by
clicking the Group. Individual Polygons will be created since there is not an analog
to "group" Background Objects.

 

See Convert To Solid for the opposite functionality.
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6.4 Convert To Solid
Background Objects can be converted to Solid Objects.

The Convert To Solid command can be found on the Modify tab of the
Ribbonbar.

 

To Convert To Solid , select the Background Object to be converted by left-
clicking the object or using a window selection method.

 

Before or after object selection, a Name can be assigned in the Properties tab.
Additionally, a Color and Reflectance can be chosen (see Using the Color Dialog)
just as would be the case when using the Individual Construction methods.

 

Right-click the mouse or press Enter to end the command and make the conversion.
The new Solid Object(s) will reside on the same Layer as the original
Background Object(s).

 

Grouped Background Objects can be converted in bulk. All converted objects will
be assigned the same Name, Color, and Reflectance as chosen in the
Properties tab. Individual Solid Objects will be created and will not be made a
Group.

 

It should be clear that only closed planar polygons can be converted to Solid
Objects. Visual will validate the selection by effectively ignoring the object selection if
it cannot be converted.

It is routinely the case that objects appear to be a closed polygon. If they are closed,
they will be converted. If they are not converted, they are simply not closed regardless
of the appearance. The user must apply Trim and Extend to provide a single vertex for
Visual to use.

 

 See Convert To Background for the opposite functionality.
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6.5 Copy
The Copy command applies to all object types and is used to create single or multiple copies of all selected objects.

The Copy command can be found on the Modify tab and the Home tab of the
Ribbonbar.

 

To Copy objects, left-click the object(s) you want to Copy with the selection box or use
a selection window to select a set of objects. Right-click to complete the selection
process of base objects.

See Selecting Objects for information on object selection methods.

 

Specify a Base Point with the mouse, keyboard, or Object Snap.  

After selection of a Base Point, movement of the mouse crosshairs within the
Design Environment will display a  graphical representation of the selected objects
as they are being translated to aid in the proper selection of a Destination Point.

 

Select a Destination Point with the mouse, keyboard, or Object Snap. Select
additional Destination Points for each additional Copy you want to create. At right,
note that the base object is highlighted in red (the system Selection Color) and
newly created luminaires are shown in the Color assigned to them.

 

To complete the Copy command right-click the mouse or press Enter.  
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Copy can be used on Luminaires, Background Objects, Solid Objects, and Calculation Zones.
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6.6 Edit Text
Text placed in Visual (created natively or by Import) can be edited with the Text Editor.

The Edit Text command can be found on the Modify tab of the Ribbonbar.  

To Edit Text, left-click to select the Text to be edited.  

The Text Editor is immediately initiated. Unlike other Modify commands, the object
will not be highlighted in the Design Environment.

The selected Text is shown in the Text Editor and changes to Height, Alignment,
and Wrapping can be made just as when the Text was originally created.

The orientation of the Text cannot be modified after the Text Editor is closed. See
Rotate for information on changing the angle of the Text.

The Color of Text is modified with Properties based on Layer selection and object
parameters as was the case during Text creation.

 

Click Update to apply the changes and exit the Text Editor. Clicking Cancel
ignores changes and closes the dialog.
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6.7 Erase
The Erase command removes objects from the lighting model.

The Erase command can be found on the Modify tab and the Home tab of the
Ribbonbar.

 

To Erase one or more objects, select the objects by left-clicking or selecting multiple
objects with a window selection method.

 

Right-click or press Enter to end the command.  

Erase applies to all object types.
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6.8 Explode
The Explode command allows connected objects to be un-Grouped (for Solid Objects) or un-Joined (for Background Objects). Objects like Rooms, Structures, and Polygons are
pre-connected upon construction. It may be desirable to break this connection to Erase or otherwise modify one of the sub-objects.

The Explode command can be found on the Modify tab of the Ribbonbar.  

To Explode an object, select the object(s) to be Exploded by left-clicking or using a
window selection method.

 

Right-click to end object selection and Explode the objects. In most cases, the
explosion will not be immediately obvious. At right, note that a single surface of the
Solid Object Room and the long sides of a Background Rectangle can be
individually selected, whereas above, prior to the explosion, the entire Room and
Rectangle where selected with a single left-click on each.

 

The Background Objects: Polylines, Rectangles, and Polygons can be
Exploded.

 

The Solid Objects: Room, Structure, and Grouped objects can be Exploded.  

See Group and Join for methods of connecting objects.
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6.9 Extend
The Extend command increases the length of a Line or Polyline (not Arcs) to meet or touch the selected Base Object.

The Extend command can be found on the Modify tab of the Ribbonbar.  

To Extend one or more Base Objects, left-click or use a window selection method
to choose the Boundary Edges or object(s) to extend to. Right-click or press Enter
to end object selection. Two Boundary Edges are selected at right; a Solid Object
square and a Background Line.

 

Left-click each object to be Extended to the Boundary Edge(s). It is necessary to
left-click on the half of the object nearest the Boundary Edge.

After each click, Visual Extends the object.

 

Right-click or press Enter to end the command.  

Extend operates on objects based on the current view. i.e. an object at Z=0 can be
Extended to an object at Z+1 when viewed in the Plan View, even if the objects
don't mathematically intersect. This functionality can be an advantage when
constructing advanced geometries when used in N, S, E, or W views. At right, a line is
extended to a vertical Solid Object.

 

Important Note:

Extending in isometric views can yield unsatisfactory results if Boundary Edges
objects are not in the same plane as the Extended object. At top right, the Plan
View and South view of two objects are shown; a line and a square. The common
assumption is that the Line will be Extended to the center of the square when in an
isometric view. This is not the way the command functions. At bottom, the Line is
Extended in SW View, and when viewed in Plan View, the results are not likely
what was intended.
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Extend operates only on Background Objects. Arcs cannot be Extended. Solid Objects can be used as Boundary Edges.

 



6.10 Extrude
Extrude is a term that describes the process of "stretching" a linear or planar object linearly into a (in most cases) third dimension to create a 3-D Solid Object from it. See the Pull command
for a more graphical and WYSIWYG method of extruding.

Extrude is a powerful tool for modeling Solid Objects because extruded shapes are
commonly found in modern architecture. At right, some examples of extruded shapes
are shown. The original planar object is shaded and the arrows indicate the direction
of extrusion.

 

Any existing Solid Object may be Extruded. Select the Extrude command from
the Modify tab of the Ribbonbar. The Properties tab will appear allowing for entry
of command parameters.

 

An Extrusion Distance must be entered. The default direction of Extrusion is
perpendicular to the plane of the Solid Object, in the direction nearest the point of
view.

To extrude in the opposite direction, specify a negative Extrusion Distance.

 

When Directional Extrusion is chosen, the Command Line will prompt for the
base and destination points of a vector to establish the direction of Extrusion. In
terms of the graphics above and at right, the base would correspond to the tail of the
arrow and the destination would correspond to the head. The exact location of the
chosen base and destination points is irrelevant as they only serve to indicate a
direction. The base and destination points may be entered manually as well. For
example, a base point of (0,0,0) combined with a destination point of (1,0,1) would
result in the extrusion at right, which is in the X-Z plane at an angle of 45°.

 

The result of Extrusion is a single Solid Object having the same Reflectance
value (taken from the original planar object) on all surfaces. Should varying
Reflectance values need to be assigned, this can be accomplished by editing the
Reflectance values by using the Properties command. The Grouped Solid Object
can also be Exploded into its component Solids.

 

Extruding Background Objects follows a similar methodology as Solid
Objects. Select the object to be Extruded, specify the extrusion distance in the
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Properties tab, and right-click or press Enter to end the command.

Lines can be Extruded to make Rectangles.  

Note that the Extrusion process is the core of the behavior when executing the Room and Structure commands. Review Rooms and Structures before deciding to construct a Solid Object
and Extrude it; i.e. constructing a Room or Structure may be a quicker process.
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6.11 Fla,en
The Flatten command changes the Z-coordinate of selected Background Objects to zero. This is very useful when importing CAD files to use as reference for a design since various heights
of objects that are not germane to the project can exist.

The Flatten command can be found on the Modify tab of the Ribbonbar.  

To Flatten objects, select the desired objects by left-clicking or with a window
selection method. "All" is useful in this case; see Selecting Objects. Note the first
graphic at right is an elevation view of the X-Z plane.

 

Right-click or press Enter to end the command and the objects are changed to have Z
= 0. Note the first graphic at right is an elevation view of the X-Z plane and that all
objects now have a Z-coordinate of "0".

 

Flatten only operates on Background Objects.
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6.12 Group
The Group command allows Solid Objects to be connected. This can allow for collective editing of Properties, use of Modify commands, or in complex projects, a cleaner model.

The Group command can be found on the Modify tab of the Ribbonbar.  

To Group objects, select the desired objects by left-clicking or using a window
selection method.

 

Right-click the mouse or press Enter to end object selection and automatically
complete the command.

 

The Group command only applies to Solid Objects. See Join for the analog command for Background Objects.
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6.13 Join
The Join command allows Background Line and Polylines to be connected. This can allow for collective editing of Properties, use of Modify commands, or in complex projects, a cleaner
model.

The Join command can be found on the Modify tab of the Ribbonbar.  

To Join objects, select the desired objects by left-clicking or using a window selection
method.

 

Right-click the mouse or press Enter to end object selection and automatically
complete the command.

 

Lines or Polylines must touch and cannot cross at vertices. The level of Zoom
may indicate a viable vertex when one does not actually exist. The command will not
change the length of base objects; Extend and Trim must be used to "clean up" the
base objects.

 

Objects of different Color and Line Width will be made the Color and Line Width
of the object with the highest Polyline Number. The number of any Polyline can be
found with the Properties command. After Joining, the resultant Polyline can be
modified with Properties if desired.

 

The Join command only applies to Background Objects. See Group for the analog command for Solid Objects.

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_6_Modify/6.9_Extend.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_6_Modify/6.21_Trim.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_4_New_Features/Properties/4.4.2_Background_Properties.htm
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_4_New_Features/Properties/4.4.2_Background_Properties.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_6_Modify/6.12_Group.htm


6.14 Mirror
The Mirror command applies to all object types and is used to produce a Mirror image of selected items.

The Mirror command can be found on the Modify tab of the Ribbonbar.  

Select the objects to be Mirrored by left-clicking or with a window selection. Right-
click or press Enter to complete the selection process.

See Selecting Objects for information on object selection methods.

 

Mirroring occurs about a Mirror Line that must be user-specified. The mouse is
normally used for this, but keyboard and Object Snap input are also accepted. Left-
click to establish the first coordinate about which mirroring will occur.

In the example at right, it is known that the restrooms are symmetric and then the
midpoint of a line between walls can be used as the Base Point to mirror the
Luminaires, Solid Objects, and Calculation Zones.

 

As the mouse crosshairs are moved, an implied Mirror Line will be drawn from the
Base Point to the mouse cursor, and the Mirrored objects are temporarily shown to
assist in proper Mirror Line input.

 

file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_2_Getting_Started/2.11_Selecting_Objects.htm
javascript:TextPopup(this)


Specify the second point of the Mirror Line with the mouse, keyboard, or Object
Snap. Visual completes the command after the complete specification of the Mirror
Line.

Use of Orthogonal Mode is often an advantage since architecture is often parallel to
the Cartesian axes. Similarly, using the keyboard to specify "@1<90" also yields the
result at right.

 

Mirror can be used on Luminaires, Background Objects, Solid Objects, and Calculation Zones.
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6.15 Move
The Move command is used to uniformly translate selected objects in the Design Environment.

The Move command can be found on the Modify tab and the Home tab of the
Ribbonbar.

 

To Move one or more objects, Left-click on the object you want to Move with the
selection box or use a selection window to select a set of objects.

Right-click or press Enter to end object selection.

 

Select a Base Point with the mouse, keyboard, or Object Snap.  

After selection of a Base Point, movement of the mouse within the Design
Environment will display a graphical representation of the selected objects as they
are being translated to aid in the proper selection of a Destination Point.

 

Select a Destination Point with the mouse, keyboard, or Object Snap.

Visual automatically ends the command and Moves the object(s).

 

The Move command applies to all object types.
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6.16 Offset
The Offset command creates a Background Object similar to the base Background Object but applies non-linear scaling to change the shape accordingly.

The Offset command can be found on the Modify tab of the Ribbonbar.  

To Offset an object, select the base object by left-clicking with the mouse. Right-click
the mouse or press Enter to end object selection.

Offset operates on multiple objects but because results can be confusing, it is
recommended that Offsets be applied to one object at a time.

 

Select the Base Point with the mouse, keyboard, or Object Snap.

The Base Point can be positioned anywhere related to where the Offset is desired;
it does not have to be on the side of the object where the new object will be created.
The Base Point defines the first end of a direction vector that tells Visual how to
make the Offset.

 

The Offset Distance must be specified in the Properties tab of the Ribbonbar.

The Offset of the object is made parallel to the base object.

 

Moving the mouse after selection of the Base Point shows the implied Offset in red.
The direction of the offset is based on an imaginary line (shown in gray at right) drawn
parallel to the base object. This imaginary line is not drawn in Visual.

Moving to one side or the other of the imaginary line changes the directional vector and
causes Visual to move the Offset object from one side to the other of the base object.

 

Select the second point of the direction vector. Visual automatically ends the
command, creating the new object(s). The new Background Object is created with
the same properties as the base object; Color and Width are preserved. Properties
can be modified if necessary.
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For multi-segment Background Objects, the behavior of the direction vector is
often non-linear and complex as can be seen at right. It is recommended that the
implied drawing feature inherent to the command be used to determine if the Offset is
desirable and/or where the Offset object will be created.

Polylines may need to be Exploded and/or Joined prior to Offsetting to create the
desired result.

 

Offset only applies to Background objects.
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6.17 Pull
The Pull command is effectively the same as the Extrude command with the exception that the Extrusion/Pull distance is specified with the mouse, the keyboard or Object Snap. Pull only
operates on Solid Objects.

The Pull command is found on the Modify tab of the Ribbonbar.  

To use the Pull command, select the objects to be manipulated by left-clicking. Right-
click or press Enter to proceed.

 

Visual will automatically begin Pulling the object by attaching the farthest extent to the
mouse crosshairs. Note that Pulling only occurs perpendicular to the plane of the
Solid Object chosen, with the positive direction of Pull being in the direction of the
Surface Normal. Moving the mouse shows the implied Pulled shape.

 

Left-click the mouse to choose the desired distance. Note that keyboard input is valid
in that a distance can be input; to Pull 10 units, enter "10" at the command line. Input
of direction information via the "<angle" method is not valid.

 

Pull only applies to Background Objects and Solid Objects.

file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_6_Modify/6.10_Extrude.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


6.18 Rotate
The Rotate command imparts an angular displacement to objects parallel to one of the Cartesian planes. Rotation occurs only in the Active Plane.

The Rotate command can be found on the Modify tab and the Home tab of the
Ribbonbar.

 

To Rotate one or more objects, select the objects by left-clicking or selecting multiple
objects with a window selection method.

 

Select the Base Point for rotation with the mouse, keyboard, or Object Snap.
Right-click or press Enter to end object selection.

 

Movement of the mouse in the command shows the implied rotation of the selected
objects. 0° is the X-axis if rotated in the X-Y or X-Z planes and the Y-axis if rotated in
the Y-Z plane.

 

Specify the angle to Rotate with the mouse, keyboard, or Object Snap. The
command will be automatically completed after the angle is specified with a left-click.
Specification with the keyboard at the Command Line requires a right-click or
pressing Enter to end the command.

Using Orthogonal Mode and the mouse, 90° rotations can be ensured without
having to rationalize clockwise or counterclockwise when viewed in 3-D.
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To Rotate an object vertically, simply choose the desired Active Plane, and repeat
the steps above. Since rotation can only be applied parallel to a Cartesian plane, the
exact (X,Y,Z) location of the Active Plane is not important. At right, rotation occurs in
the Y-Z plane, or in other words, the rotation occurs about the X-axis.

 

As an additional example, the same 3-D arrow is rotated at right in the X-Z plane, or in
other words, the rotation occurs about the Y-axis.

 

Rotate applies to all object types.
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6.19 Scale
The Scale command changes the size of objects based on the application of one or more factors to the (X,Y,Z) coordinates.

The Scale command can be found on the Modify tab of the Ribbonbar.  

To Scale one or more objects, left-click or select objects with a window selection
method.

Right-click or press Enter to end object selection.

 

Select a Base Point with the mouse, keyboard, or Object Snap. See below for
detailed information and examples.

Selection of the Base Point automatically completes the command.

 

A Scale Factor must be specified in the Properties tab. The factor can be any decimal value and is applied as would be expected; e.g. a Scale Factor of 2 would make objects twice
their original size and 0.5 would result in half size.

The Uniform option (the default) for Scale Factor applies a single factor to the X, Y,
and Z dimensions.

For example, at right a 1x1x1 cube becomes 2x2x2.

 

The Non-Uniform option for Scale Factor applies a separate factor to each of the
X, Y, and Z dimensions as specified in the individual Properties tab fields.

For example, at right, a 1x1x1 cube becomes 4x3x2.

 

Selection of the Base Point may cause a translation of the source object(s) with an increase or decrease in size:
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 1. Selecting a Base Point at the corner of an object changes the size but doesn't
cause a translation (a movement in the X, Y, and/or Z-direction). For example, with a
Uniform Scale Factor of 0.5, a 2x2 square is reduced to a 1x1 square and the
lower-left corner (being the Base Point) remains in the same location.

 

2. Selecting a Base Point at (0,0,0) changes the size and translates the object by the
same factor(s). For example, with a Uniform Scale Factor of 2, a 1x1 square
located at (3,2,0) would be moved to (6,4,0) and would become 2x2 in dimension.

 

3. Non-Uniform Scaling of a Solid or Background Circle yields an ellipse. For
example, a 2x2 Circle with Scale Factors of 2, 1, and 1 respectively yields an ellipse
with a major axis of 4 and a minor axis of 2. The Base Point here is the center of the
Circle.

 

Mathematically, the equations applied when scaling are shown at right.  

The Scale command applies to Background Objects, Solid Objects, and Calculation Zones. Luminaires cannot be scaled but their location can be scaled if, for instance, a CAD
Import file was misjudged to be drawn in feet and it was really inches, a 1/12 Scale Factor could be applied to the entire lighting model to correct the error.
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6.20 Stretch
The Stretch command changes the size or shape of objects non-proportionally. Stretch will effectively move the selected objects and then alter the adjoining objects.

The Stretch command can be found on the Modify tab and the Home tab
of the Ribbonbar.

 

To Stretch an object, left-click the object(s). A selection should be made to
fully select the object(s) that will remain the same shape. The process could
be thought of as "stretching the connectors to keep the base objects
attached as they are moved."

 

Select a Base Point with the mouse, keyboard, or Object Snap. This is
the first end of a direction vector that will define the amount and direction of
Stretch. Normally, a selection would be made on the object with the
mouse. Once an object is selected, the vertices will be highlighted. Multiple
left-clicks will select multiple objects. Right-click the mouse or press Enter
to end object selection.

 

Moving the mouse in the command shows the implied change to the base
objects, so the result can be verified before ending the command.

 

Select the end of the direction vector (Destination Point) with the mouse,
keyboard, or Object Snap and the command is automatically completed.

 

If the initial object selection is made at a vertex, behavior changes slightly.
The vertex will be moved and the abutting edges will be changed to suit that
selection. Note that only one vertex is highlighted. (This is the same
methodology as before except the base object is a zero-length line.)

 

Two examples illustrating behavior and usefulness:
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1. Multiple edges are selected, the mouse is moved to two positions, and
the final selection is made. Note that the selected objects do not change.
The objects adjacent to the selected objects morph to make the new shape.

 

2. A change has been made to a small office to increase the size by one
foot in width and a new CAD file has been Imported. (This can be seen at
right in the Background objects that are uneditable.) The appropriate
edges are selected with a crossing window method; including the
Calculation Zone. Finally, the new design is ready to be calculated after
the changes have been applied.

 

The Stretch command applies to all objects except Luminaires.
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6.21 Trim
The Trim command decreases the length of any Background Object (Lines, Polylines, Circles, and Arcs) to meet the selected Base Object or Boundary Edge.

The Trim command can be found on the Modify tab of the Ribbonbar.  

To Trim one or more Base Objects, left-click or use a window selection method to
choose the Boundary Edges or object(s) to extend to. Right-click or press Enter to
end object selection.

 

Left-click each object to be Trimmed to the Boundary Edge(s). It is necessary to
left-click on the half of the object nearest the Boundary Edge. After each click,
Visual Trims the object. At right, the previous Line is shown dashed along with the
clicked location.

 

Right-click or press Enter to end the command.  

Trim can also remove the included portion of the Trimmed object. The segment
bounded by the Boundary Edges will be removed wherever it may be. At right, the
previous Line is shown dashed along with the clicked location.

 

Trim operates on objects based on the current view. i.e. an object at Z=0 can be
Trimmed to an object at Z+1 when viewed in the Plan View, even if the objects don't
mathematically intersect. This functionality can be an advantage when constructing
advanced geometries when used in N, S, E, or W views.
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Important Note:

Trimming in isometric views can yield unsatisfactory results if Boundary Edge
objects are not in the same plane as the Trimmed object. At top right, the Plan View
and South view of two objects are shown. The common assumption is that the Line
will be Trimmed to the center of the square. This is not the way the command
functions. At bottom, the Line is Trimmed in SW View, and when viewed in Plan
View, the results are not likely what was intended.

 

Trim operates only on Background Objects. Solid Objects can be used as Boundary Edges.
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Chapter 7 - Luminaire
In Visual, each Luminaire has certain fundamental properties (photometric information, graphical representation, and descriptive information) that are common to all luminaires of that Luminaire
Type. Before luminaires can be placed and manipulated in the Design Environment, these properties must be defined in the Luminaire Schedule.  This is accomplished in the Luminaire
Schedule Editor.
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7.1 Luminaire Schedule
The Luminaire Schedule Editor allows for the creation and manipulation of the definitions of Luminaire Types to be placed in the Design Environment. The schedule is a spreadsheet
format that allows for manipulation of text fields, symbols, and other parameters.

The Luminaire Schedule Editor is accessed from the Luminaire tab. Alternately,
the Schedule button can be found in the Luminaire panel of the Home tab.

 

All necessary commands are included in the Toolbar located at the top of the
Luminaire Schedule Editor. Some commands can be executed with multiple
luminaires selected.

 

Left-clicking an entry in the Schedule Window will highlight it in yellow indicating it is
the Active Item with respect to command buttons. Holding the Ctrl key while left-
clicking additional entries will select multiple luminaires.

 

The window can be sized like any other Windows-based application with click-drag
operations on corners and window edges. Scroll bars allow for all luminaires and their
data to be shown.

 

Specific usage and commands are discussed in this chapter.  Content changes are passed to the Print Editor so Luminaire Types are defined identically in both places and the schedule is
the same.
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7.1.1 Crea�ng a Schedule Entry
In order to place luminaires in the Design Environment, they must be defined in the Luminaire Schedule.

To define a new Luminaire Type, left-click on the New button in
the Toolbar. The Photometric File Dialog will appear,
prompting for the selection of a photometric file. For information on
how to use the Photometric File Dialog, reference section
Selecting a Photometric File.

 

After a file is selected, a new Luminaire Schedule entry will be
created in the first available row in the Schedule Window. All
available information from the photometric file will be placed in the
appropriate fields of the new Luminaire Schedule item. If a field
is left blank, the photometric file did not contain that particular
information.

 

A default Symbol will be created for the new item based on the luminous opening dimensions included in the photometric file and not the physical dimensions of the entire luminaire. The
symbol dimensions can be modified if necessary; see The Symbol Editor.

 A Label will be assigned to the new Luminaire Type using the
first available letter in the alphabet. For example, if Luminaire
Types A,B, and F are defined, Visual will assign the newly created
type the letter "C".

 

Clicking the OK command button saves changes and will exit the
editor. Clicking the Cancel button exits without saving changes.
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7.1.2 Modifying a Schedule Entry
All fields defining a Luminaire Type can be edited in the Luminaire Schedule Editor to accommodate all scenarios of both text changes and performance modification.

Left-click on any part of a row in the Schedule Window to make that Luminaire
Type the Active Item.

 

To edit the Luminaire Symbol, move the mouse pointer over the Symbol field. The
Symbol field will become a button. Left-click on the button to launch the Symbol
Editor .  See The Symbol Editor for more information.

 

The Label can be thought of as the “name” of the Luminaire Type. The Label may
be any combination of alphanumeric characters.

 

 

The Quantity cannot be modified and will change as luminaires are added in the
Design Environment.

 

The Manufacturer can be any combination of alphanumeric characters, with a
maximum length of 255 characters.

 

The Catalog Number is generally the specific product tested but changes to this
field are frequent to indicate luminaire properties specific to the project at hand. This
field can be any combination of alphanumeric characters, with a maximum length of
255 characters.
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The Description can be modified to describe all luminaire properties as they relate to
the performance of the luminaire or perhaps related to the project. For example, it
could be indicated that the pendant indirect-direct at right was suspended 24" from the
ceiling if that dimension was consistent for all instances of the luminaire. This field is
255 characters maximum.

 

The Filename field displays the currently associated photometric file. Moving the
mouse pointer over the field causes it to become a button. Left-clicking this button
launches the Photometric File Dialog. Choosing a new file from the dialog will
overwrite the current Luminaire Type with the new file information.

 

The Number Lamps field can be modified to provide a linear change to the output of
the luminaire in Visual. For example, changing 2 lamps to 3 lamps would increase the
luminous intensity by a factor of 1.5 (3/2 = 1.5) at all angles.

Note: Any change to the number of lamps in a luminaire has a non-linear impact on the
shape of the distribution in reality, so changes to this field must be done very carefully
and with direct knowledge of the validity of the change for a particular scenario.

 

The Lumens Per Lamp field will initially show the value that was contained in the
photometric file, but it is most often changed to reflect the specific lamp that will be
used in the design.

 

The Light Loss Factor (LLF) field is auto-populated with a value of 1.00 that is often
used for "initial" conditions but should be changed to match equipment and installation
conditions as appropriate.

 

The Wattage field displays the input power for the luminaire when it was tested. This  
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value is initially read from the photometric file, but may be changed as necessary to
account for ballast loads or different lamp types. Modification of this value does not
change photometric output but it is critical to obtain proper lighting power density when
Power Zones are created. See Power Zones for more information.

A Template is a set of iso-illuminance contour lines that are associated with the
current Luminaire Type. To assign a Template to a Luminaire Type, make the
desired Luminaire Type the Active Item and click the Template button in the
toolbar. The Luminaire Template Editor will launch and Template values and
colors can be assigned. For information on using the Luminaire Template Editor,
reference section Luminaire Templates. Multiple luminaires can be selected by holding
the Ctrl key while left-clicking in order to assign the same Template to those selected
luminaires.
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7.1.3 Copying a Schedule Entry
Luminaire Types can be copied. A common use for this feature is luminaires with emergency batteries or wiring. The base photometric file is the same for both types, but modifications to
Catalog Number, Description, and Wattage would be appropriate to indicate the difference in the product to be used.

To Copy an existing Luminaire Type, select the entry to be copied by left-clicking on
the appropriate row in the Schedule Window to make it the Active Item.

 

Left-click the Copy button on the Toolbar. The selected entry will be appended to the
bottom of the list of Luminaire Types. The Label will be assigned based on the
earliest unused character in the alphabet.

 

The copied Luminaire Type can then be edited as necessary. See Modifying a
Schedule Entry for more information.
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7.1.4 Expanding a Schedule Entry
When a Luminaire Type has been defined with multiple Heads, the properties of each Head can be modified.  Multiple Heads are most common in area lighting projects, but there are also
some interior applications with track and retail lighting products. For information on how to create multi-headed Luminaire Types, reference Multi-head Luminaires.

When a Luminaire Type can be expanded, a plus-sign graphic will appear at the left
side of the entry in the Luminaire Schedule. To expand the item, left-click the
symbol.

 

With the exception of Label and Quantity, all fields can be modified on a per-Head
basis. The Head to which the entry applies is shown in red in the sub-Symbol.

Most often, the need for a different photometric file would be the impetus for this
process. Select a new photometric file as appropriate for each head and modify the
other fields as necessary.

To modify a field, simple left-click the entry and Visual will highlight the entire text field
to indicate it is selected and allow for editing.

Note: The yellow Active Item panel will not shift to the sub-entries.  

 

Modification of any fields on the Head level proceeds in the same manner as discussed in section Modifying a Schedule Entry.

Modifications to fields on the Luminaire level (i.e., in the yellow Active Item area) are applied to all Heads in the currently selected Luminaire Type.

To collapse (i.e. un-expand or close) a Luminaire Type, left-click the minus-sign
symbol on the left side of the entry.
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7.1.5 Modifying Columns
In the Luminaire Schedule Editor, Columns can be modified to provide configuration specific to user preference and needs.

To change which Columns Visual displays, click the Columns button in the
Toolbar.

 

Clicking the Columns button will pull down the sub-menu that includes the list of
available Columns that can be shown or hidden.

The currently visible Columns are indicated with check marks. The list is ordered
alphabetically in this sub-menu and is independent of how the Columns are displayed
in the Luminaire Schedule. Columns can be moved as discussed below.

Clicking any Column name selects/deselects that column, and changes will be made
immediately in the Schedule Window.

The Reset Columns command returns the columns to the default state shipped with
Visual (shown at right).

Save as Default saves the column configuration as the default that Visual will display
in new Luminaire Schedules in future projects.

The sub-menu will stay visible until the mouse is clicked elsewhere in the Luminaire
Schedule Editor.

 

Columns can be moved by left-click-dragging (left-click and hold, and then drag) the
Column header (name) to the desired position. A red arrow will indicate where the
Column header will be placed when the mouse button is released. In the example at
right, the Label column is being moved to the left of the Symbol column.
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To re-size Columns , place the mouse cursor over the vertical boundary between two
Columns . The cursor will change to a double-arrow. Left-click (and hold) and drag
the mouse to the left or right to the desired width. Note: the Column for which the
width will be changed is to the left of the cursor. Visual will highlight one Column or
the other depending on the specific coordinates of the cursor but that has nothing to do
with the re-sizing process.

 

Changes made to which Columns are displayed and the order they appear in the Luminaire Schedule Editor are independent of those made to the Luminaire Schedule in the Print
Editor.  
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7.1.6 Modifying Rows
In the Luminaire Schedule Editor, Rows can be manipulated in a few ways.

The Rows button in the Toolbar provides quick selection and expansion of Rows.  

Clicking the Rows button will pull down the sub-menu that includes commands to
select/deselect all Rows (for use with other command buttons) as well as
expand/collapse all Rows if the luminaire definitions allow. See Expanding a Schedule
Entry for more information.

The sub-menu will stay visible until the mouse is clicked elsewhere in the Luminaire
Schedule Editor.

 

Rows can also be sorted alphabetically based on the content of the various Label
fields in each Luminaire Type by clicking the Sort button. It is not necessary to
select all of the Rows .

 

The Sort order of Rows will pass through to the Luminaire Schedule in the Print Editor.
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7.1.7 Impor�ng and Expor�ng Schedules
Luminaire Types can be imported and exported singly, in groups, or as complete schedules.  

To export Luminaire Types, select those to be exported from the Schedule
Window. Hold the Ctrl key to select multiple types. Once the desired entries are
selected, click the Export button in the Toolbar.

 

Clicking the Export button will pull down the sub-menu. Click Selected Items and a
standard file dialog will appear. Choose a filename and location; be sure to note where
you have saved the file.

 

If the entire schedule is to be saved, there is no need to select items prior to clicking
the Export button. Simply click the Export button and then click Export All. A
standard file dialog will appear. Choose a filename and location; be sure to note where
you have saved the file. Visual saves exported schedules with a *.VSC extension.

 

The Luminaire Schedule can also be exported as a Comma Separated Value
(*.CSV) file for use with spreadsheet software. If desired, select that format from the
"Save as type:" combo box at the bottom of the file dialog prior to clicking Save.

 

Note: If Luminaire Type fields (Description, Lamp, etc) contain commas, those commas are inherently interpreted as part of the separation construct of the *.CSV file format. Extensive
formatting may be necessary to use the *.CSV file in other software related to this idiosyncrasy.

To import saved Luminaire Types into the current list, click the Import button.
Select the desired *.VSC file using the dialog (only *.VSC files can be imported). Visual
will sort the list by Label as the last step of importing. Note that Visual cannot resolve
duplicate Label names so there may be multiple Luminaire Types with the same
Label after Import.

 

Exported files could be given to other Visual users to maintain continuity in a project or as a "boilerplate". Imported files are appended to previously defined Luminaire Types in the Schedule.
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7.1.8 Selec�ng a Photometric File
Selecting a photometric file is a necessary part of defining a Luminaire Type in the Luminaire Schedule Editor. The Photometric File Dialog is the tool used to select photometric files.
This dialog is similar to dialogs found in other Windows-based applications with the addition of functionality to aid in the selection of the appropriate file based on physical and performance
characteristics.

To define a new Luminaire Type, select New from the toolbar in the
Luminaire Schedule Editor. A file selection dialog customized to
photometric files will appear.

 

Acuity Brands products can be selected from the database included with
Visual. This database is comprised of all publicly available data and is
updated regularly.

 

For non-Acuity Brands products, navigation is done in the lower half of the
directory structure on the left, just as in other Windows-based applications.

 

The left side of the dialog houses a directory structure that is similar to that
used in other Windows-based applications.

 

Left-clicking a "+" will expand the sub-directories. Alternately, the sub-
directory name can be double-clicked to navigate into the structure.

 

Left-clicking a product category name will show images for all products in the
sub-directories.
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Left-clicking a product family directory name in the left pane will display all
available photometric files in the upper portion of the right pane. All files in the
directory are read by Visual and the most common header information is
displayed for each available file.

 

If information is missing from the header of a particular photometric file, the
entry for that file in one or more columns may be blank.

 

The lower portion of the right pane is a preview of the selected file above. An
image (if available) is shown, along with basic header information, a polar
candlepower curve plot, and the Luminaire Classification System BUG plot
related to IESNA publication TM-15.

 

Between the upper and lower right panes, Visual displays helpful links to
additional information. All files will have links to a complete photometric
report, a PDF specification sheet, and the product or family website; all
requiring internet access.

Some files will additionally have links to solid model information. "Model" will
be displayed if the information is available.

 

Visual can search (in the Acuity Brands database only) for files with keywords as defined by the user in the Search box at the top of the dialog. If the name of a product is known but the
location of that product is not, this is a simple way to quickly get to that product.

When selecting outside the Acuity Brands database, the dialog will list any files with an IES, LDT, CIB, TMS, or CB1 extension. Visual can read any photometric file that is formatted in accordance
with the IESNA LM-63, EULUMDAT, or CIBSE-TM14 specifications.
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7.2 Luminaire Editor
The Luminaire Symbol is a graphical model used to communicate the physical properties of the Luminaire and the associated components.

To open the Luminaire Editor, move the mouse pointer over the Symbol field of a
Luminaire Type in the Luminaire Schedule Editor. The Symbol field will
become a button. Left-click on the button to launch the Luminaire Editor.

 

The Luminaire Editor provides flexibility in constructing and modifying a Symbol to
allow for multiple colors and configurations.

The Luminaire Editor contains two tabs, both of which contain a view pane and
multiple panels for parameter definition:

- The Symbol Tab configures what is displayed in the Wireframe Display Mode.

- The Model Tab configures what is displayed when Shaded and Rendered
modes are important and may therefore not be necessary for certain projects or
certain users. See Display Modes for more information.

 

Visual populates the Luminaire Editor with information relevant to the data in the photometric file. A Symbol of appropriate size and shape will be chosen by Visual based on the luminous
dimensions (in feet) recorded in the photometric test. For example, a 2ft x 4ft troffer might be 1.92ft x 3.92ft. Note: Visual cannot account for poor photometric tests that have incorrect
dimensions, incorrect shape indicators, or other issues. See the IESNA publication LM-63 for information about dimensions in *.IES files.

The Symbol chosen is an indicator only. Visual performs calculations based on the luminous dimensions in the files associated with each Luminaire Type.
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7.2.1 Symbol Tab
The Symbol tab configures what is displayed in the Wireframe Display Mode.

The Preview Pane is the main portion of the tab and shows the Symbol in a plan
view.

Angular markers are provided at the edges of the Preview Pane for reference when
specifying angular parameters in the panels. Note: 0 degrees when referencing
luminaires is the Y-Axis due to photometric reporting conventions, unlike the Cartesian
convention where 0 degrees is the X-Axis when drawing objects

 

The multiple panels on the right side of the tab allow for parameter definition and
Symbol manipulation. The panels are discussed in more detail in subsequent
sections of this manual.

 

Changes made to the parameters will modify all heads of a multi-head Symbol
equally. See Multi-head Luminaires for more information.

 

The thumbnail view in the upper left corner of the Preview Pane shows the Symbol
in an isometric view to provide further feedback of the effect of parameter changes.

 

The various components and their use are described in the following topics.
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7.2.1.1 Symbol Tab Graphic Panel
The Graphic panel is part of the Symbol Tab in the Luminaire Editor.

To change the basic Symbol shape, click the Symbol button in the
Graphic panel to open the Symbols dialog.

 

The Symbols dialog contains several common shapes that can be
associated to the Luminaire Type. These are 3-D wireframe
representations that have depth/height.

 

Left-clicking the desired Symbol will close the dialog and place that
information in the Luminaire Editor. Note that all Symbols are shown in
blue in this dialog regardless of the Symbol color chosen in
the Luminaire Editor.

 

To close the Symbol dialog without making a choice, click the red X at the
upper right of the form.

 

Configurations are multiple luminaires that are arranged in commonly
used groups. To create a Configuration, click the Configuration
Select… button to open the flyout dialog. See Multi-head Luminaires for
more information.

 

Size Factor increases the size of the Symbol in the Design
Environment and Print Editor to allow for ease of viewing for large
projects. The default Size Factor of 1 is most common for Interior
designs, whereas a larger Size Factor would be appropriate for Exterior
(site) applications. Note: Visual does not alter calculations based on this
value.

 

The Color button shows the currently assigned color.  Left-clicking the
Color button launches the Color dialog, which can be used to change the
color of the Luminaire Symbol. This does not impact the color of the
Model associated to the Luminaire Type.  See Using the Color Dialog for
more information.
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7.2.1.2 Symbol Tab Components Panel
The Components panel is part of the Symbol Tab in the Luminaire Editor.

The Components panel contains checkboxes that allow the available
Components defined in the Symbol to be chosen such that additional detail or
variation can be shown in the Design Environment and Print Editor. The
Components shown will vary based on the base Symbol chosen. Multiple
Components can be selected by placing a check in the desired box(es)

 

Typical Components are: Optical Arrow, Emergency, and Washer. These three
Components are shown at right for the Circular Symbol as an example.
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7.2.1.3 Symbol Tab Dimensions Panel
The Dimensions panel is part of the Symbol Tab in the Luminaire Editor and allows for the modification of Symbol size.

Visual populates these cells with the luminous dimensions in the photometric file,
which are not always the same as the physical dimensions.  Note: 0 degrees when
referencing luminaires is the Y-Axis due to photometric reporting conventions, unlike
the Cartesian convention where 0 degrees is the X-Axis when drawing objects

 

Length is defined as being along the 0-degree axis of the luminaire. Again, 0 degrees
is at the top of the screen and therefore Length is generally top-bottom on the
screen.

 

Width is defined as being perpendicular to the 0-degree axis of the luminaire in the
most basic case. Width is always initially left-right on the screen.

 

Photometric file data for directional luminaires (e.g. wallwash and/or asymmetric
reflectors) are likely oriented so the "throw" is in the 0-degree direction. Therefore
Width and Length may not be as intuitive as it is in the definition graphics above. In
the example at right the long axis is the Width whereas it might at first seem to be the
Length.

 

When an Orientation angle is applied, the "length axis" rotates with the Symbol. For
example, with the 2x4 Symbol and a 90 degree Orientation, changes to Length
would apply left-right on the screen as seen at right. See Position Panel for more
information on Orientation.

 

The resultant size of the Symbol is for display only; Visual calculates the lighting model based on the dimensions in the related photometric file. The Audit may report issues related to dimensions
if user-specified values are used.
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7.2.1.4 Symbol Tab Posi�on Panel
The Position panel is part of the Symbol Tab in the Luminaire Editor.

Parameters editable in the panel allow for movement of the Symbol with respect to
the insertion point. Common angles are included in the lists accessed by clicking the
arrows to the right of the various fields. Custom values can also be entered with the
keyboard by simply clicking in the text field and typing.

 

Displacement allows the Symbol to be moved in relation to the insertion point
(origin) that is by default the center of the luminous dimensions. The value entered is
applied to the Symbol by shifting it on the 0-degree axis toward the top of the screen
in the Luminaire Editor.

When placed in the Design Environment, the displacement orients in conjunction
with the Symbol orientation.

The most common use for this feature is with wall-mounted luminaires as in the
example at right where a 12in x 6in wallpack is displaced 3in (0.25ft).

 

Orientation rotates the Symbol clockwise about the origin. This value adds
Orientation angle to luminaires when placed in the Design Environment. The
examples at right have an Orientation angle of 90 degrees; the two examples are
with and without a Displacement.

 

Tilt is applied in the Y-Z plane of the luminaire such that the Symbol is tilted
counterclockwise when viewed from the right elevation in the Luminaire Editor as in
the area lighting example at right.

 

Optical Spin rotates the candela distribution clockwise with respect to the
Symbol.  Visual automatically selects the Optical Arrow Component to make this
change clear. See Components Panel for more information.

 

Remember that dimensional information is input in terms of decimal feet or meters.
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7.2.1.5 Symbol Tab Support Panel
In general these fields are used to configure elements of a pole-mounted Luminaire Type used in Exterior lighting models.

The Support panel is uneditable for certain configurations, which don't have
supports, like downlights. Choose an Exterior Configuration to enable use of these
parameters. See Graphic Panel for more information.

 

The origin for the Symbol is the center of the pole.  

For pole-mounted configurations, Visual assumes a Displacement of half the
luminaire Length such that these parameters are related to an origin as in the graphic
at right. These parameters will be scaled by the Size Factor. See Graphic Panel for
more information.

 

The Length of the Support is the distance from the pole to the edge of the Symbol.  

Orientation is the clockwise rotation angle of the Support with respect to the 0-
degree axis that points to the top of the screen. The Orientation of the Symbol (as
indicated in the Position panel) will be automatically changed to rotate the luminaire
when a Support change is made.

 

Support parameters impact calculations in that the luminaire center is moved and rotated according to the user inputs.
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7.2.1.6 Mul�-head Luminaires
Symbols with multiple heads can be manipulated in various ways to better mimic real assemblies.

Symbols with multiple heads can be created using the Configuration section in the
Graphic panel on the Symbol tab.

 

Interior and Exterior groups are provided, but Exterior Configurations can be
used in an Interior calculation.

Note: Exterior Configurations include poles and therefore enable the Support
panel input fields in the Symbol tab. See Support Panel for more information.

 

Left-click the desired configuration and Visual will apply the change to the Symbol in
the Luminaire Editor.

 

The Custom Exterior Configuration will place the indicated number of luminaires
in a polar array around a central pole as in high-mast lighting.

 

It is possible to select a single head of a multi-head Configuration so as to modify
only one head with parameters discussed in this sub-chapter.

To select a head, left-click and left-click again to make a window around the desired
head. The selected head will be highlighted in red. Unlike selecting in the Design
Environment the window does not have a "crossing" variant; it is inclusionary only.

To un-select a selected head, simply select blank space with a window.

 

Changes made to any parameter on the Symbol tab will impact all heads of a multi-head Symbol in an equal fashion. Symbols with multiple heads are not merely a modification of the
Symbol; additional instances of the photometric file are included and positioned to more accurately represent reality.
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Illustra�ve Example 1

To make the Symbol at far-right, start with a Photometric File for an area luminaire,
choose a Twin Exterior Configuration, and then select a single head.  Then
change the Support Orientation to "90" and the resultant Symbol would be
applicable for positioning site lighting on a corner.

Note that the default Length most likely needs to change so the heads don't overlap
as would be the case in reality.

 

 

Illustra�ve Example 2

The Bullhorn Configuration is pre-built for convenience and can be manipulated
as necessary, but illustrating how to construct it will further illustrate how to use some
of the parameters. The goal is to simulate the assembly at right.

This configuration might be used on tennis courts or in situations where a field-
rotatable area lighting is not available.

 

Select a Twin Exterior Configuration.

Select the lower head and set Support Orientation to "90" as we want that support
to point in the 90-degree direction. With the lower head still selected, set the Position
Orientation to 0 to point the head in that direction.

Select the other head and set Support Orientation to 270 and Position
Orientation to 0.

 

Thus far, the luminaires are oriented properly but not positioned properly. Be sure to
left-click in whitespace to de-select luminaires.

Recall that a 0.75ft Support is the default. A bullhorn will in reality have luminaire
spacing of nominally 3ft, so the appropriate Length is 1.5. Both supports are changed
at the same time because no luminaire is selected.

Lastly, the luminaires need to be moved forward  to account for the arm attached to
the housing; in this case, 0.75ft. To do this, add 0.75 to the value in the
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Displacement textbox. Again, both supports are changed at the same time.

 



7.2.2 Model Tab
The Model tab allows for the specification and manipulation of the solid model used in Shaded and Rendered Display Modes.

The Model tab consists of: the Toolbar at the top, the large Model Pane that
displays the Model, and various panels on the right.

 

In the Model Panel, the mouse can be used to manipulate the view of the Model
just as the view would be changed in the Design Environment.

 

3-D Orbit the view by left-click-drag.

Pan the view by right-click-drag.

Zoom by rolling the mouse wheel.

 

For information on creating solid models, see Luminaire Models  
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7.2.2.1 Model Tab Toolbar
The Toolbar includes several buttons to manipulate the Model in the event that positional issues arise and editing the base Model file is not possible or practical.

Delete removes all associated solid model information.  

Move shifts the Model to correct alignment issues that may arise.

Dimensions are in feet. "X" refers to the normal Cartesian X-axis; i.e. to the right on the
screen. "Y" refers to "up" on the screen. "Z" refers to in and out of the screen.  All of
these are with respect to a plan view of the Symbol as it appears in the Luminaire
Schedule.

Moving the Model is an advanced feature and should be done carefully.

 

Rotate changes the plan view orientation of the Model with respect to the Symbol.
Rotation occurs counterclockwise when the Model is viewed in plan view as it
appears in the Luminaire Schedule.

Rotating the Model is an advanced feature and should be done carefully.

 

Zoom All changes the view to include the entire Model.  

The Undo function in Visual will not impact changes made in the Model tab. To reset the model, the file must be re-selected or a new choice must be made from the database.
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7.2.2.2 Model Tab Parameter Panels
The parameters of the solid model can be modified to fit the product specifically chosen to yield the most accurate Shaded or Rendered view possible.

The Graphic panel contains the Model Select… button that allows a DWG format
model file to be chosen. Clicking the button will open a file dialog to allow for selection.
Only DWG format files may be imported and specific information is necessary in the
file.

 

The Components panel lists the available components in the Model file. The color of
each Component can be changed by clicking the colored box next to the name.

Some files may contain multiple product options such that certain Components
would need to be unselected to make the Model coordinate with the options desired.

For example, in the model file at right, multiple arms are available (4", 9", and 12") so
the arms not used should be unchecked by left-clicking those associated boxes.

 

The Dimensions panel allows the Model to be scaled by a linear factor in each of
the Cartesian axes with Length, Width, and Height the same as in the Symbol
Tab; see Dimensions Panel for more information.

Changes are applied to all Components; i.e. flanges and arms will be stretched as
well, which may not yield a desirable result in certain cases.

The value entered is the new dimension in feet not a scaling factor.

 

It will likely be necessary to consult specification sheets to determine which Components can be validly combined. Specification sheets can be viewed on the manufacturer's website or in the
Visual program if it is an Acuity Brands product. See Selecting a Photometric File for more information.
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7.3 Luminaire Templates
Luminaire Templates are assigned in the Luminaire Schedule; see Luminaire Schedule for more information.

A Template is one or more iso-illuminance lines (contours) attached to the Symbol.
and is generally used in exterior projects related to roadway, site, and area lighting.

Because illuminance generally increases closer to a luminaire, all points inside an
iso-illuminance line will have illuminance greater than or equal to the iso-illuminance
line value.

Luminaire Templates allow for quick design to meet common site lighting criteria in
parking lots where a minimum illuminance needs to be met.

Alternately, Templates show the general shape of the effect of the luminaire candela
distribution and are useful for design even when they are not specifically used to meet
design criteria.

 

Since illuminance is additive, and the illuminance inside a contour is greater than the
iso-illuminance line value, appropriate values can be assigned related to design
criteria, and Templates can be overlapped to design to meet minimum illuminance
criteria quickly. This method says nothing about uniformity criteria, so in most cases a
point-by-point analysis is still necessary.

In the example at right, Template iso-illuminance lines of 0.5fc are overlapped to
ensure that a 1.0fc minimum is maintained along a curb line in part of a parking lot.

 

To apply Templates to one or more Luminaire Types, select the desired
Luminaire Types and click the Template button in the Luminaire Editor
Toolbar. Remember that multiple Luminaire Types can be selected by holding the
Ctrl key while left-clicking entries.

 

Clicking the Template button initiates the Template Editor. This editor allows for the
assignment of values and colors for up to eight iso-illuminance lines per Template.

To assign an iso-illuminance line to the Template, left-click the check box next to an
entry. Inactive entries are gray in color and are uneditable.

To edit the value of an iso-illuminance line, modify the value in the text box.

To change the color of the iso-illuminance line, click the Color button. Clicking the
Color button initiates the Color Dialog.  See Using the Color Dialog for more
information.

The entry order of values has no impact on any aspect of how Templates are
displayed.
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Selecting the "Apply to All" checkbox will associate the chosen values and colors to
Templates for all Luminaire Types in the Luminaire Schedule regardless of
what is in the Active Item selection set.

 

Template Color can be connected to the Symbol Color in the Settings Dialog.
When this option has been selected, Visual provides notification in the Template
Editor and Color selections are overridden by the Settings Dialog choice(s). See
Luminaires Settings for more information.

 

Luminaire Types with assigned Templates are indicated at the far left of each
entry. The symbol indicates that a Template is assigned not the shape or any other
property of the Template.

To view the assigned parameters of a Template, select the Luminaire Type and
left-click the Template Button in the Luminaire Editor Toolbar.

 

Global display of Templates is controlled with the Templates button on the
Luminaire tab of the Ribbonbar. The yellow highlight indicates display of templates
is turned on.

 

Different Template lines can be assigned to different Luminaire Types by repeating the process described above for each set of desired Template configurations and/or values. Note that
Template iso-illuminance lines become part of the Symbol and can then be left-clicked when selecting a luminaire in commands.
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7.4 Placing and Orien�ng Luminaires
Visual includes many ways to place and modify Luminaires.

The Luminaire tab of the Ribbonbar contains placement and modification and
display commands.

 

The Home tab of the Ribbonbar also contains the most commonly used
commands.

 

Luminaires are copied, moved, and arrayed like any other objects.

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


7.4.1 Place Luminaires
Place is the most common method of inserting Luminaires into the Design Environment.

The Place command can be found on the Luminaire tab and the Home tab
of the Ribbonbar.

 

The Home tab button is dual function; the upper portion executes the
command, the lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button
portion will change to execute that command with the next press and the
graphic is changed accordingly. Selecting one of the other commands from the
drop-down menu will revert the button to that mode.

 

To insert a luminaire, one must first be defined in the Luminaire Schedule.
See The Luminaire Schedule Editor for more information.

 

To Place a luminaire, select a Luminaire Type from the graphical list. Select
the coordinates desired with the mouse, keyboard entry or Object Snap.

After a luminaire is inserted with Place, Visual continues the command to allow
for multiple insertions. To end the command, right-click or press Enter.

 

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_7_Luminaire/Luminaire_Schedule/7.1_Luminaire_Schedule.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


By clicking the Luminaire Type List during command execution, all defined
Luminaire Types are shown and a selection can be made.

Symbol, Type, and Catalog Number are shown to identify types in complex
projects.

Preceding the Catalog Number is a number in square brackets representing
the number of that Luminaire Type currently inserted in the Design
Environment.

 

Mounting Height is the distance from the Active Plane that the luminaire
will be inserted. Mounting Height is always applied in the z-direction.
Changes to the Active Plane orientation (i.e. moving to the X-Z or Y-Z planes)
will still result in the Mounting Height  being applied in the Z-direction.

 

Orientation is the rotation angle applied in the horizontal plane. This angle is in
reference to the 0° axis of the Luminaire Symbol defined in the Luminaire
Editor. Angles are applied in a clockwise fashion and the impact can be
immediately seen prior to placement as shown at right.

 

Tilt is the rotation angle applied in the vertical plane. Unlike Orientation, Tilt
angle is applied in place of the angle used to define the  Luminaire Symbol in
the Luminaire Editor. Angles are applied in a counterclockwise fashion when
viewed from the East Elevation, with 0° being straight down; thus a positive
tilt angle rotates the luminaire up.

 

See Luminaire Display Options for further explanation of augmentation to Luminaires to aid in design.
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7.4.2 Place and Orient Luminaires
Place and Orient is one of the most common methods for inserting Luminaires into the Design Environment. This command allows for placement and graphical manipulation of the
Orientation parameter for each placement instance.

The Place and Orient command can be found on the Luminaire tab and the
Home tab of the Ribbonbar.

 

The Home tab button is dual function; the upper portion executes the
command, the lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button
portion will change to execute that command with the next press and the
graphic is changed accordingly. Selecting one of the other commands from the
drop-down menu will revert the button to that mode.

 

To insert a Luminaire, one must first be defined in the Luminaire Schedule.
See Luminaire Schedule for more information.

 

To Place and Orient a Luminaire, select a Luminaire from the Luminaire
Type List then select the coordinates desired for the location of the
Luminaire with the mouse, keyboard entry or Object Snap. Secondly,
specify the Orientation with the mouse, keyboard, or Object Snap. Visual
displays the angular change as the mouse is moved to illustrate the end result.

After a Luminaire is inserted with Place and Orient, Visual continues the
command to allow for multiple insertions. To end the command, right-click or
press Enter.
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By clicking the Luminaire Type List during command execution, all defined
Luminaire Types are shown and a selection can be made.

Symbol, Type, and Catalog Number are shown to identify types in complex
projects.

Preceding the Catalog Number is a number in square brackets representing
the number of that Luminaire Type currently inserted in the Design
Environment.

 

Mounting Height is the distance from the Active Plane that the Luminaire
will be inserted. Mounting Height is always applied in the z-direction.
Changes to the Active Plane orientation (i.e. moving to the X-Z or Y-Z planes)
will still result in the Mounting Height  being applied in the Z-direction.

 

Orientation is solely specified by user input at the Command Line in this
command. The Orientation parameter text box is accordingly inactive.

 

Tilt is the rotation angle applied in the vertical plane. Unlike Orientation, Tilt
angle is applied in place of the angle used to define the  Luminaire Symbol in
the Luminaire Editor. Angles are applied in a counterclockwise fashion when
viewed from the East Elevation, with 0° being straight down; thus a positive
tilt angle rotates the luminaire up as would be expected.

 

This command is useful with odd-angled alignments necessary in site lighting,
as shown at right where the angle is specified by using Object Snap to align
to the parking lot line.

 

See Luminaire Display Options for further explanation of augmentation to Luminaires to aid in design.
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7.4.3 Place and Aim Luminaires
Place and Aim allows Luminaires to be graphically aimed in the direction of a chosen coordinate. This command allows for placement and graphical manipulation of the Orientation and Tilt
parameters for each placement instance. This method is useful for floodlighting, track lighting, sports lighting, and landscape lighting.

The Place and Aim command can be found on the Luminaire tab and the
Home tab of the Ribbonbar.

 

The Home tab button is dual function; the upper portion executes the
command, the lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button
portion will change to execute that command with the next press and the
graphic is changed accordingly. Selecting one of the other commands from the
drop-down menu will revert the button to that mode.

 

To insert a Luminaire, one must first be defined in the Luminaire Schedule.
See The Luminaire Schedule Editor for more information.

 

 

To Place and Aim a Luminaire, select a Luminaire Type from the
graphical list. Select the coordinates desired for the Luminaire location with
the mouse, keyboard entry or Object Snap. Visual then provides instant
feedback by placing the aim point at the mouse crosshairs and shows the
resultant Aiming Line and Luminaire orientation as the mouse is moved.
Specify the aiming point with the mouse, keyboard, or Object Snap.

After a Luminaire is inserted with Place and Aim, Visual continues the
command to allow for multiple insertions. To end the command, right-click or
press Enter.
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By clicking the Luminaire Type List during command execution, all defined
Luminaire Types are shown and a selection can be made.

Symbol, Type, and Catalog Number are shown to identify types in complex
projects.

Preceding the Catalog Number is a number in square brackets representing
the number of that Luminaire Type currently inserted in the Design
Environment.

 

Mounting Height is the distance from the Active Plane that the Luminaire
will be inserted. Mounting Height is always applied in the z-direction.
Changes to the Active Plane orientation (i.e. moving to the X-Z or Y-Z planes)
will still result in the Mounting Height  being applied in the Z-direction.

 

Orientation and Tilt are solely specified by user input at the Command Line
in this command, most often with the mouse. The Orientation and Tilt
parameter text boxes are accordingly inactive.

 

Aim to Surface (found on the Luminaire tab) is applicable to the Place and
Aim command.  Because in many floodlighting applications it is necessary to
have the Luminaire aimed onto a specific surface, Visual can determine when
the mouse is placed "over" a Solid Object and the Active Plane can be
automatically and temporarily changed to the plane of that Solid Object such
that when the mouse is clicked the aiming point is placed in the plane of that
Solid Object.

 

See Luminaire Display Options for further explanation of augmentation to Luminaires to aid in design.
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7.4.4 Reaiming Luminaires
Once inserted into the Design Environment, Luminaires can be Reaimed if necessary.

The Reaim command can be found on the Luminaire tab and the Home tab
of the Ribbonbar.

 

The Home tab button is dual function; the upper portion executes the command,
the lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button portion
will change to execute that command with the next press and the graphic is
changed accordingly. Selecting one of the other commands from the drop-down
menu will revert the button to that mode.

 

To Reaim a Luminaire, left-click the luminaire Symbol or the Aiming Line (if
displayed). Visual will highlight the selected luminaire. Specify the new aiming
point with the mouse, keyboard, or Object Snap.

While in the command, Visual displays the previous Aiming Line, the new
Aiming Line attached to the mouse crosshairs, and the resultant Symbol
alignment as the mouse is moved.

 

Aim to Surface (found on the Luminaire tab) is applicable to the Reaim
command just as it would be to the initial Place and Aim command. Visual can
determine when the mouse is placed "over" a Solid Object and the Active
Plane can be automatically and temporarily changed to the plane of that Solid
Object such that when the mouse is clicked the aiming point is placed in the
plane of that Solid Object.

 

See Luminaire Properties for information about displaying aiming lines.
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Luminaire Display Op�ons
After Luminaires have been placed in the Design Environment, there are  ways to augment the display to aid in design.

Luminaire display options are found on the Luminaire tab of
the Ribbonbar.

 

Luminaire Labels can be shown with the Luminaire Type or
the Luminaire Type and Number.

When the Display is set to Luminaire Type and Number,
Visual activates the following additional options:

Sequence tells Visual how to handle numbering across
Luminaire Types. Sequential will number Luminaires
regardless of Luminaire Type. Non-Sequential will re-start
numbering for each Luminaire Type.

Reset Luminaire Numbers. controls the numbering used
with the Sequence options. Sort By Creation Order tells
Visual to number Luminaires based on the order they are
placed (created) in the Design Environment regardless of
where they are placed. Sort By Location Order tells Visual to
use the internal algorithm for sorting based on the relative
position in the Cartesian X-Y plane.

 

The Templates button turns on or off the global display of
iso-illuminance templates for Luminaire Types where
Templates have been defined in the Luminaire Schedule.
See Luminaire Templates for information on defining
Templates.
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The Photometric Web button turns on or off the display of the
Photometric Web for the luminaire currently being placed. It
does not impact already placed Luminaires; see Luminaire
Properties for information on controlling display of placed
Luminaires.

The Photometric Web illustrates the shape of the candela
distribution and provides visual feedback as to proper alignment.
Note that the magnitude is scaled to  allow for all sizes to be
visible. For example, a 32W CFL downlight will have the same
magnitude as a 4-lamp troffer or a 1000W metal halide floodlight
even though actual candlepower could be 10,000X different.

 

Analogous to the Photometric Web button when inserting
Luminaires, the Distribution button found on the Luminaire
tab of the Ribbonbar initiates a drop-down menu that allows the
user to turn on or off Photometric Webs in the Design
Environment for all Luminaires.

 

The Luminous Volume button directs Visual to display the
luminous dimensions graphically (as seen in the wireframe view
at middle-right) for each placed Luminaire in the Design
Environment in conjunction with the Symbol as defined in the
Luminaire Schedule.

Design Audit will automatically turn on this feature when an
interference is found. At right, the wall sconce Symbol is
aligned properly but the alignment of the Symbol and the
Photometric File is incorrect, yielding half of the luminous area
inside a wall as can be seen in plan view.
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Chapter 8 - Calcula�ons and Results

Visual's primary function is to calculate illuminance levels at distinct locations in the
lighting model for the purpose of lighting system performance verification.  This
chapter provides a brief overview of the calculations and the techniques for interpreting
the results.

 

Basic knowledge of lighting equipment and metrics is necessary prior to using Visual to be able to understand the ramifications of choices made in the program and the resultant numbers. Most
local sections of the Illuminating Engineering Society provide Fundamentals of Lighting  classes to suit this purpose.

An advanced discussion of the Visual Calculation Engine is provided in the Appendices of this manual.
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8.1 Calcula�on Zones
Calculation Zones are an integral part of any lighting model. Statistical information related to Calculation Zones is displayed in the Sidebar. See Statistics and The Sidebar for more
information.

Calculation Zones can be lighting-based (Illuminance,
Luminance, etc) or power-based (Lighting Power Density). By
default, Visual shows Lighting Calculation Zones in dark red and
Lighting Power Density Zones are shown with a olive border and
are furthermore shaded.

 

Lighting Calculation Zones can be defined by rectangular areas,
areas bounded by a polygon, or can be locations along a linear path.
Calculation Zones can also be placed directly on surfaces (Solid
Objects).

The boundary of the Calculation Zone is indicated by a dashed line
and points indicated by crosses are placed in an array defined by the
user.

Visual assumes the light meter orientation to be perpendicular to the
defining (bounding) plane. This can be modified at creation or by editing
Properties after creation.

 

Lighting Calculation Zones can be modified to remove points that
are unwanted using the Masking commands. Points can be Masked
with rectangles, polygons, by surface, or individually.

Mask boundaries are shown with a dashed purple line.

The display of the Mask boundary can be turned on or off in the
Settings dialog.
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Statistical Zones can be created to report information about part of a
Lighting Calculation Zone. Statistical Zones are displayed in the
Statistics tab of the Sidebar separately from their parent zone.

Statistical Zones can be created with rectangles, polygons, or by
selecting surfaces. Statistical Zones can be grouped in the Sidebar
for an additional level of reporting and analysis.

Statistical Zone boundaries are shown with a dashed dark green line.
Notice how the internal points are omitted by astute boundary selection.
Calculation points included in the Statistical Zone have a different
symbol.

For example, only the paved area could be shown for a parking lot.
Points in the Statistical Zone are indicated with a green asterisk
symbol by default.

 

Lighting Power Density (LPD) Zones can be defined by
rectangular areas, areas bounded by a polygon. They have associated
luminaires specifically applied to the calculation. LPD Zones can also
be placed directly on surfaces (Solid Objects).

 

When changes have been made to the lighting model that require a re-
calculation, Visual will indicate that Calculation Zone values may no
longer be valid by bracketing point values.

 

The following section describes the process of entering Calculation Zones along with the information required to produce appropriate results.
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8.1.1 Rectangular and Polygonal Calcula�on Zones
Calculation Zones may exist along a linear path or within planar regions bounded by a rectangle or polygon.

The buttons for the various types of Calculation Zones can be found in the
Calculations panel on the Home tab or the Calculation Zone panel on the
Calculations tab of the Ribbonbar.

 

The Home tab buttons are dual function; the upper portion executes the command,
the lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button portion will
change to execute that command with the next press and the graphic is changed
accordingly. Selecting one of the other commands from the drop-down menu will
revert the button to that mode.

 

Rectangular and Polygonal Calculation Zones share a similar interface in the
Properties tab of the Ribbonbar that is shown upon command execution.

See Calculation Zone Parameters for information on specific parameters.
 

Note that the basic process of creating Calculation Zones is identical to that of creating Background or Solid Rectangles and Polygons except that additional information must be
entered on the Properties tab to space and format the points.

To construct a Rectangle Calculation Zone, specify the coordinates of the first
vertex using the mouse, keyboard, or Object Snap. In the command, moving the
mouse causes Visual to draw the implied Rectangle showing what will be created
when the command is completed. To end the command, right-click the mouse or
press Enter. Various parameters can be specified in the Properties tab as
discussed below.

 

To construct a Polygon Calculation Zone, specify the coordinates of the vertices
using the mouse, keyboard, or Object Snap. In the command, moving the mouse
causes Visual to draw two types of implied lines: the small-dash line connects the
first vertex and the last vertex specified and the large-dash line connects the cursor
to the last vertex specified. To end the command, right-click the mouse or press
Enter. Various parameters can be specified in the Properties tab as discussed
below.
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When changes have been made to the lighting model that require a re-calculation,
Visual will indicate that Calculation Zone values may no longer be valid by
bracketing point values.

 

In all cases, the default point normal (virtual light meter) orientation is Directional (Perpendicular) that corresponds to a direction perpendicular to the plane of the Calculation Zone bounding
rectangle, polygon, or line. Several other options can be chosen to change how Visual orients the virtual light meter. See Calculation Types for other meter orientation options.

Statistical information related to Calculation Zones is displayed in the Sidebar. See Statistics and The Sidebar for more information.
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8.1.2 Placing Calcula�on Zones on Exis�ng Solid Objects
The lighting levels on surfaces are frequently of interest because the illumination of a surface is often the primary objective (wall-washing, facade lighting, etc.) of a project and a lighting model.

The buttons for the various types of Calculation Zones can be found in the
Calculations panel on the Home tab or the Calculation Zone panel on the
Calculations tab of the Ribbonbar.

 

The Home tab buttons are dual function; the upper portion executes the command,
the lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button portion will
change to execute that command with the next press and the graphic is changed
accordingly. Selecting one of the other commands from the drop-down menu will
revert the button to that mode.

 

Surface Calculation Zones have the identical interface in the Properties tab of
the Ribbonbar that is found when placing Rectangle and Polygon Calculation
Zones.

See Calculation Zone Parameters for information on specific parameters.

 

To place a Calculation Zone on a Surface, select the desired Surface to use as
the basis by left-clicking, specify parameters as necessary in the Properties tab,
and press Enter or right-click to end the command. The selection of a Surface
provides the bounding polygonal (or rectangular) shape just as if that shape had
been provided while executing the commands as described in Rectangular and
Polygonal Calculation Zones.

Note that the Height is applied from the Surface itself not the Cartesian coordinate
system.

 

The normal of the Calculation Zone (and therefore the virtual light meter) will be
pointed to the interior when placed on Room Surfaces and pointed to the exterior
when placed on Structure Surfaces.

For the same reasons, Calculation Zones placed on Room Surfaces will be
offset to the interior of the Room. Calculation Zones placed on Structure
Surfaces will be offset to the exterior of the Structure. This of course assumes a
non-zero Height is specified.
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The default point normal (virtual light meter) orientation is Directional (Perpendicular) that corresponds to a direction perpendicular to the plane of the Calculation Zone bounding rectangle,
polygon, or line. Several other options can be chosen to change how Visual orients the virtual light meter. See Calculation Types for other meter orientation options.

Statistical information related to Calculation Zones is displayed in the Sidebar. See Statistics and The Sidebar for more information.
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8.1.3 Line Calcula�on Zones
A Calculation Zone based on a linear path can be placed in a similar fashion to other Calculation Zones. This is most commonly used for the analysis of spill light and light trespass.

The button for the Line Calculation Zone command can be found in the
Calculations panel on the Home tab or the Calculation Zone panel on the
Calculations tab of the Ribbonbar.

 

Accessing the Line command from the Home tab requires the use of the dual-
function button; the upper portion executes the command, the lower portion initiates a
drop-down menu.

On first use, the button will show the default Rectangular mode. To select the Line
option for the button, click the lower portion with the arrow, select Line from the
drop-down menu, and the command will be initiated. The button will remain in Line
mode until another choice is made from the drop-down menu.

 

Line Calculation Zones share a similar interface in the Properties tab to
Rectangle and Polygon Calculation Zones of the Ribbonbar that is shown
upon command execution. Note that the field name changes to Point Spacing and
thus Column Spacing is not applicable and inactive.

See Calculation Zone Parameters for information on specific parameters.

 

Note that the basic process of entering Calculation Zones is identical to that of entering Background or Solid Rectangles and Polygons except that additional information must be
entered on the Properties tab to space and format the points.

To construct a Line Calculation Zone, specify the coordinates of the first vertex
using the mouse, keyboard, or Object Snap. Specify additional vertices as
necessary. Right-click the mouse or press Enter to end the command. Various
parameters can be specified in the Properties tab as discussed below.

Calculation Zone points are spaced starting at the first coordinate entered and the
user-specified spacing is continued around corners. At right, a spacing of 2 units is
applied to a triangular path. Note how the calculation points turn the corner at point 3.
The gray lines are for illustration and are not drawn normally.

 

The default point normal (virtual light meter) orientation is Directional (Perpendicular) that corresponds to a direction perpendicular to the plane of the Calculation Zone bounding rectangle,
polygon, or line. Several other options can be chosen to change how Visual orients the virtual light meter. See Calculation Types for other meter orientation options.

Statistical information related to Calculation Zones is displayed in the Sidebar. See Statistics and The Sidebar for more information.
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8.1.4 Calcula�on Zone Parameters
All Calculation Zone types share the same parameters to control position, spacing, and format of calculation points.

Calculation Zones are often placed at some level above grade (workplane height).
While this can certainly be accomplished by choosing the correct coordinates when
entering the Calculation Zone parameters, the Height field provides an alternative
method. When a Height value is entered, the points in a Calculation Zone will be
displaced perpendicularly from the working plane (plane of the crosshairs) in the
direction nearest the point of view. For horizontal Calculation Zones this will typically
be in the direction of the positive Z-axis as would be commonly desired.

 

Rectangular and Polygonal Calculation Zones result in an array of points and
thus, spacing values must be entered for each dimension of the array. In the case of a
Line, calculation points are spaced with the specified increment along the path of the
Line.

 

Color can be selected from the Properties tab in the Ribbonbar that will
automatically be shown. This selection modifies the points and the associated
numerical text. See Using the Color Dialog for information on selecting Color.

 

The Point Style for a Calculation Zone can be chosen at creation. Clicking the
button initiates the drop-down graphical menu that illustrates the available Point
Styles at right.

 

Precision specifies how many decimal places should be shown for the Calculation
Zone. Clicking the button initiates the drop-down menu to allow for the selection of 0 to
3 digits. It is not possible to display more than 3 digits because it is beyond the
accuracy of photometric testing in most cases.
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The Offset Points checkbox tells Visual to either center the grid of calculation points
(checked) or to start spacing in the lower left corner (the corner with the smallest x, y,
and/or z coordinates if creation occurs outside the x-y plane), which is likely to leave
space between the last points and the edges of the boundary.

 

In this section, reference is made to parameter specification on the Properties tab of the Ribbonbar while one of the Calculation Zone commands is being executed. See Calculation Zone
Properties for more information on modification of parameters after creation.
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8.1.5 Calcula�on Types
All Calculation Zone types share the same options to control virtual light meter ("meter") orientation. Each of the options found in the Properties tab when creating a Calculation Zone
provides descriptive text as a reminder of the meter orientation.

The default for all Calculation Zone types is Directional (Perpendicular). This
option positions the meter perpendicular to the plane that defines the Calculation
Zone. This is the most common use be it for horizontal or vertical surfaces.

 

The Directional (User-Defined) option allows the point normals to be oriented
uniformly in any specified direction. This is commonly used for calculating vertical
illuminance in a horizontal grid. When this option is chosen, the Command Line will
prompt for the base and destination points of a vector to establish the direction of the
point normals. The exact location of the chosen base and head of the vector is
immaterial as they only serve to describe a direction vector. For example, (0,0,0) as
the base point and (1,0,1) as the destination produces a 45° tilt of the meter in the X-Z
plane. The base and destination points may be entered with the mouse or keyboard.

 

For Directional Calculation Zones, Visual draws a unit vector showing the
orientation of the meter. Because Calculation Zones are often large, it may be
necessary to Zoom to see the vector. The tail of the vector lies in the plane defining
the Calculation Zone, while the head points in the direction the meter faces. This
normal vector will not be shown for other Calculation Zone types.

 

The Max Spill option calculates the maximum possible illuminance value from all the
luminaires in the model regardless of orientation. This option is typically applied when
light trespass is of concern and the "worst case" values on adjacent property are
desired. The Max Spill option requires no point normal specification.

 

The TV option establishes point values based on a single viewing position for sporting
events and other applications where special lighting consideration must be given to the
operation of television cameras. Each calculation point normal in the Calculation
Zone is oriented toward the single camera location. When the TV option is selected,
the Command Line will prompt for the coordinates of the TV camera and a line is
drawn from the center of the zone to the camera for reference.

Moving the Calculation Zone does not move the camera location.

 

Spherical orientation of the meter can be assigned for use with UVGI calculations.
See UVGI Calculations for more information.
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Meter Tilt and Orientation as well as TV camera location can be modified after creation by editing Calculation Zone Properties.
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8.2 Power Zones
Power Zones are used to analyze and illustrate performance of lighting systems related to lighting power density (LPD). LPD quantifies the amount of power required to provide lighting to a
space. LPD is often limited by building codes and is an integral part of sustainability programs such as LEED.

The buttons for the various types of Calculation Zones can be found in the
Calculations panel on the Home tab or the Power Density panel on the
Calculations tab of the Ribbonbar.

 

The Home tab buttons are dual function; the upper portion executes the command,
the lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button portion will
change to execute that command with the next press and the graphic is changed
accordingly. Selecting one of the other commands from the drop-down menu will revert
the button to that mode.

 

Rectangular and Polygonal Power Zones share a similar interface in the
Properties tab of the Ribbonbar that is shown upon command execution.

Name allows Power Zones to be individually identified for later use and presentation
clarity.

Color can be selected to modify the highlight given to the zone in the Design
Environment. See Using the Color Dialog for information on selecting Color.

Precision specifies how many decimal places should be shown for the Calculation
Zone. Clicking the button initiates the drop-down menu to allow for the selection of 0 to
3 digits.

 

To create a Rectangular Power Zone, select the two necessary corners that define
the rectangle with the mouse, keyboard entry, or Object Snap. Right-click the mouse
or press Enter to advance the command to the next step. Select the luminaires to be
associated to the Power Zone, see Selecting Objects. Right-click the mouse or
press Enter to end the command.

 

To create a Rectangular Power Zone, select the vertices necessary to define the
polygon with the mouse, keyboard entry, or Object Snap. Right-click the mouse or
press Enter to advance the command to the next step. Select the luminaires to be
associated to the Power Zone. Right-click the mouse or press Enter to end the
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command.

While drawing the bounding polygon, moving the mouse causes Visual to draw two
types of implied lines: the small-dash line connects the first vertex and the last vertex
specified and the large-dash line connects the cursor to the last vertex specified.

Creating a Power Zone based on a Surface is perhaps the most useful of the
options available since the Solid Objects defining the physical space are likely to
overlay the boundary related to LPD. To create a Power Zone based on a Surface,
select the Surface. Right-click the mouse or press Enter to advance the command to
the next step. Select the desired luminaires to be associated to the Power Zone.
Right-click the mouse or press Enter to end the command.

 

To Update a Power Zone, select the desired Power Zone, right-click the mouse to
advance the command, and then add or remove luminaires as necessary. See
Selecting Objects for information on adding and removing objects from the selection
set.

 

Lighting power density is calculated in terms of Watts per unit area; W/ft² or W/m²
depending on system settings. See Settings Luminaires for information on changing
the units used in Visual.

Calculations are based on the values in the Luminaire Schedule. Values input to the
Luminaire Schedule should be ballast Watts based on the most common usage of
LPD. The value imported to the Luminaire Schedule from the IES file may be the
value measured during testing, lamp Watts, or ballast Watts. Care should be taken to
include the correct value based on published manufacturer data for the specific lamp
and ballast components used.

 

Statistical information related to Calculation Zones is displayed in the Sidebar. See Statistics and The Sidebar for more information.
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8.3.1 Masking Calcula�on Zones
Certain scenarios require the removal of calculation points from perimeter and internal sections of Calculation Zones. In Visual, the removal of calculation points is called Masking.

The buttons for the various types of Masking can be found in the Calculations
panel on the Home tab or the Masking panel on the Calculations tab of the
Ribbonbar.

 

The Home tab button is dual function; the upper portion executes the command, the
lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button portion will
change to execute that command with the next press and the graphic is changed
accordingly. Selecting one of the other commands from the drop-down menu will revert
the button to that mode.

 

To Mask a Rectangular or Polygonal area, select the Calculation Zone to be
Masked by clicking a point, the boundary, or in Transparent Display Mode,
anywhere inside the boundary. Then select coordinates to include the points to be
Masked, and right-click or press Enter to end the command.

At right, a Polygonal mask is applied to the corner of a parking lot. Note that the
masking boundary does not always need to be artfully or carefully applied, it simply
needs to encompass the points to be removed.

 

To Mask calculation points based on a surface, select the Calculation Zone to be
Masked by clicking a point, the boundary, or in Transparent Display Mode,
anywhere inside the boundary. The select the Solid Object to be used as the basis
for the Masking, and right-click or press Enter to end the command.

At right, an apartment building (included to block light) is used to remove points in a
site lighting project.

 

To Mask individual points, left-click the point(s) to be removed. Visual instantly
removes the point, and allows for removal of additional points. Right-click the mouse
or press Enter to end the command. Note that Visual will update Statistics after
ending the command.

In the example at right,  a calculation point is inside a column and should be removed.
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Visual can be set to show the boundaries of masked areas. See Calculation Zone
Properties for more information. Note that this border is a bit thicker than that of
Calculation Zones themselves.

At right, the boundary from the Polygonal masking example above is shown with a
dashed purple border.

 

See Unmasking Calculation Zones for information on how to remove Masking.   

Remember that Masking calculation points should be done to produce the most accurate model. Removing points should only be done if those points are not truly valid.

file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_4_New_Features/Properties/4.4.3_Calculation_Zone_Properties.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_8_Calculation/Masking/8.3.2_Unmasking_Calculation_Zones.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


8.3.2 Unmasking Calcula�on Zones
It may be necessary to remove a Mask applied to a Calculation Zone.

To remove a Mask, the Settings must be set to show the Mask Zone Outline. See
Calculation Zones Settings.

 

With the Mask Zone Outline visible, use the Erase command to remove the dashed
outline as shown at right. The calculation points will be restored.

 

Calculation Zones masked with the Mask Point method, don't have Mask Zone
Outlines to erase. It is necessary to draw a new Mask Zone that includes the points
to be unmasked. The location of points can usually be assumed from adjacent points.

This process effectively says "Put the points back no matter how they were removed."
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8.4 Sta�s�cal Zones
The Statistics tab of the Sidebar provides feedback related to created Calculation Zones, Power Zones, and Combined Zones.

Statistics are shown by default in the Statistics tab of the Sidebar. If closed, the
Statistics tab can be shown by clicking Statistics in the Windows menu on the
Ribbonbar.

 

The Statistics that will be displayed in the Statistics panel for each Calculation
Zone can be modified in the Settings Dialog. The defaults are shown at right.

 

To expand or collapse the Statistics for each Calculation Zone, double-click on the
bold title of the Calculation Zone in the Statistics panel.

 

See Statistics for more information about the tab, use of the tab, and modification of items in the tab.
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8.4.1 Crea�ng a Sta�s�cal Zone
It is often useful to view statistics that are compiled from only a portion of a Calculation Zone. In Visual, this is called a Statistical Zone.

The Statistical Zone button can be found on the Calculations tab and the Home
tab of the Ribbonbar.

 

The Statistical Zone button is dual function; the upper portion executes the
command, the lower portion initiates a drop-down menu.

Once a selection has been made other than the default, the upper button portion will
change to execute that command with the next press and the graphic is changed
accordingly. Selecting one of the other commands from the drop-down menu will revert
the button to that mode.

 

To create a Statistical Zone, select a Calculation Zone, then draw a rectangle,
polygon, or select a surface (depending on the method chosen) where points should
be included in the Statistical Zone. As it is being drawn, the polygon or rectangle is
shown in green.

Clicking the second point of the rectangle or right-clicking the mouse in polygon mode
ends the command and applies the choices made in the Properties tab.

After creation, the boundary is shown with a green dashed line. Display of the
boundary is controlled in Calculation Zones Settings.

 

In the command , the Properties tab allows for naming, and control of the symbols
used for the Statistical Zone much like that during creation of the base Calculation
Zone.
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The statistics for the zone are displayed alphabetically in the Statistics tab.

The Name, Color, Decimal precision, and Point Style of the zone can be edited
as necessary by left-clicking the zone name. The lower panel will be populated with
zone parameters. See Calculation Zone Parameters for a description of parameters
and modification.

Note that Statistical Zones have a slightly different symbol in the Sidebar.

 

Statistical Zones can be Erased, and more importantly they can be Stretched to then change which points are included in the zone.
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8.4.2 Combining Zones
It can be useful to view statistics that are compiled as a combination of two or more Power Zones or Calculation Zones.

When designing lighting for a building, it is useful to report Lighting Power Density
for each space type, as well as for the entire building; allowing for illustration of
compliance via one or both methods depending on the specification.

 

To create a Combined Power Zone, first select all the zones to be included in the
combined zone within the Statistics tab; hold down the Ctrl key while left-clicking on
the desired items.

When all of the desired zones are highlighted, click the Combine button at the top of
the Statistics tab. Visual will create the Combined Power Zone and display it in
the Statistics tab. The name can be modified as necessary.

 

The same procedure can be used to create Combined Calculation Zones.  
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8.4.3 Sta�s�cs Sidebar Tab
The Statistics tab is located in the Sidebar. The tab shows summary data for all Calculation Zones and Power Density Zones and will change as zones are added and removed.

If it is not visible, the Statistics (Sidebar with Statistics tab focus) can be
shown by clicking the command on the Windows sub-menu in the Options
panel of the Tools tab. Shift+S next to the command indicates that this is the
hotkey to initiate the command.

 

The Statistics tab displays both Calculation Zones and Power Density
Zones sorted in alphabetical order by name.

Statistics are displayed for each zone as set in the Settings dialog. See Settings
Dialog for more information.

Calculation Zone and Power Density Zone Properties can be modified
while the Statistics tab is active in lieu of specifically executing the Properties
command. To modify Properties, click the name of a zone. Visual will populate
the Properties panel at the bottom of the tab with the parameters for that zone.

Selected zone names are highlighted in yellow in the Statistics tab and
additionally the associated zone in the Design Environment is highlighted in red.

 

Statistics for multiple Calculation Zones and Power Density Zones can be
selected and Combined to provide an overall summary. For instance, multiple
Power Density Zones could be Combined to provide the Lighting Power
Density for an entire building.

Select the desired zones by left-clicking the names in the Sidebar. Select multiple
names by holding the Ctrl key or Shift key. Click the Combine button at the top of
the Statistics tab. Visual will make a Combined set of Statistics and give it a
generic name. Properties for the combined zone can be manipulated like any
other zone; i.e. Combined zones can be renamed.
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To Filter Calculation Zones and Power Density Zones, click the Filter
button to show the Filter panel in the Statistics tab. The small down arrow
indicates a menu is available, select from the Criterion Menu, from the
Operator Menu, and then enter a value into the Filter Textbox. Visual will show
only zones meeting that collective criteria.

Note that selecting a criterion applicable to Calculation Zones (e.g.
"Minimum")automatically means Power Density Zones will not be shown and
vice versa.

Criteria shown in gray are those not displayed based on system settings in the
Settings dialog. See Settings Dialog for more information.

To reset the filter to show all zones, select No Filter from the drop down.

 

Calculation Zones and Power Density Zones can be Deleted from the
Statistics tab by selecting the zones to be Deleted and clicking the Delete
button on the tab.

 

Display of zones can be compacted by pressing the Collapse button in the upper
right corner of the Statistics tab. Visual will show only zone names. After the
button is pressed it changes to the Expand button and will be highlighted in yellow.
Pressing the Expand button reverts to the original state where summary data is
shown below the name.

 

If the Calculation status needs to be updated, Visual displays greyed text and
blank numerical entries for the sub entries of Calculation Zones.

Modifications to luminaires (changing to a different type, erasing, changing
Wattage in the Luminaire Schedule, etc) will cause Visual to automatically
update Power Density Zone Statistics.

 

Right-clicking a Calculation Zone name initiates a pop-up menu providing
Delete, Export, and Properties commands.

Exporting a Calculation Zone is done in CSV format and includes illuminance
to five decimal places and the height of each calculation point.

 

Which statistical values are shown is controlled in the Settings dialog. See Calculations Settings for more information.
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8.5.1 Ligh�ng Metrics
A basic knowledge of lighting metrics is necessary to fully integrate Visual into the design process.

 

 



8.5.1.1 Illuminance
Illuminance is the most common metric used by the lighting industry for system performance verification.

Loosely defined, illuminance (E) is the amount of light falling onto an area. Thus,
illuminance is a density. The footcandle is the English unit for illuminance and
represents the number of lumens (light) incident on an area per square foot of that
area. Lux is the metric equivalent of the footcandle and represents the number of
lumens incident on an area per square meter of that area. The units used to display
illuminance values in Visual may be changed in the Settings Dialog.

 

Illuminance is a directional quantity, meaning that one must speak not only of the
illuminance at a location in the model, but of the illuminance in a particular direction at
a location in the model.

One can think of each calculation point as a miniature illuminance meter. The value
that each illuminance meter reports depends on the orientation of the meter. For
example, a meter at a particular location will have a greater illuminance reading when
facing a source than if it faces away from the source.

 

The most common lighting calculations measure horizontal illuminance on a floor or at
desk level for interior applications, or on the ground for exterior applications. This is
analogous to placing a light meter on one of these surfaces, facing the meter straight
up, and taking a reading.

    

Other common calculations such as vertical illuminance, TV illuminance and
maximum spill illuminance require alternate orientations of the light meters. Visual
provides the means to specify calculation points to calculate all of these illuminance
types. Indeed, any orientation of the calculation point normals (light meters) may be
achieved. For more information on the placing and orientation of Calculation Zones
see section Placing Calculation Zones.
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8.5.1.2 The Components of Illuminance
The illuminance value at any calculation point in a lighting model has two components. The user can control which types are calculated.

The first component is called the direct component and consists of illuminance
produced at the calculation point by light that reaches the point directly from a
Luminaire without being reflected off any of the Solid Objects in the model. The
direct component of illuminance is a relatively straightforward and rapid calculation.

 

The second component is the interreflected component and consists of illuminance
produced at the point by light that, once emitted from a Luminaire, reflects off of one
or more Solid Surfaces in the model before reaching the calculation point. Calculation
of the interreflected component is more complex and time consuming.

 

By default, Visual does not calculate the inter-reflected component of illuminance for
exterior models. In exterior lighting models the interreflected component of illuminance
is most often considered insignificant and therefore the additional calculation time that
would be necessary to calculate this component is unjustified.  By default, both
components are calculated for interior lighting models.

 

However, the user may calculate this component by changing the Calculation Mode
as discussed in Initiating a Calculation.

 

Calculations in Visual are performed with the assumption of perfectly diffuse
reflectance.
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8.5.1.3 Exitance
Exitance is the converse of illuminance. Rather than the density of light incident upon a surface, exitance is the density of light leaving a surface.

In practical terms, exitance (M) may be calculated by multiplying the illuminance on a
surface by the reflectance of that surface. The units of exitance are lumens/square
foot and lumens/square meter.

 

Visual can report exitance by using Properties to change the Measurement Type
and assign a Reflectance to a Calculation Zone after it is created. Select the
Calculation Zone, click the Measurement list in the Calculation panel in the
Properties tab and select "Exitance", then specify a Reflectance. Right-click or
press Enter to apply the changes. Visual will immediately apply the Reflectance
without recalculation.

 

Exitance can be displayed in the Rendered Display Mode By selecting from the
Display Menu on the Calculations tab. (This is not the same as the Display
button on the Home tab.)
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8.5.1.4 Luminance
Luminance is another metric of light leaving a surface. Unlike exitance, luminance is a directional quantity. That is, the luminance of a surface is dependant upon the angle at which the surface is
viewed.

A perfectly diffuse surface is special in that it exhibits constant luminance over all
angles. All surfaces in Visual are modeled as perfectly diffuse, so this in practice
results in the luminance of a surface being directly proportional to the exitance of the
surface and the illuminance on the surface. The units of luminance are lumens/square
foot/steradian or lumens/square meter/steradian.

 

Brightness is the perceptual analog of luminance. The mathematics and perception
research are complex and beyond the scope of this manual. The simplest relationship
is expressed by the Stevens Power Law shown at right. Effectively, a 2x increase in
brightness requires 8x more luminance.

 

Visual can report luminance by using Properties to change the Measurement Type
and assign a Reflectance to a Calculation Zone after it is created. Select the
Calculation Zone, click the Measurement list in the Calculation panel in the
Properties tab and select "Luminance", then specify a Reflectance. Right-click or
press Enter to apply the changes. Visual will immediately apply the Reflectance
without recalculation.

 

Luminance can be displayed in the Rendered Display Mode By selecting from the
Display Menu on the Calculations tab. (This is not the same as the Display
button on the Home tab.)

Brightness can similarly be displayed by making that choice form the sub-menu.
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8.5.2.1 Ini�a�ng a Calcula�on
Once the necessary components of a lighting model have been created, Calculating only requires pressing a single button.

The Calculate button can be found on the Home tab and the Calculations tab of
the Ribbonbar. The Calculate button becomes active after at least one Luminaire
and Calculation Zone are placed. See Placing and Orienting Luminaires and
Placing Calculation Zones.

 

The Calculate button is dual function; the upper portion executes the command, the
lower portion initiates a drop-down menu. Once a selection has been made, that
choice will remain until Visual is closed, or a new choice is made.

Choose the most appropriate Calculation Type from the upper 3 choices by left-
clicking. Interior Lighting and Exterior Lighting set a large number of parameters
used in surface analysis, initial flux evaluation, radiative transfer analysis, and
processing renderings specific to either case. Under normal circumstances, no
difference in calculations will be seen. Sign Lighting expands analysis to provide
proper modeling of shadows caused by sign lettering. This mode is much slower than
the others and should be chosen judiciously.

Choose Direct and Interreflected or Direct Only as desired. The choices are
obvious. Direct Only still considers Solid Objects as light blockers.

 

The Status Bar indicates which mode has been chosen.  

Left-clicking the Status Bar section initiates a dialog providing details about the last
calculation.

 

Once activated, calculation progress is shown in the Calculations Dialog.

The dialog indicates which mode has been chosen and shows progress in the various
steps of analysis. Pressing the Cancel button halts progress, closes the dialog and
returns to the Design Environment as normal.

When calculating Direct Only, several sections (shown in gray at far right) are
skipped.
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When changes have been made to the lighting model that require a re-calculation,
Visual will indicate that Calculation Zone values may no longer be valid by
bracketing point values.

 

 

javascript:TextPopup(this)


8.5.2.2 Automa�c Calcula�on Feature
When making minor adjustments and/or revisions to a lighting model it is often useful to see the updated values after each modification.  

Visual has an Automatic Calculate feature that, when on, recalculates the model
after any change that could effect the illuminance (or other metric) values.

To toggle the Automatic Calculate feature on or off select Auto Calculate from the
Calculations tab of the Ribbonbar.

 

It is recommended that this feature be used at the end of model creation when fine-tuning is being done, not at the start of the project. There is no detriment to using the feature early-on, but it is
very much inefficient since a majority of actions would require a recalculation.
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8.5.2.3 Se0ng and Displaying Contours
Contours are contour lines that are drawn on top of Calculation Zones showing constant values. These are most often associated to illuminance, but are based on the metric used to define
the Calculation Zone. See Lighting Metrics for discussion of different metrics.

Just as contours on topographical maps show constant elevation, Contours in Visual
most often show constant illuminance.

The magnitude of the illuminance (or other metric) is then analogous to elevation on
the topographic map.

 

To show Contours, click the Contours button on the Calculations tab of the
Ribbonbar to initiate the sub-menu.

 

On the sub-menu, place a check in the desired number of contour line checkboxes to
activate them.

The Color for each Contour Line can be specified by clicking the Color button.

Once activated, specify the iso-illuminance value in each textbox.

Select Show All Contours to turn the feature on.

Conversely, select Hide All Contours to turn the feature off.

 

The display of Contour Labels can be toggled in the Contours sub-menu as
shown above. This can also be toggled in the Settings dialog.

Contour Label increment is set on the Contours tab of the Settings dialog and
uses the base drawing units. For example, "20" implies each label will be placed
nominally 20 feet or meters apart.
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Contours can be displayed in a Shaded fashion (with pseudocolor) by editing
Properties for a Calculation Zone and placing a check in the Shaded box in the
Properties tab.

The method used to Shade is that chosen in the Calculation Zones Settings.

 

Note that the display of Calculation Points can be toggled in Properties as well.
This is likely useful when displaying a Calculation Zone with Shading as
discussed above but depends on user preference.

 

Contours are displayed to the boundary points not the bounding edge of a Calculation Zone. This is due to the fact that construction of the contour lines requires values for interpolation; values
are not known past the last points on the edges, regardless of the bounding polygon.
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8.5.2.4 Color-Coding Illuminance Values
Visual provides several options for color-coding illuminance values.

Calculation Zones can be colored at creation by making choices in the Properties
tab. See Calculation Zone Parameters.

After creation, Calculation Zone color can be modified in the Properties tab of the
Sidebar. See Calculation Zone Properties

This can allow for easier identification in more complex projects.

 

Point values can be highlighted based on an Upper Limit and/or a Lower Limit. To
modify highlights, edit the Calculation Zone Properties, and make Color and/or
Value selections as desired.

The default is to highlight the Maximum and Minimum values. New defaults can be
set in the Calculation Zones Settings

 

Using the Lower Limit to highlight all points below a Minimum value required in a
specification provides quick feedback, particularly in site lighting projects.

Values can be set by editing Properties and selecting a common value from the list or
typing a custom value. At right, the specification calls for 0.5fc minimum at any point,
and values below that are shown in red.

The same process could be used to find Upper Limit values above a criteria or
 related to unacceptable max/min ratios.

 

The Lower Limit and Upper Limit can be set to not highlight at all. Edit the
Calculation Zone Properties, and select "None" in both the Lower Limit and
Upper Limit listboxes.

 

See Setting and Displaying Contours for information about Contours and color coding with shading methods.
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8.6 Rendering
Rendering in Visual is a single-click task that is in most cases a quick task. The view can be manipulated without need for a new Rendering due to the fact that all surfaces are perfectly diffuse.
Renderings can be equally generated for interior and exterior projects. Note that exterior Renderings require a Solid Object to be placed to mimic the ground, and it may be advantageous to
change the background color of the Design Environment in the Environment Settings.

The Rendering button can be found on the Calculations tab and the Home
tab of the Ribbonbar. To execute the command, left-click the top portion of the
button.

 

After initiating the command, a Calculation will be performed if a valid solution is
not present. Visual will then display the Rendering In Progress window to
report the completeness of the calculations necessary to generate the
Rendering.

This is the first of up to four "passes" made to refine the Rendering.

After the first pass is complete, Visual displays the current Rendering in
Rendered Display Mode. The View can be changed without impacting the rest of
the process where Visual will enhance the Rendering to provide greater detail.

 

After the first pass, the Rendering Status Bar is displayed at the top of the
Design Window. If the results are immediately unacceptable, the process can
be cancelled by clicking the Stop button.

Visual will proceed through up to four passes to analyze the surfaces. In this
process, Visual determines where high gradients exist and where more analysis
is needed. After each pass is completed, Visual displays the newly refined
Rendering.

When the process is complete, Visual will close the Rendering Status Bar.

 

Luminaires are displayed in a Rendering as defined in the Model tab of the
Luminaire Editor. If a Luminaire Model is not defined, the Luminaire
Symbol will be used.
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The Render button is dual function. The lower portion of the button initiates a
sub-menu that allows for selection of options in the Rendering process.

Left-click an item to toggle the option on or off.

Single-Pass Rendering is just that; only one pass as described above will be
completed to provide an ever quicker analysis to provide proof of concept prior
to a full Rendering.

 

Approximate Curved Surfaces tells Visual to use additional analysis beyond
the actual Solid Objects in the model to generate more visually correct data
that drastically reduces "faceting" as illustrated at middle-right. The system
default is to have this option active, as shown at far right.

 

Renderings can be colorized by choosing appropriate Colors at Solid
Object creation or by modifying Solid Object Properties after creation.

The modification of Solid Object Color does not require a new Rendering to
be performed, assuming the new Color has the same Reflectance as the one
used for the last calculation. To provide fast yet useful Renderings, Visual
does not track the colored components of light and therefore does not provide a
prediction of interaction between colored surfaces.

 

On the Calculations tab of the Ribbonbar, the Display button in the
Render panel allows for varying metrics to be used in Rendered Display
Mode. Clicking the button initiates a sub-menu with multiple choices. The
default mode is to use Solid Object Colors as they are defined in the Design
Environment.

Pseudocolor is controlled on the Calculation Zones Settings in the Pseudo-
Color Shading panel.

 

The Gray Scale mode converts all Colors to the gray equivalent.  

javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_13_Appendices/Color/13.1_Color.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_5_Construct/Constructing_Solid_Objects/5.2_Constructing_Solid_Objects.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_4_New_Features/Properties/4.4.5_Solid_Properties.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_10_Tools/Settings_Dialog/10.6.2_Calculation_Zones_Tab.htm
javascript:TextPopup(this)


The Brightness mode displays the pseudocolor from 0.0 to 1.0.

A colored scale is provided in the lower left corner of the Design
Window. Since brightness is a concept based on human perception, no units
are involved.

 

The Illuminance mode shows the Rendering with pseudocolor shading that
maps illuminance onto all surfaces with actual calculated illuminance used for
scaling.

A colored scale is provided in the lower left corner of the Design Window.
Illuminance is shown with units of footcandles (fc)

 

 

The Exitance mode shows the Rendering with pseudocolor shading that
maps the exitance off all surfaces. Note that Exitance factors illuminance by the
Reflectance of the base Solid Object.

A colored scale is provided in the lower left corner of the Design Window.
Exitance is shown with units of lumens per square foot or lumens per square
meter based on system unit settings.

 

The Luminance mode shows the Rendering with pseudocolor shading that
maps the luminance of all surfaces. See Luminance for discussion of how that
varies from brightness and exitance.

A colored scale is provided in the lower left corner of the Design Window.
Luminance is shown with units of candela per square meter regardless of
system units.

 

See Rendering in the appendices for advanced information on the Rendering process.
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Chapter 9 - View
Visual provides a fully interactive 3-D interface for the construction and analysis of lighting models. This section will describe Visual's approach to 3-D viewing and introduce each of the associated
tools and commands.

The View tab in the Ribbonbar contains a number of tools
and commands used to easily and intuitively manipulate the
Visual view.

 

All view commands are transparent, meaning that they can be initiated while in the midst of other commands if necessary.
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9.1 Mouse Naviga�on
The most intuitive form of navigation in Visual is to use the mouse to Pan, Zoom, and 3-D Orbit in the Design Window.

Panning in the Design Window refers to moving left-right and up-down in the plane
of the computer screen while keeping the view angle constant. Hold the right mouse
button and move the mouse to pan.

 

While a command is being executed, holding the Ctrl key and the right mouse button
will Pan in the Design Window as the mouse is moved.

 

Visual will Zoom In on the current view without changing the view angle by rolling the
mouse wheel forward. Conversely, rolling the mouse wheel rearward will Zoom Out.
Zooming with the mouse wheel works whether or not a command is being executed.

 

Holding the left mouse button will change the view angle in a 3-D Orbit fashion. This
means you are "grabbing" the Design Window just like you would a real object in
front of you. For example, placing the mouse at the top of the screen, holding the left
button, and moving the mouse downward causes more of the top of the model to be
viewed.

 

While a command is being executed, holding the Ctrl key and the left mouse button
will 3-D Orbit in the Design Window as the mouse is moved.

 

While in 3-D Orbit mode, clicking on an object will orbit about that object. Clicking in
open space will rotate about the center of the entire model space or the center of the
screen depending on many variables. The crosshairs and Global Axis (if activated)
will orbit in conjunction with the mouse movement to indicate the view direction.

 

The sensitivity of mouse movement in Visual can be controlled the "+" and "-" keys or
the analogous commands in the Navigation panel of the View tab on the
Ribbonbar. "+" increases mouse sensitivity so that a given mouse movement
makes more movement on the screen.

Sensitivity can also be controlled in the Navigation Speed panel found on the View
tab of the Ribbonbar.

 

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


 



9.2 Basic Viewing
As a 3-D drawing space, the Visual Design Environment can show various views to aid in the design and analysis of lighting models.  In addition to the capabilities with the mouse to change the
view, buttons are located in multiple locations for convenient access.

All View manipulation commands are located in the Navigation panel found on the
View tab.

 

The Home tab contains the most common commands in the View panel.

Display commands and Views are discussed in separate sections.

 

Zoom All shows the entire model while holding the view angle constant.  

The nine fixed view buttons allow for simple navigation around the model. There are
four elevation views, four isometric views (the corner buttons), and the center button
returns to the default Top View. See Keyboard Commands for analogous keyboard
hot keys.

 

The Navigation panel in other tabs provides a truncated set of commands on each
of the main Ribbon bar tabs to allow for convenient access to the basic navigation
buttons. This includes Zoom All, Zoom Window, and Zoom Previous, as well as
the nine buttons for the standard views.

 

Zoom All, Zoom Window, Zoom Previous, Zoom In, Zoom Out, and Zoom to
Center are also included in the Status bar in proximity to the command line where
coordinate entry occurs and changing the view may be necessary at that time.

 

Visual can display a Global Axis in the lower left hand corner of the Design
Window that provides constant feedback as to the view direction and active plane.
See Environment Settings for information on controlling the display. See Mouse Pointer
Navigation and Cartesian Coordinates for information on axes, color-coding, and
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related information.

For more information see View Commands in Chapter 12.



9.3 Display Mode
Visual is capable of displaying the lighting model in several ways to allow for easier design, modification, and analysis of lighting models. Solid Objects are those mostly impacted by these
commands, but the display of other objects can be changed as well; for example, Luminaires and Background Lines would be drawn in a perspective fashion when that mode is chosen.

The View tab contains all of the commands for modifying the Display Mode. The
default mode is an Orthographic projection with Wireframe solids.

 

The Rendered Display Mode is that which is based upon the actual photometry of
Luminaires and how the light reflects with Solid objects. Unlike other Display
Modes, this mode requires a rendering to be performed prior to display. In the
Rendered Display Mode, Visual will display Luminaires using the 3-D model
defined in the Model tab of the Luminaire Editor. See Rendering for more
information.

 

The Shaded Display Mode uses object Color/Reflectance properties to opaquely
shade Solid objects. Objects behind Solids will not be shown. Visual uses an
ambient light source to differentiate between surfaces of the same color. In the
Shaded Display Mode, Visual will display Luminaires using the 3-D model
defined in the Model tab of the Luminaire Editor.

 

The Transparent Display Mode shows the Solid object edges thick as in
Wireframe Display Mode, but also shades the surface in relation to the assigned
reflectance/color while still being translucent. Objects (Solids, Luminaires, and
Background) behind Solids will be visible. Luminaires will continue to be shown
as a wireframe consistent with the Symbol chosen in the Luminaire Schedule.

 

The Wireframe Display Mode is the default when Visual is opened. This mode
displays Solids by only showing the bounding edges, just as if the solid model was
composed only of wire. Solid object edges are shown as lines that are thicker
(bolder) than Background objects, and will be the Color of the Layer on which they
reside.

 

Without changing how Solid Objects are displayed as described above, Visual can display the Design Environment in one of two graphical projection modes:

Orthographic projection displays the model with parallel lines (and surfaces)
remaining parallel.
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Perspective projection displays the model much as it would appear in reality. Parallel
lines (and therefore surfaces) will appear to converge at two vanishing points.

 

Also independent of both surface shading and projection method, Visual can make internal objects visible by removing the "outer wrapper":

As the name implies, the Dollhouse mode "opens" the model much like a child's
dollhouse. Solid Objects nearest to the view camera are removed to allow the
objects farther from view to be seen.

 

The View panel of the Home tab on the Ribbonbar also includes a drop-down
menu button that contains all the Display Modes described here.

This button is also present in the View panel of the Properties tab when executing
commands.
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9.4 Saving Views
Visual can save Views with respect to the angle of the "camera" as well as Layer visibility and other parameters, which is useful when comparing the performance (especially in the Rendered
view) of different lighting systems.

The Views drop-down menu is available on both the Home tab and the View tab.  

To save a View for later use, position the camera where desired using View
commands: zoom, choose a standard isometric view, navigate with the mouse, select
the Display Mode, etc.

 

Clicking the Views button pulls down the sub-menu for saving and managing Views.  

Save the current View by clicking Save View. At a later time, the View can be
reproduced in the Design Environment or in the Print Editor.

 

The current View can be saved to a JPG, PNG, or BMP format image file by clicking
Save View to a File.

 

Retrieval of a saved View is done by simply clicking on the button showing the desired
View in the dialog initiated by the Views button.

 

The View Manager allows the user to rename saved Views. To change the name of
the View , click on the View name, Visual will highlight all of the existing name, and a
new name can be entered.

 

The View Manager allows the user to delete saved Views. Deleting a View does  
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not modify any other parameters in Visual; it only removes the user-defined preset
View. To delete a saved View, move the mouse over the thumbnail of the saved
image to be deleted, an X in a red square will appear in the upper right corner of the
thumbnail, then click the X to delete.

 



9.5 Align to Plane
It is possible to have Visual change the Active Plane to align with a specified Solid Object.

Align to Plane is found in the Status Bar.  

Select the Solid Object to which the Active Plane is to be aligned by left-clicking
with the mouse. Different (not additional) Solid Objects can be chosen if necessary
to make the desired selection.

 

Right-click the mouse or press Enter to end the command and Visual will change the
Active Plane. Note that the axes are aligned to the surface and have changed to be
full screen.

 

Pressing the Home key sets the Active Plane back to the X-Y plane.
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9.6 Align to View
It is possible to have Visual change the View to align with a specified Solid Object.

Align to View is found in the Status Bar.  

Select the Solid Object to which the View is to be aligned by left-clicking with the
mouse. Different (not additional) Solid Objects can be chosen if necessary to make
the desired selection.

 

Right-click the mouse or press Enter to end the command and Visual will change the
View.

 

 



Chapter 10 - Tools
Visual includes various tools to provide design aids, system setting control, and other functions.



10.1 Customize Dialog
The Customize dialog allows advanced users to have control of some of the graphical user interface of Visual.

The Toolbars tab controls which commands are shown.

Clicking New will create a Toolbar below the Ribbonbar. A dialog box will be
shown to name the new Toolbar.

If additional Toolbars are present, they can be renamed and deleted using the
appropriate buttons on this Tab.

Command buttons can be placed on a user-defined Toolbar from the Commands
tab or by left-click-dragging buttons from existing tabs of the Ribbonbar. Note that
moving buttons from default Ribbonbar tabs will make it challenging for Visual
Support to assist users.

 

The Commands tab allows individual commands from any tab to be placed on other
tabs or on a Custom Toolbar.

Select a Category to find a command of interest. Left-click-drag a command from
the listing on the right to a Toolbar or Tab.

 

The Quick Access tab allows control of which commands are shown in the Quick
Access Toolbar. Currently assigned commands are shown in the right pane.

Chose a menu Category from the drop-down and then left-click the desired
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command in the left pane. Click the Add button to place the command on the Quick
Access Toolbar. Conversely, click a command in the right pane and click Remove
to delete a command from the Quick Access Toolbar.

Placing a check in the box will move the Quick Access Toolbar to a location below
the Ribbonbar.

Clicking the Reset button will return the Quick Access Toolbar to the factory
defaults.

The Keyboard tab controls hotkey assignment. Visual includes multiple hotkeys as
outlined in Keyboard Commands. These can be expanded or changed.

Click a Category to find a command of interest. Click the command in the left pane. If
a hotkey assignment has been made, it will be shown in the right pane.

To assign a new hotkey, left-click in the Press new shortcut key box and press the
key combination to be assigned. Click the Assign button. If the selected hotkey is in
use, Visual will alert to this situation. Choose to overwrite the current assignment or
cancel the operation.
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The Options tab controls menus and icons.

Clicking Large Icons displays larger icons in any user-defined Toolbars. This does
not impact the Ribbonbar.

Screen Tips are shown when the mouse hovers over a button. Unchecking this box
removes that feature. If Screen Tips are active, Visual can also show the hotkey
combination (if assigned) in the Screen Tip in the format Command (hotkey); for
example "Explode (Shift+E)". This is particularly useful for new users to learn hotkeys.

How menus appear can be modified by making a selection in the Menu Animations
drop-down.

Note that Personalized Menus and Toolbars is not a valid selection for Visual. This
section is displayed as part of the core tool used to write the computer code behind
Visual and changes made in this dialog have no impact on program operation.
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10.2 Design Tools
Design Tools can be found on the Tools tab of the Ribbonbar. These Tools are HTML-based and open in browser windows. Each tool has a tutorial and help information of its own.

Area - The tool is designed to allow users to quickly determine pole spacing from an
illuminance criteria or illuminance levels from user specified spacing.

 

Interior - The tool is designed to perform lumen method calculations on a rectangular
room. The lumen method determines average illuminance achieved on the workplane
using a derived property of luminaire photometrics and room geometry called the
coefficient of utilization.

 

Flood - The tool was developed to help specifiers select flood, sign, and wall lighting
products. The tool only considers the direct illumination component's effect on the
wall.

 

Roadway - The tool calculates the largest spacing between regularly spaced poles
on a continuous straight and flat roadway using the calculation procedure defined in
the IES RP-8-2000 American National Standard Practice for Roadway Lighting. This
tool includes the changes to the calculation procedure in the 2007 errata.

 

Template - The tool allows for simultaneous comparison of two luminaire templates.
This is a great way to quickly and visually contrast the performance of outdoor fixtures.

 

Wallwash - The tool was developed to help specifiers select flood, sign, and wall
lighting products. The tool only considers the direct illumination component's effect on
the wall.

 

Economic - The tool is designed to provide users with an interface to perform basic
life cycle cost analysis. This tool is based on the IES RP-31-1996 Recommended
Practice for the Economic Analysis of Lighting.

 

Report - The tool provides a method of viewing, comparing, and printing, standard
photometric report information.
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All Design Tools can alternately be accessed outside of Visual at http://www.visual-3d.com/tools/.

http://www.visual-3d.com/tools/


10.3 Help Tools
Help Tools provide varied information related to Visual.

The Help sub-menu is accessed from the Options panel on the Tools tab of the
Ribbonbar.

 

Contents opens the Help dialog.  

Support links to the Support web page with contact information.  

Hot Keys opens the PDF of shortcut keys current available on the Visual website.  

Knowledgebase links to the Support Search web page to allow for research of
commonly asked questions and answers.

 

Training opens a link to the Acuity Brands Center for Light and Space schedule page
where Visual training opportunities can be found among other opportunities in a
browser window.

 

Videos links to a page containing all available videos on the Visual website in a
browser window.

 

Website links to the home page of the Visual website in a browser window.  

Activate License opens a dialog that allows for entry of an activation code after
purchasing Visual.

Deactivate License opens a dialog that deactivates the license code on the current
machine and returns it to the cloud to be used on another computer.
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About Visual provides detailed information about: Version Number, Serial
Number, License Number, and to whom the codes are registered and licensed.

 

 



10.4 Measurement Tools
Tools are provided to measure basic properties of elements in Visual.



10.4.1 Angle Tool
The Angle Tool is found in the Measurement panel on the Tools tab of the Ribbonbar.

The Angle command measures the Angle between objects based on a
Vertex and two Endpoints. On-screen cues in the Status Bar aid in
command entry.

 

Select the Vertex of the Angle to be measured. it is not necessary to use
Object Snap but it is convenient and accurate.

 

Select the Endpoint of the first edge of the Angle.  

Visual displays the Angle from the first edge to the temporary second
edge drawn from the selected Vertex to the cursor. Visual draws a thin
black line illustrating this reference. This allows for multiple, quick,
approximate measurements by moving the cursor to a location near
desired points.
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Select the Endpoint of the second edge of the Angle.  

Visual will display the measured Angle in the Status bar. The Angle
command is automatically restarted to measure additional Angles as can
be seen from the command direction in the Status Bar that is the first
step in this process.

To exit the command, right-click the mouse.

 

Lines do not need to be present for the command to provide a result. Lines are used here to more clearly illustrate the concept. The inputs may be based on real or imaginary lines, or Solid
Objects.



10.4.2 Distance Tool
The Distance Tool is found in the Measurement panel on the Tools tab of the Ribbonbar.

The Distance command measures the Distance between two points as
specified.

 

Select the first point.  

Visual displays the Distance from the first point to the cursor. Visual
draws a thin black line illustrating this reference; obscured at right. This
allows for multiple, quick, approximate measurements by moving the
cursor to a location near desired points.

 

Select the second point.  
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Visual will display the Distance in the Status bar. The Distance
command is automatically restarted to measure additional Distances as
can be seen from the command direction in the Status Bar that is the first
step in this process.

To exit the command, right-click the mouse

 

Lines do not need to be present for the command to provide a result. Lines are used here to more clearly illustrate the concept. The inputs may be based on real or imaginary lines, Solid
Objects or Luminaires.
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10.4.3 Radius Tool
The Radius Tool is found in the Measurement panel on the Tools tab of the Ribbonbar.

The Radius command measures the Radius of Background objects.
The command does not operate on Solids.

 

After clicking a Background object, Visual displays the Radius in the
Status Bar.
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10.5 Minimize Ribbonbar
The Minimize Ribbonbar command is found in the Options panel of the Tools tab on the Ribbonbar.

The Minimize Ribbonbar command changes the behavior of the
Ribbonbar to allow for a larger working space in the Design Window. When
the function is active, the button will be highlighted in yellow.

 

Minimizing the Ribbonbar means that only the tabs will be shown until a tab
is clicked. When a tab is clicked, Visual will "pull down" the Ribbonbar to allow
for further command execution.

Clicking the active button will turn off the feature and maximize the Ribbonbar.
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10.6 Se%ngs Dialog
The Settings dialog is accessed in the Options panel of the Tools tab.

Clicking the Settings button initiates the Settings dialog.  

Seven tabs allow for advanced control of functionality and setting of defaults.

Make selections as desired and click OK to exit and save those choices. Click
Cancel to exit without saving changes.

Click Save As Defaults to use the current choices every time Visual is opened.
Choices can be made on multiple tabs and then Save As Defaults can be selected.

Click Reset to change all Settings back to the system defaults.

At the bottom of each tab in the dialog, Visual displays helpful tips about Settings and
color-codes that to individual sections. At right, Visual indicates which Settings will
require a recalculation to be put into affect.
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10.6.1 Calcula&ons Tab
The Calculations tab is found in the Settings dialog accessed in the Options panel of the Tools tab on the Ribbonbar.

The Design Mode panel controls calculation engine parameters. Exhaustive testing
has been done to remove the need for an overwhelming number of "sliders". Select
the mode that is most applicable to the project type.

Interior Mode and Exterior Mode set a large number of parameters used in
surface analysis, initial flux evaluation, radiative transfer analysis, and processing
renderings specific to either case. Under normal circumstances, no difference in
calculations will be seen.

Sign Lighting Mode expands analysis to provide proper modeling of shadows
caused by sign lettering. This mode is much slower than the others and should be
chosen judiciously.

 

The Calculation Mode panel controls whether or not Visual makes calculations of
the interreflected component of radiative transfer. Direct and Interreflected
calculates both components whereas Direct Only is the direct component only.
Direct Only is assigned when a new Exterior Project is created from the File
menu and is appropriate for area lighting, roadway, and sports projects.

 

The Statistics panel controls which statistical calculations are performed and
displayed in the Statistics tab of the Sidebar. See The Sidebar and Statistics for
more information.

Selection of statistical quantities should be obvious except two used primarily in sports
specifications:

Uniformity Gradient  - This calculates the local change in lighting quantity (e.g.
illuminance) between adjacent points in the grid. The reported value is the highest
found in the calculation grid.  In summary, the value quantifies how quickly lighting
quantity changes and controls "bright and dark spots".

Coefficient of Variance  - This is an advanced statistical calculation defined as the
standard deviation divided by the mean (average) of all points. In brief, as applied to
sports lighting, this is the average difference from the average, and thus measures the
concept that one low illuminance should not overly impact the overall acceptability of a
design, depending on how low that minimum may be.

 

The Luminaire Blocking panel controls if Visual considers Luminaires to be light
blockers or not. The implication of the two choices is as indicated in their titles. This
option does not make the Luminaires reflect light in the radiative transfer system.

 

Console Mode tells Visual to open a Windows command-prompt window and  
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display the calculation process and minimal feedback information in a step-by-step
process. This setting is for advanced users only.

Settings made in subgroups indicated with a "*" and shown in dark red will not take
effect until a recalculation is performed.

 

Choices made apply to the current session. Click Save As Defaults to apply settings to other sessions.  See The Calculation Engine for detailed information on how calculations are performed.
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10.6.2 Calcula&on Zones Tab
The Calculations Zones tab is found in the Settings dialog accessed in the Options panel of the Tools tab on the Ribbonbar.

The Calculation Zones panel controls dimensional parameters used in Visual.

Decimal is the number of decimals displayed after the integer value. None, one, or
two decimal values can be displayed. Only the options shown in the drop-down are
valid.

Height (Distance) is the height offset from the selected coordinates that the plane
will be placed. This may be above or below a Surface if Calculation Zones
Surface is used to place the Calculation Zone, depending on the direction of the
Surface Normal. A selection can be made from the choices in the pull-down or a
value can be typed.

Row Spacing is the distance (in feet or meters) between points on the X-axis. A
selection can be made form the choices in the pull-down or a value can be typed.

Column Spacing is the distance in (feet or meters) between points on the Y-Axis. A
selection can be made from the choices in the pull-down or a value can be typed.

 

The Calculation Zone Points panel controls the formatting of points and values.

Default Color is the Color that will be assigned to newly created Calculation
Zones.

Point Style allows for the selection of a default style for the calculation point marker.

Max Color is that which is assigned to the maximum value in a zone. Unchecking the
Max checkbox turns off highlighting. Selecting the Above checkbox means that
values above the value in the textbox will be highlighted in the Max Color selection.

Min Color is that which is assigned to the minimum value in a zone. Unchecking the
Min checkbox turns off highlighting. Selecting the Below checkbox means that values
below the value in the textbox will be highlighted in the Min Color selection.

Offset points from zone boundary means Visual will offset points a certain
amount depending on point spacing and Calculation Zone dimensions. This yields a
grid of points centered in the selected area. Unchecking the box causes Visual to start
placing points in the lower left corner of the selected area based on point spacing as
specified in the Calculation Zones panel.

See Using the Color Dialog for more information on Color selection.
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The Pseudo-Color Shading panel controls what is displayed in certain modes
selected in the Display drop-down from the Rendering panel of the Calculations
tab in the Ribbonbar.

Relative will assign the Max Color and Min Color to the highest and lowest values
in each Calculation Zone.

Global will assign the Max Color and Min Color to the highest and lowest values in
all Calculation Zones in the model.

Selecting the upper Color Preview Bar assigns colors between Max Color and
Min Color progressing clockwise around a color wheel. Selecting the lower Color
Preview Bar progresses counterclockwise.

 

          

Selecting Display Mask Zone Outline will show a dashed line in the Design
Environment that indicates where user-selected Masking has been done. This
does not impact what is printed in the Print Editor.

Selecting Display Statistical Zone Outline will show a dashed line in the Design
Environment that indicates the boundaries of Statistical Zones if present. This
does not impact what is printed in the Print Editor.

 

The Power Density Zones panel controls both the default color and displayed
decimal accuracy of Power Density Zones. Valid decimal values are only those
provided in the drop-down.

 

The Statistical Zones panel controls how Visual displays Statistical Zones in the
Design Environment.

Default Color is assigned to both the Calculation Points and the associated text
value and overrides the base selection of the Calculation Zones.

Point Style overrides the selection made in the base Calculation Zones.

 

Settings made in subgroups indicated with a "*" and shown in dark red will not
change existing objects.

 

Choices made apply to the current session. Click Save As Defaults to apply settings to other sessions.
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10.6.3 Contours Tab
The Settings Contours tab is found in the Settings dialog accessed in the Options panel of the Tools tab on the Ribbonbar.

The Contours panel controls which Contour Lines are displayed and what Color
is used for each line.

To activate a Contour Line, check the box next to the desired value. Once activated,
a Color can be assigned. Values can be entered in any order. Any numerical value
can be entered in the text boxes.

See Using the Color Dialog for more information on Color selection.

Making selections here does not turn on Contours . See Setting and Displaying Iso-
Illuminance Contours for more information.

 

The Contour Labels panel controls the display of Labels on Contour Lines.
Placing a check in the Display Contour Labels checkbox turns on labelling. The
Label Location Increment is the (nominal) number of feet or meters between
Labels on each Contour Line.

 

Settings made in subgroups indicated with a "*" and shown in green will have an
effect on existing Contour Lines.

 

The settings on this tab can also be controlled in the Design Environment with the Contours drop-down in the Calculate panel found in the Calculations tab of the Ribbonbar.
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10.6.4 Drawing Aids
The Settings Drawing Aids tab is found in the Settings dialog accessed in the Options panel of the Tools tab on the Ribbonbar.

Circles and Arcs are drawn in Visual as multi-segment polygons and polylines. The
resolution of Circles and Arcs can be changed to use a greater or lesser quantity of
segments depending on the purpose and size of the Circle or Arc.   

As is noted in the settings panel, large Circles and Arcs happen with large projects,
and therefore increasing resolution would be appropriate.

This setting applies to Background and Solid objects. As is noted in the panel,
increasing resolution could greatly increase calculation time, but may in fact not
increase accuracy in nay meaningful way. Again, this is dependent on the particular
situation.

 

The Crosshair Size (the mouse cursor) can be changed from the default 150 pixel
size (at full screen) to extend to the edges of the Design Window by placing a check
in the checkbox.

 

The Dynamic Modes panel allows control of whether or not the left and right mouse
buttons activate the 3D Orbit and Pan functions. If these checkboxes are unchecked,
it is necessary to hold the Ctrl key to activate these modes.  See Mouse Navigation for
more information.

 

The Snap Modes panel allows control of default Snap settings. Similar control is
available in the The Status Bar.

X, Y, and Z Start specifies an alternate Origin for the Snap Increment while
leaving the Cartesian origin as (0,0,0). For example, entering the values at right would
make the Cursor Snap at 5,15,25, etc.; Snap starts at 5 and moves in increments
of 10.

Orthogonal Snap forces the cursor to move perpendicular (orthogonal) to the
Cartesian axes. This on/off option is also provided in the Status Bar. See Incremental
Snap for related information.

 

The size of the Selection Box used to select Objects can be changed from 11
pixels to 41 pixels to accommodate personal preference or need for detail. The two
extremes are shown at right in actual size. See Selecting Objects for related
information.
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Settings made in subgroups indicated with a "*" and shown in dark red will not
change existing objects.

 

 



10.6.5 Environment
The Settings Environment tab is found in the Settings dialog accessed in the Options panel of the Tools tab on the Ribbonbar.

Visual is set to Automatic Save a backup every 5 minutes and will retain those
backup files for 30 days.  Settings can be user-modified if necessary. See Automatic
Recovery and File Backup for related information.

Backup files are located in the directory
[drive]:\Users\[username]\AppData\Local\Visual 2012\Support

 

Background Color sets the color of the Design Window in most Display
Modes.

Render Background is the color used for the Design Window when Rendered
Display Mode is active. See Display Modes for related information.

Selection Color is the color used to indicate an object is part of the Selection Set.
See Selecting Objects for related information.

 

The Units panel allows choices for feet or meters and footcandles or lux. Changes in
distance Units will not convert objects already drawn; i.e. a line of length "3" will
change from 3 feet to 3 meters and therefore be 3.28 times longer.

Note that Luminance is calculated in cd/m2 regardless of Units chosen.

It is strongly recommended that unit choices be made prior to starting a project.
Conversion after objects have been created may yield non-obvious results.

 

Hardware Acceleration can be turned off to remedy issues with certain graphics
cards. There is no need to change this setting without the involvement of Visual
Support.

 

A Global Axis icon can be shown in the lower left of the Design Window. See
Cartesian Coordinates.

Absolute and Relative Coordinates can be shown near the mouse crosshairs.
See Mouse Pointer Navigation.
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10.6.6 Luminaires
The Settings Luminaires tab is found in the Settings dialog accessed in the Options panel of the Tools tab on the Ribbonbar.

The Luminaire panel sets defaults for Luminaire placement in the Design
Environment.

Display Photometric Web will show a scaled 3D mesh of the candlepower curve
attached to the Symbol.

Mounting Height  is the default used when placing a Luminaire, but the Mounting
Height can be modified at placement.

Orientation is the default used when placing a Luminaire, but the Orientation
Angle can be modified at placement.

 

Luminaire Aiming panel settings are useful in floodlighting projects.

The first option will hold the Aiming Point coordinates constant when Moving a
luminaire.

The second option moves the Luminaire Label from near the Luminaire to near
the Aiming Point.

Enable Aim To Surface allows Visual to provide input and as to which surface a
Luminaire is aimed. See Place and Aim Luminaires for more information.

 

The Luminaire Label panel controls default display of Labels. Checking the
checkbox tells Visual to display Labels by default and activates the rest of the panel.
Using the top radio buttons, the choice can be made to display just the type or the type
and the number. If "Type and Number" is chosen, the lower radio buttons control the
default method used to assign numbers.

See Luminaire Display Options for information on making modifications to change the
defaults and more information on the topic.

 

Default Template Colors and magnitude can be set (not to be confused with
Contours) to apply to new Luminaire Types.

Selecting Use Luminaire Symbol Color will assign all Template lines to the
Color of the Symbol and override any other selections.
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Template Resolution can be changed to include a greater or lesser number of
segments in the polyline components. The recommended value should be acceptable
for a majority of situations.

In some cases, photometry is overly sparse and the user may want greater smoothing
between data points. This may not correlate to the reality of photometric output so
changes should be made with direct knowledge it is necessary and valid.

Increasing above the recommended value may cause graphic display lag depending
on computer hardware configuration.

 

Visual includes only a portion of photometric output to speed Template display.
Changing the Template Vertical Angle will include more or less photometric
information. The graphic at the left of the panel displays the actual angle of inclusion
and a dynamic graphic describing the inclusion angle visually. (The recommended
angle is 80°.)

In a vast majority of cases, this setting should not need to be changed. If output is low
or Template lines have very small illuminance values, truncation may be seen in the
Template and adjusting the inclusion angle higher would be valid.

Increasing the angle may cause a noticeable lag in certain computer performance
aspects depending on computer hardware configuration.

 

Settings made in subgroups indicated with a "*" and shown in dark red will not
change existing objects.
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10.6.7 UVGI
The Settings UVGI tab is found in the Settings dialog accessed in the Options panel of the Tools tab on the Ribbonbar.

Enabling UVGI Calculations allows Visual to calculate ultraviolet germicidal irradiation.  

The UVGI tab will be added to the Ribbonbar.  

Using this function requires advanced knowledge and a different data set than "normal" lighting. See UVGI Calculations for more information.
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10.7 Windows Tools
The Windows Tools are found in the Windows sub-menu of the Options panel on the Tools tab of the Ribbonbar.

The Design Manager is an always-on-top dialog.

These tools control the display of some Windows in the Design Environment.
The base functions of the features are described in the relevant sections for Layer
Manager, Properties, and Statistics. These features are shown in the Sidebar.

 

On occasion, Microsoft Windows and Visual don't communicate properly. This can
result in the tabs at the bottom of the Sidebar disappearing. This command forces a
reset of the background computer code and resolves the issue.
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Chapter 11 - Print Editor
The Print Editor provides a versatile means to compose a complete set of final drawings without the necessity of using an additional CAD package.

Visual is capable of multi-page printing on any sheet size supported by a printer or
plotter.

Pages (drawings are referred to as "pages" in Visual) may consist of:

Title block
Multiple views (called Drawings here)
Statistics
Luminaire schedule
Luminaire locations
Drawing notes
Text and drawing annotations
Images
Specification Sheets

Pages can be printed to any printer (including a PDF printer) or exported to
DWG/DXF.

 

From the Design Environment, the Print Editor is accessed by selecting Print
Editor from either the File Menu or the Quick Access Toolbar.
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11.1 Introduc�on
The Print Editor is a full screen editor WYSIWYG with a layout much like that of the Design Environment. The Print Editor includes a Ribbonbar with command buttons, a Design
Layout showing the current Page, a Sidebar for viewing a list of Pages or editing Properties, and a Status Bar that provides feedback and access to some commands.

Important Terminology Note:

Pages are shown in the Design Layout. Pages may contain Drawings. To avoid
confusion, this manual refers to "drawings" as those objects inserted with the
Drawing button on the Ribbonbar. "Drawing" does not refer to the whitespace
representing the piece of paper in the Design Layout; that is called a "page".
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11.1.1 Print Editor Ribbonbar
The Ribbonbar is the graphical menu interface housing all Print Editor commands. The commands on each tab are sub-grouped into panels to make navigation easier. Using a Ribbonbar
style allows easier location of commands via images and text that then allows for more commands to be shown.

Common commands and insertable items are located on the Home tab.  

The Insert tab contains additional resources available to add to Pages.  

The presence of a small downward arrow below the button graphic indicates a sub-
menu is available for more detailed selection. For example, clicking the Drawing
button initiates the sub-menu showing the nine standard views that can be inserted.

 

Some buttons with a small downward arrow are dual-function.

Clicking the upper portion executes the command and insert the default item.

Clicking the lower portion initiates a sub-menu to allow for selection of additional
available items or related commands.

Title Block, Note, and New have this function. The New sub-menu is shown at far
right (modified to show detail).

 

Left-clicking an object in the Page Layout will cause the context-sensitive
Properties tab to appear. The Properties tab provides an interface for the
specification of object parameters.  All versions of the Properties tab contain the
Edit, Format, and Zoom panels. Additional panels will be shown depending on the
object selected. As an example, the tab used for Drawings is shown at right.
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The Edit panel is always on the far-left side of the Properties tab. Cut, Copy,
Paste, and Delete are available. These buttons operate similarly to other Windows-
based applications.

 

The Format panel is always on the left of the Properties tab, just to the right of the
Edit panel. Buttons related to various formatting parameters are available. These may
be activated in a context sensitive manner when a button doesn't apply to the Active
Object. See Using the Format panel for detailed information.

 

The Zoom panel is always on the far-right of the Properties tab. Zoom All, Zoom
In, Zoom Out, and Zoom Window are available. These buttons function in the
same manner as they do in the Design Environment.

 

Specific functionality is covered in various sections of this chapter.
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11.1.2 Print Editor Sidebar
The Print Editor Sidebar provides convenient access to all created Pages and the interface that allows for object parameter modification in the Properties tab.

The Pages tab of the Print Editor Sidebar shows Snapshots of all currently
created Pages. This allows for easy of movement when multiple Pages are created.

Left-click a Page Snapshot to make that Page the Active Page and place it in the
Page Layout Window.

Buttons at the top of the tab allow for New, Copy, Clear, and Delete mimicking the
Page panel of the Home tab of the Print Editor Ribbonbar.
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The Properties tab of the Print Editor Sidebar contains various fields that allow for
advanced manipulation of Page entities such as Font Format or Color.

The Properties tab contains the many common parameters also accessible from the
Properties tab in the Print Editor Ribbonbar such as Font formatting options
standard to Windows-based applications.

 

Note: The use of this tab is an advanced feature in most cases and should only be
necessary if changes are desired to very specific elements of items on a Page.
Specific use of the Properties tab is not covered in this manual. However, it functions
as would be expected having used other parts of Visual and most other Windows-
based applications. For example, left-clicking a field makes it editable or initiates a
dialog, the use of which should be self-evident.  If use and behavior is non-obvious to
the user, it is recommended that use of the Properties tab be avoided to make these
advanced changes.

 

Left-clicking the pushpin in the upper right corner of the Sidebar Auto-Hides or
"pins" it to the right side of the Print Editor Window. Pinning is indicated by the
pushpin pointing to the left, which means that the button is now in the converse "un-pin
mode".

Placing the mouse over the hidden Sidebar causes it to expand, or "flyout". Placing
the mouse over the Page tab or the Properties tab causes that particular tab to
display.

To un-hide or un-pin the Sidebar, left-click the pushpin.
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11.1.3 Print Editor Status Bar
The Print Editor Status Bar is always present at the bottom of the Print Editor screen, and contains various buttons and feedback mechanisms to make Page layout easier. A toggle button
with a gold color indicates the mode associated with that button is in operation as is shown below for Snap Mode.

The components of the Print Editor Status Bar are:

Absolute
Coordinates

 This element reports the location (Cartesian X,Y) of the mouse crosshairs within the Page Layout with respect to the origin (0,0) that is located at the
upper-left corner of the Page. For more information see Cartesian Coordinates.

Snap Mode  This button allows the Snap Mode to be turned on or off and indicates the mode is active when it has a gold background. See Incremental Snap for
more information about how Snap works in the Design Environment, which translates to the Print Editor.

Snap Increment  This list box indicates what snap increment Visual will use if that mode is activated. Three choices are available. Custom increments are not allowed.
 See Incremental Snap for more information about how Snap works in the Design Environment, which translates to the Print Editor.

Zoom  These buttons allow the quick change of the view by: Zoom All, Zoom Window, Zoom In, and Zoom Out. For more information see Zoom for
information about how Zoom works in the Design Environment, which translates to the Print Editor.

Printer, Paper  This field shows the currently selected Printer and Paper configuration. Left-clicking the field is the same as clicking the Print Setup button on the
Print Editor Ribbonbar.

The lower portion of the Print Editor Status Bar will report information when manipulating Page items. For example, the text "Place New Item: Light Level Statistics" will be displayed when
placing that item.
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11.1.4 Print Editor File Menu
The File menu is a part of the Print Editor Ribbonbar but functions like a traditional menu instead of as part of the ribbon. The File menu is where new projects are created, VSL files are
opened and saved, projects are verified with the Audit command, DWG and DXF files are imported and exported, and the Print Editor is accessed.

Upon selecting the File menu, a drop-down menu will appear allowing further selection
of several commands.

The presence of an ellipsis (...) following a menu command indicates that the
command provides access to a dialog form, most of which are just like those used in
other Windows-based applications.

 

The Save command is the same as that in the Design Environment and therefore
saves the current Print Editor and Design Environment. The operating system
focus likely shifts between windows while accomplishing both save operations.

 

The Save As command  is the same as that in the Design Environment and
therefore saves the Print Editor and Design Environments as a new VSL file.

Clicking the command initiates the Save File As Dialog to allow for filename and
location specification.
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The Print command is the same as left-clicking the Print button on the Print Editor
Ribbonbar and initiates the Print Dialog. See Printing.

 

The Export command initiates the Export As Dialog that allows for the
specification of a file name and one of multiple CAD or graphic formats. Once the
Save button has been clicked, the Export CAD Layers Dialog appears to allow the
user to choose which Layers of the Page Layout are exported. Only the current
Page is exported. Clicking OK closes all dialogs and Exports the file.

 

The Close button closes the Print Editor and returns to the Design
Environment. If the current Page Layout is not saved, Visual will ask to save or
not.
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11.2.1 Crea�ng a Page
Initially, the Print Editor contains a single blank page. It is recommended, although not required, to select a printer and paper size before adding objects to the page.

To set the Active Printer, select the Setup button from the Project Panel of the
Print Editor Ribbonbar. Alternately, select the Print, Paper field of the Status
bar.

 

After clicking either Setup button, Visual initiates a drop-down menu.

Clicking the Printer button in this dialog initiates a drop-down to select one of the
system Printers. The Printers shown will vary from computer to computer. Select
the desired Printer to make it the Active Printer.

The Select Paper button initiates the Windows printer configuration dialog for the
Active Printer to allow for detailed configuration. Consult specific printer and
Windows help for more information.

Apply To All Pages tells Visual to use the same Printer and Paper parameters for
each Page. To apply different settings to each Page, uncheck the checkbox, move to
each Page where a different configuration is desired, press the Setup button, and
make the desired selections as above.

Closing the dialog by clicking in the Page Layout Environment will save the
settings.

Clicking the Print button initiates the Visual Print Dialog.

 

To choose a custom paper size, first check the Use Custom Paper Size checkbox.

This will activate the Paper button to allow for default choices to be made or a custom
size can be typed in the text boxes below the Paper button.

Orientation is controlled by making a selection of one of the radio buttons.

Margins are controlled by making default selections from the combo boxes or typing
custom values into the text fields of those boxes.

 

Objects placed in the Page Layout are referenced to a global (0,0). The "paper" is  
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referenced to the same (0,0). Therefore, changing the paper size as shown above
leaves the objects placed in the same locations, which may or may not place them on
the "paper" as shown at far right.

Once a Paper Size has been chosen, any of the objects on the Insert tab of the
Print Editor Ribbonbar can be placed.
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11.2.2 Naviga�on
Navigation in the Print Editor is very similar to the Design Environment. The main exception being that the Print Editor is a 2-dimensional space and therefore has no height or Z-dimension.

Click and hold the right mouse button while moving the mouse in the Print Editor to
move the view in the plane of the computer screen.

 

Use the roller wheel to Zoom In (roll forward) and Zoom Out (roll rearward) when the
mouse cursor is in the Page Layout Window.

 

The Zoom panel of the Print Editor Ribbonbar contains the Zoom All, Zoom In,
Zoom Out, and Zoom Window buttons that function as they do in the Design
Environment.

The Zoom level is saved for each Page.
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11.2.3 Placing Objects
The placement of any object follows generally the same logical progression.

Choose an object to be inserted from the Insert tab (or the Home tab) of the Print
Editor Ribbonbar; for example Light Level Statistics.

 

The object will be attached to the mouse cursor, which then allows the user to left-click
the mouse at the preferred location for the upper-left corner of the object. A plus sign is
added to the cursor to indicate an object is being placed.

 

Objects are placed based on the Snap setting in the Print Editor Status Bar. A
yellow highlight to the Snap button indicates objects will be placed on the Snap Grid
as defined by the adjacent listbox. To change the Snap Grid, select the desired value
from the choices in the sub-menu. The current value will have a yellow check to the
left of the value.

 

Once placed, objects can be moved, scaled, and formatted with commands on the Properties tab of the Print Editor Ribbonbar specific to each object type.
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11.2.4 Selec�ng Objects
Selecting objects in Print Editor is similar to doing so in the Design Environment.

Left-clicking an object makes it the Active Object. This tells Visual to initiate the
Properties tab in the Print Editor Ribbonbar for basic modifications and allows
advanced modification in the Properties tab of the Sidebar.

The Active Object will be highlighted, a grey border with additional capability may be
added, and Grips will be provided for resizing.

 

Grips (the yellow boxes on the perimeter of an object) allow for scaling as discussed
in various sections of this chapter.

 

As in the Design Environment, the mouse can be used to window objects for
selection. Should a left-click be issued when there are no objects within the pick-box,
Visual will automatically assume that selection by Window and Fence is desired. A
rectangle will be dynamically drawn starting at the location of the first left-click as the
mouse is moved within the Design Window. The opposite corner of the rectangle is
then chosen with a left-click to define the rectangular selection region. See Selecting
Objects for a review of the methodology in the context of the Design Environment.

 

Once selected, Print Editor objects can be modified as detailed in the section 7.4 Modifying Pages and Objects as well as information provided in sections of 7.3 Print Editor Objects as
necessary.
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11.2.5 Context Sensi�ve Menus
Right-clicking the mouse on objects initiates a Context-Sensitive Menu that can be useful.

Zoom Selection - zoom to fill the screen with a specified window

Bring to Front - place the object in front of all other objects

Send to Back - place the object behind all other objects

Lock Position - lock the current position such that it can't be moved with the mouse

Cut - remove the object and place it in the Visual clipboard

Copy - place the object in the Visual clipboard

Copy and Locate - copy the object and immediately attach it to the mouse cursor
for placement (equivalent to Copy and Paste at the same time)

Paste - duplicate the last object from Cut or Copy by placing the new object at (0,0)
on the Page

Select All - select all objects on the current Page

Delete - remove the object without placing it in the Visual clipboard

Properties - set focus to the Properties tab of the Print Editor Sidebar with the
parameters of the object active

 

Right-clicking on tabular objects allows for multiple extra features and is discussed in
Working With Tabular Objects.

 

Some functions in the Context-Sensitive Menu may be inactive or inapplicable in various cases. Right-clicking in some cases yields a reduced set of options.
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11.3 Print Editor Objects
Many different objects can be placed on a Page to illustrate the lighting model.

Luminaire Schedule - describes the luminaires

Surface Schedule - details the surface properties

Statistics - summarizes lighting metrics for each Calculation Zone

Power Statistics - summarizes lighting power density

Template - pre-defined user-created elements used across multiple projects

View - any saved view from the Design Environment

Note - user-defined text describing the project or lighting model

Products - Graphics and/or specification sheets from any Acuity Brands
product

Luminaire Locations - detailed information about placement and aiming

Text - simple alphanumeric information

Shape - a Line or Callout to connect elements

Drawing - any of the nine pre-defined views scaled as desired

Title Block - text and graphic information describing the project and designer

 

The elements can be placed in any position, each element can be formatted to suit individual preference or project needs, and detailed formatting can be applied by advanced users to provide
individuality as desired.
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11.3.1 Drawings
Drawings show the lighting model in 2-dimensions to a specific scale.

To place a Drawing on the Page, click the Drawing button located on the Insert tab
of the Print Editor Ribbonbar.

 

Visual will initiate the Drawing drop-down menu showing the nine basic views
available. Left-click the desired view.

Once a view direction is selected, Visual will determine the appropriate scale to fit the
Drawing.

 

Drawings are placed by left-clicking the mouse in the desired location as described
in Placing Objects.

 

Visual automatically chooses a Drawing scale based on the Page size and
commonly used scales. The scale of a drawing can be easily modified.

Modification of Drawings is discussed in Modifying Drawings.

 

To place a view of the model that is not one of the nine standard viewing angles, a View must be inserted.
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11.3.2 Luminaire Schedule
Luminaire Schedules provide detailed information about Luminaires used in a lighting model. The specific content of the Luminaire Schedule is modified in the Design Environment.
Modifications discussed here are related to formatting.

To place a Luminaire Schedule on a Page, click the Luminaire Schedule button
on the Insert tab of the Print Editor Ribbonbar.  

Luminaire Schedule is placed by left-clicking the mouse in the desired location as
described in Placing Objects.  

See Working with Text-Based Objects for information on editing text content.

See Working With Tabular Objects for information on formatting tables as well as
choosing columns to display.

 

When a multi-head Luminaire Type is present, the Luminaire Schedule in Print
Editor behaves like that in the Design Environment.

A plus symbol is shown at the left edge of the row when it is the Active Object, and
the multi-head Luminaire Type can be expanded to show information for individual
heads by clicking the plus symbol.

This feature is useful in very complex projects, and is of little value when the heads are
the same base Luminaire (IES file).

To collapse the Luminaire Type, click the minus symbol.
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The available columns for a Luminaire Schedule are:

Symbol - The Symbol defined in the Luminaire Schedule Editor

Label - The text label defined in the Luminaire Schedule Editor

Image - The graphic assigned in the Acuity Brands database

QTY (Quantity) - The number of the Luminaire Type placed in the model

Manufacturer - Text from the [MANUFAC] field of the IES file or that edited in the Luminaire Schedule Editor

Catalog Number - Text from the [LUMCAT] field of the IES file or that edited in the Luminaire Schedule Editor

Description - Text from the [LUMINAIRE] field of the IES file or that edited in the Luminaire Schedule Editor

Lamp - Text from the [LAMP] field of the IES file or that edited in the Luminaire Schedule Editor

Number Of Lamps - Text from the IES file or that edited in the Luminaire Schedule Editor

Filename - The name of the IES files used as the base of the Luminaire Type definition

Lumens Per Lamp - Text from the IES file or that edited in the Luminaire Schedule Editor

LLF - The Light Loss Factor  assigned in the Luminaire Schedule Editor

Wattage - Text from the IES file or that edited in the Luminaire Schedule Editor

Efficiency - The calculated efficiency from the information in the IES file

Distribution - The IES classification and spacing criterion (SC) across and along the lamps

Plot - A miniaturized candlepower graph in polar coordinates (otherwise called a polar plot or candela curve)

Notes - This is the only field NOT based on the Luminaire Schedule Editor. When this column is shown, it allows for insertion of additional text-based information using the editing
method in Working with Text-Based Objects

Once placed, the object can be modified in many ways. See Working With Text-Based Objects for information about formatting headers.

Visual has default settings of common content. The default may differ on any one computer based on user choices; see Saving Templates and Defaults.
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11.3.3 Luminaire Loca�ons
Luminaire Locations shows a table with data about position and aiming of each Luminaire in the model.

To place a Luminaire Locations table on a Page, click the Luminaire Locations
button on the Insert tab of the Print Editor Ribbonbar.

 

Luminaire Locations is placed by left-clicking the mouse in the desired location as
described in Placing Objects.

 

See Working with Text-Based Objects for information on editing text content.

See Working With Tabular Objects for information on formatting tables as well as
choosing columns to display.

The available columns for Luminaire Locations are:

 

No. - The Luminaire Number based on the sort method chosen for Luminaire Labels in the Design Environment

Label -  The Luminaire Type Label as assigned in the Luminaire Schedule Editor

Location (X, Y, Z) - The Cartesian coordinates of the Luminaire

MH - The mounting height of the Luminaire

Orientation - The orientation of the Luminaire based on 0° as defined in the Luminaire Schedule Editor for the Symbol

Tilt - The angle of tilt with 0° being straight down (in the negative Z-axis) of the Luminaire

Aim (X, Y, Z) - The Cartesian coordinates of the aiming point of the Luminaire

Once placed, the object can be modified in many ways. See Working With Text-Based Objects for information about formatting headers.

Visual has default settings of common content. The default may differ on any one computer based on user choices; see Saving Templates and Defaults.
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11.3.4 Power Density Sta�s�cs
Power Density Statistics shows a table with data about each zone relaying area, total power, and the resulting power density to justify or verify compliance to various requirements.

To place a Power Density Statistics table on a Page, click the Power Density
Statistics button on the Insert tab of the Print Editor Ribbonbar.  

Power Density Statistics is placed by left-clicking the mouse in the desired
location as described in Placing Objects.  

See Working with Text-Based Objects for information on editing text content.

See Working With Tabular Objects for information on formatting tables as well as
choosing columns to display.

The available columns for Power Density Statistics are:

 

Description - The name given to each Power Density Zone in the Design Environment

# Luminaires - The number of Luminaires associated to the zone

Total Watts - The total number of Watts (power) associated to the zone, based on the defined Watts in the Luminaire Schedule Editor

Area - The area of the zone, based on the system units of feet or meters

Density - The resulting Watts per unit area (W/ft² or W/m²) for the zone equalling [Total Watts]/[Area]

Once placed, the object can be modified in many ways. See Working With Text-Based Objects for information about formatting headers.

Visual has default settings of common content. The default may differ on any one computer based on user choices; see Saving Templates and Defaults.
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11.3.5 Sta�s�cs
Light Level Statistics (Statistics) summarize performance metrics for all Calculation Zones placed in the model. Statistics only applies to lighting metrics. Lighting Power Density is
summarized in Power Density Statistics placed separately.

To place a Statistics table on a Page, click the Statistics button on the Insert tab of
the Print Editor Ribbonbar.

 

Statistics is placed by left-clicking the mouse in the desired location as described in
Placing Objects.

 

See Working with Text-Based Objects for information on editing text content.

See Working With Tabular Objects for information on formatting tables as well as
choosing columns to display.

The available columns for Statistics are:

 

Description - The name given to each Calculation Zone in the Design Environment

Symbol - the graphical symbol associated to the zone

Avg - the average of all values in the zone

Max - the maximum value in the zone

Min - the minimum value in the zone

Max/Min - the maximum value in the zone divided by the minimum value in the zone

Avg/Min - the average of all the values in the zone divided by the minimum value in the zone

Avg/Max - deprecated; the average of all values in the zone divided by the maximum value in the zone

Min/Max - deprecated; the minimum value in the zone divided by the maximum value in the zone

Min/Avg - deprecated; the minimum value in the zone divided by the average of all values in the zone

Max/Avg - deprecated; the maximum value in the zone divided by the average of all values in the zone

UG - Uniformity Gradient, which is the highest value of all the local changes in lighting quantity between adjacent points in the grid

CV - Coefficient of Variance , which is an advanced statistical calculation defined as the standard deviation divided by the mean (average) of all points

NOTE: units will change as necessary depending on the Calculation Type chosen. Some statistics (e.g. UG and CV for a luminance-based zone) become nonsense in some cases.
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Once placed, the object can be modified in many ways. See Working With Text-Based Objects for information about formatting headers.

Visual has default settings of common content. The default may differ on any one computer based on user choices; see Saving Templates and Defaults.
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11.3.6 Surface Schedule
Surface Schedules summarize properties of all Solid Objects in the model.

To place a Surface Schedule table on a Page, click the Surface Schedule button
on the Insert tab of the Print Editor Ribbonbar.

 

Surface Schedule is placed by left-clicking the mouse in the desired location as
described in Placing Objects.

 

See Working with Text-Based Objects for information on editing text content.

See Working With Tabular Objects for information on formatting tables as well as
choosing columns to display.

The available columns for Surface Schedule are:

 

Name - the name given to each Solid Object in the Design Environment

Reflectances - the "front" and "back" Reflectance assigned to each object

Normal (X, Y, Z) - the unit vector describing the normal of each object

Area - the square feet or meters of each object based on system units

Once placed, the object can be modified in many ways. See Working With Text-Based Objects for information about formatting headers.

Visual has default settings of common content. The default may differ on any one computer based on user choices; see Saving Templates and Defaults.
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11.3.7 Title Block
A Title Block can be inserted on a Page to organize and illustrate project-related information.

To place a Title Block table on a Page, click the Title Block button on the Insert
tab of the Print Editor Ribbonbar. The top portion of the button places a Title
Block.

Once the button is pressed, Visual inserts the Title Block based on the printable area
and margins returned by the Windows system information.

 

The Title Block button is dual function; the lower portion of the button initiates the
Title Block Dialog that shows saved Title Blocks that can be inserted. Left-click
the desired thumbnail image and Visual inserts the Title Block based on the printable
area and margins returned by the Windows system information.

Note that, once placed, the Title Block cannot be moved or resized like other objects.

Today's date will be placed in the Title Block. This can be edited if necessary.

Borders are formatted as described in Working With Tabular Objects.

 

Editing text-based sub-objects in a Title Block is similar to the method for other text-
based objects; the first left-click places focus on the object, and the second left-click
tells Visual to modify the text contents of the object. See Working With Text-Based
Objects for detailed information.

Editing the main Title Block text is slightly different in that a small editor appears to
edit the text without it being rotated. Multiple lines can be input. Click Accept to close
the editor and apply the changes.

 

The image in the upper-right can be modified as described in Images to present a
company logo or any graphical element.

 

Using the Title Block Dialog, the user can select Keep All Titleblocks Synchronized
to make each text field the same on all sheets; i.e. "Designer" (or whatever the user
chooses for that field) is the same on all Pages. This feature also removes automatic
Page numbering.
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Using the Title Block Dialog, the user can select Manage Titleblock Templates  that
initiates a dialog to delete and rename saved Title Blocks. See Saving Templates
and Defaults.

 

Visual has default settings of common content. The default may differ on any one computer based on user choices; see Saving Templates and Defaults.
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11.3.8 Products
Products provide a way to describe products in a detailed fashion using graphical and specification sheet information from the Acuity Brands Product Database. Consequently, this only applies to
Acuity products. "Product" refers to one of the elements related to a Luminaire Type, and can vary depending on the context. It could be a graphic (JPG, BMP, PNG, etc) or a PDF. Or, by the
time we get around to updating the manual, it could be a QR code or something to tie in your Google Glass or alert the NSA you're planning to sell LEDs to Iran. Products are a specific case of
inserting PDF files.

To place a Product on a Page, click the Products button on the Insert tab of the
Print Editor Ribbonbar. The number in the red circle represents the number of
Products available to insert.

 

The Product Dialog will initiate below the button. Each Product section contains a
graphic and a specification sheet PDF; either of these may be blank indicating there is
not an object of that type to place. As can be seen at right, the blue header is labeled
with the IES file name.

Left-click either object type to place it on a Page.

 

Clicking a graphic tells Visual to place an Image as described in Images with the file
(from the product database) pre-attached for placement.
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11.3.9 Views
Views are saved images from the Design Environment as described in Saving Views. Views are not Drawings and are not to a scale.

To place a View on the Page, left-click one of the Views shown in the Views panel
on the Insert tab of the Print Editor Ribbonbar.

 

The first View (in the upper-left) is always the current View in the Design
Environment. If the desired View is not shown, scroll using the scrollbar on the right
or click the expand button to see all Views. Left-click the desired View.

 

Clicking a View tells Visual to place an Image as described in Images with the related
graphic file of the View pre-attached for placement.

 

Once placed, a View can be Cropped if desired. Select the View to be Cropped.
Click the Crop button in the Properties tab of the Print Editor Ribbonbar and
select Crop View from the drop down menu.

Left-click-drag a window that defines the area to remain after the Crop. Release the
left mouse button and Visual automatically applies the changes and ends the
command.
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To Reset a Cropped View, click the Crop button in the Properties tab of the
Print Editor Ribbonbar and select Reset View from the drop down menu. Visual
will automatically restore the View to its original size.

 

Note that Views are often saved in Visual at a larger size than they are placed and can be enlarged without pixelation.

To insert a scalable Drawing, see Drawings.
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11.3.10 Images
Images can be placed on the Page to provide supporting information, logos, signatures, PE stamps, or other graphics. The Images functionality is also used by Visual when inserting some other
objects. PNG, GIF, JPG, BMP, TIFF, and EMF files are valid for insertion.

To place an Image on a Page, click the Image button on the Insert tab of the Print
Editor Ribbonbar. The standard file selection dialog used in other Windows-based
applications will be initiated. Select the desired file and click Open.

 

Once a file has been selected, Visual attaches it to the mouse cursor for placement.
Left-clicking the mouse in the desired location places the graphic.

 

Modifications to borders are made in the Format panel of the Properties tab in the
Print Editor Ribbonbar. See Using the Format Panel.

 

Images are inserted with title text based on the filename. Editing this text is
accomplished by clicking the title text after the Image has been selected. As with
other text-based entities, Visual initiates an editing box highlighted in yellow.

Left-click the mouse in whitespace to apply changes.

Formatting of title text is done with items in the Text panel as described in Working
with Text-Based Objects

 

Once inserted, the Image can be modified using the Image button on the
Properties tab of the Print Editor Ribbonbar that is initiated after left-clicking the
Image.

Clicking the button has functions as discussed in Using the Image Preview.

 

The scale of the Image may not be desirable. To change the scale of the Image, left-click the Image to select it, then two options are available:
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1) Use the grips to left-click-drag: Left-click the mouse on a yellow grip, hold the
mouse button, and drag until the desired size or scale is achieved. Visual displays the
resulting scale factor in the upper-left corner.

 

2) Using the advanced Properties tab of the Sidebar, type the desired scale % (of
original size) in the text box and press Enter to apply the change. The "%" symbol
does not need to be entered.

 

Images are used to insert Products, and Views as well as in the Title Block graphic.
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11.3.11 Notes
Notes is a text-based element that allows for description of the lighting model.

To insert a Notes entity, click the Notes button on the Insert tab of the Print Editor
Ribbonbar. This selects the default Notes entity.

 

Notes is placed by left-clicking the mouse in the desired location as described in
Placing Objects.

 

The Notes entity is a pre-formatted container that holds a large text box. To edit the
content, simply left-click the object to make it active, and then left-click it to activate
text editing.

 

The Notes button is dual-function. clicking the lower portion initiates the Notes
Dialog that shows saved Notes that can be inserted. Left-click the desired thumbnail
image and Visual inserts the Notes.

 

Using the Notes Dialog, the user can select Insert Note From File  that initiates a
dialog to choose a text file to be used to populate the Notes content area.

 

Using the Notes Dialog, the user can select Manage Note Templates that initiates a
dialog to delete and rename saved Notes.
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Notes borders can be formatted as described in Using the Format Panel  

See Working With Text-Based Objects for information about formatting text.

See Saving Templates and Defaults for information on saving Notes entities for future use.
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11.3.12 Text
Text can be inserted on a Page for various reasons. This section does not apply to editing text in other objects.

To insert Text, click the Text button on the Insert tab of the Print Editor
Ribbonbar.

 

Text is placed by left-clicking the mouse in the desired location as described in
Placing Objects.

 

The Text entity is a pre-formatted container that holds a large text box. To edit the
content, simply left-click the object to make it active, and then left-click it to activate
text editing.

Click in "whitespace" to end editing and apply changes.

 

Text borders can be formatted as described in Using the Format Panel. Unlike text in
the Design Environment, Text can be formatted like most Windows-based
applications allow.

 

See Working with Text-Based Objects for information on formatting Text.
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11.3.13 PDF
The PDF (function) allows for specification sheets not in the Acuity Product Database, lamp and ballast information, or other elements to be inserted in the Print Editor, just like PDF specification
sheet Products. PDFs are placed one sheet at a time onto a Page.

To place a PDF page from a file, click the PDF button on the Insert tab of the Print
Editor Ribbonbar. Clicking the button opens a file selection dialog standard to
Windows-based applications. Select the desired file as normal.

 

The PDF Dialog will be initiated, which allows for the selection of one of the pages
contained in the PDF file. Multiple insertions can be executed to place all pages if
necessary.

Click the Next and Previous buttons below the snapshot to display the desired page.
Click OK to place the object. Click Cancel to close without changes.

 

PDFs are placed by left-clicking the mouse in the desired location as described in
Placing Objects.

 

Once placed, PDFs behave like an Image in Print Editor and can be modified as
described in Images.

PDF Page borders can be formatted as described in Using the Format Panel.
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11.3.14 Shapes
Shapes provide basic elements to augment a Page.

To insert a Shape on a Page, click the Shapes button on the Insert tab of the Print
Editor Ribbonbar.

 

Clicking the Shapes button initiates a sub-menu that allows for selection of one of the
available elements. Left-click the desired element.

 

Shapes are placed by left-clicking the mouse in the desired location as described in
Placing Objects.

 

A Line provides a straight segment and two nodes.  

A Callout provides a straight segment, a node, and a (by default) numbered textbox.  

Lines and Callouts can be moved by left-click-dragging the object with the mouse.

Lines and Callouts can be changed in length and orientation by left-clicking the
object to make it active, then performing a left-click-drag on one of the end grips.

 

Callout text can be edited by using the advanced Properties tab in the Print Editor
Sidebar. Left-click the object to make it active and modify the text as necessary in the
text box of the Content section.

 

Modifications to Shapes are made in the Format panel of the Properties tab in the
Print Editor Ribbonbar. See Using the Format Panel.
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11.3.15 Table
Tables allow for the inclusion of tabular data on a Page.

To insert a Table, click the Table button on the Insert tab of the Print Editor
Ribbonbar.

Clicking the button initiates the Table Dialog that allows for specification of Table
size. Place the mouse over the location that yields the desired number of rows and
columns.

Note that a Table title row and header row will be automatically inserted in addition to
the number of rows chosen.

The example at right places two rows and 3 columns as shown below.

 

Tables are placed by left-clicking the mouse in the desired location as described in
Placing Objects.

 

Visual uses the default formatting for the new Table and provides placeholder text for
the title and header row in addition to the chosen number of rows and columns. At
right, the two rows and three columns shown in the selection from the Table Dialog
above have been used to create a new Table.

 

See Working With Text-Based Objects for information about editing headers.

See Working With Tabular Objects for information on formatting; e.g. borders and shading.

Visual has default settings of common content. The default may differ on any one computer based on user choices; see Saving Templates and Defaults.
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11.3.16 Templates
Templates are user-defined objects based on standard Print Editor objects.

To insert a Template object, click the Template button on the Insert tab of the Print
Editor Ribbonbar.

Clicking the button initiates the Template Dialog that allows for the choice of one of
the pre-defined Templates.

Templates must first be created as described in Saving Templates and Defaults to
be displayed and therefore inserted with this dialog. Templates may not exist on a
given computer; Visual does not include Templates.

(Note that the dialog graphic at right has been modified for the purpose of this manual.)

 

Left-click the desired Template object from the dialog. Templates are placed by left-
clicking the mouse in the desired location as described in Placing Objects.

 

Once placed, the object can be moved, edited, formatted or otherwise manipulated as
normal. See the appropriate section in this chapter for information on any of the object
types.

 

Using the dialog, clicking Manage User Templates  initiates a dialog window that allows
Template objects to be renamed and deleted.

To rename an object, left-click the desired object and click the Rename button at the
bottom of the dialog. Visual will initiate a dialog to select a new name.

To delete an object, left-click the desired object and click the Delete button at the
bottom of the dialog. Deletion cannot be undone.

(Note that the dialog graphic at right has been modified for the purpose of this manual.)

 

See Manipulating Pages for information on saving Page Templates.
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11.4 Modifying Pages
Pages and objects can be modified in various ways in the Print Editor.

Be sure to review Selecting Objects for information on choosing objects to modify.
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11.4.1 Manipula�ng Pages
Whole Pages can be controlled in Print Editor.

 

Page Order
The order of Pages can be manipulated in the Print Editor Sidebar.

To change the order of Pages, left-click the Pages tab in the Print Editor Sidebar
to make it active if it is not already active.

 

Select the desired Page by left-clicking.

Left-click-drag the desired Page to the new location; Visual indicates the new location
with a blue line.

Release the mouse to move the Page.

 

 

Modifying Whole Pages
The Page panel of the Print Editor Ribbonbar can be used to create or modify whole Pages.

The Page panel contains buttons to create New Pages as well as Copy, Clear,
and Delete whole Pages. These buttons are duplicated (in a smaller fashion) at the
top of the Page tab of the Print Editor Sidebar.

Commands operate on the Active Page. To make a Page the Active Page, left-
click it in the Pages tab of the Print Editor Sidebar. The Page will be displayed in
the Page Layout Window.

 

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


Clicking the upper portion of the New button creates a New Page based on the
Default Page (as defined in the New Page Dialog) in the last position in the
Pages tab of the Sidebar.

Note that the Default Page may vary from that shown at right.

 

The New button is dual-function; clicking the lower portion initiates the New Page
Dialog.

Left-click the desired page and Visual will insert that page type in the last position in the
Pages tab of the Sidebar.

Add A Blank Page will insert a blank page with no objects in the last position in the
Pages tab of the Sidebar.

Save this page as the default page saves the active page (displayed in the Page
Layout Window) as the default to be used for all new Pages.

Save this page as a template saves the active page (displayed in the Page Layout
Window) as a template. a dialog will be displayed to name the Page Template and
it will be shown in the New Page Dialog.

Manage Page Templates initiates a dialog discussed below.

(Dialog modified to fit in view at right.)

 

The Copy button duplicates the Active Page including all objects on the Page and
places the Page copy in the last position in the Pages tab of the Sidebar.

To make a Page the Active Page, left-click it in the Pages tab of the Print Editor
Sidebar.

 

The Clear button removes all objects from the Active Page.

To make a Page the Active Page, left-click it in the Pages tab of the Print Editor
Sidebar.
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The Delete button removes the entire Active Page, which of course includes all
objects on the Page.

To make a Page the Active Page, left-click it in the Pages tab of the Print Editor
Sidebar.

 

Using the dialog, clicking Manage Page Templates initiates a dialog window that allows
Template Pages to be renamed and deleted.

To rename a Page, left-click the desired  Page and click the Rename button at the
bottom of the dialog. Visual will initiate a dialog to select a new name.

To delete a Page, left-click the desired Page and click the Delete button at the bottom
of the dialog. Deletion cannot be undone.

(Note that the dialog graphic at right has been modified for the purpose of this manual.)
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11.4.2 Edi�ng the Page Layout
Object placement can be changed at any time once an object is placed.

Objects are moved based on the Snap setting in the Print Editor Status Bar.
A yellow highlight to the Snap button indicates objects will be placed on the
Snap Grid as defined by the adjacent listbox. To change the Snap Grid, select
the desired value from the choices in the sub-menu. The current value will have a
yellow check to the left of the value.

 

To Move an object, left-click-drag the object to the desired position and release
the mouse to change the placement. As the mouse is being held, the cursor will
change to a 4-arrow symbol indicating a move is in progress. When the mouse is
released, the object will still be the Active Object to aid in further modifications.

 

When the mouse cursor is over a Grip (yellow boxes on the perimeter of an
object), a double-arrow will be displayed. Left-click any grip,  hold, and move the
mouse to change the size of the object. When the left-click is being held, the
mouse cursor will be a pointing finger. Release the mouse to apply the change.

 

As the mouse is moved when scaling, Visual displays different scales at the top
of a Drawing to aid in sizing to fit the Page. The blue size tag that will be used
as the scale when the mouse is released will have bold white text as in "10' " at
right.

 

As the mouse is moved when scaling an Image, Visual displays different the
resulting scale factor of the Image to aid in sizing to fit the Page. The blue size
tag shows the scale that will be used when the mouse is released.

 

Objects can be modified with Cut, Copy, and Paste as normal in Windows-
based applications. Delete removes the object without placing it on the Visual
Clipboard. Make the object the Active Object and select the appropriate button
from the Edit panel. Alternately, the Context-Sensitive Menu can be used to
access the commands.

 

Note that objects can be placed on top of other objects, which may be useful when Drawings contain a good deal of whitespace. See Context Sensitive Menus for information on controlling which
objects are in front of other objects with Send to Back and Bring to Front.
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11.4.4 Modifying Drawings
Once placed, Drawings can be modified in many ways.

To modify a Drawing, left-click the Drawing to be modified. Visual will highlight
the Drawing with a dashed border and provide grips.

 

Drawings are by default given a name that is placed below the Drawing on the
Page. This name can be moved by left-clicking it separately, and moving it with a
left-click-drag operation as should be expected. The text that appears (other than
the scale text) can be modified by using the advanced Properties tab in the
Sidebar; the Text field in the Content sub-section is where alternate text can
be input. The name can be deleted by highlighting it individually and clicking the
Delete button in the Ribbonbar or pressing the Del key.

 

The Properties tab is displayed in the Print Editor Ribbonbar. The Drawing
panel contains elements to modify the selected Drawing.

 

The View button initiates the same drop-down graphical menu used at initial
creation, and thus changes the view direction. Simply left-click the desired view
direction and the change is applied.
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The Scale checkbox tells Visual to apply a particular Scale to the Drawing. The
default for orthogonal views is to use a Scale. The default for isometric views is
to not use a Scale. Make selections from the combo boxes, type custom values
as desired, or use the grips as described below.

See http://en.wikipedia.org/wiki/Architect%27s_scale  and
http://en.wikipedia.org/wiki/Engineer%27s_scale for information on scaling
drawings.

 

Contours is a toggle button that turns on or off the display of Contour Lines.
This does not override the setting in the Design Environment; i.e. to display
Contour Lines in Print Editor, they must be turned on in the Design
Environment. The feature is on when the button is gold. See Setting and
Displaying Contours for more information.

 

Labels is a toggle button that turns on or off the display of Luminaire Labels.
This does not override the setting in the Design Environment; i.e. to display
Luminaire Labels in Print Editor, they must be turned on in the Design
Environment. The feature is on when the button is gold. See Luminaire Display
Options for more information.

 

Masks is a toggle button that turns on or off the display of Calculation Zone
Mask boundaries. This overrides the Design Environment setting if
necessary. See Masking Calculation Zones for more information.

 

Templates is a toggle button that turns on or off the display of Luminaire
Templates. This does not override the setting in the Design Environment; i.e.
to display Templates in Print Editor, they must be defined and turned on in the
Luminaire Schedule and Design Environment. The feature is on when the
button is gold. See Luminaire Display Options and Luminaire Templates for more
information.

 

Symbol is a toggle button that turns on or off the solid fill shading of Luminaire
Symbols. This can be useful in site lighting projects where the size of the project
dwarfs the luminaires and they can be hard to see. Note that turning this feature
on likely blocks the view of information "below" the luminaires; i.e. Calculation
Zone point illuminances.

 

Web is a toggle button that turns on or off the display of Photometric Webs for
all Luminaires. This overrides the display setting in the Design Environment
and will turn on Photometric Webs even if they are turned off there. See
Luminaire Display Options for information.
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Clicking the Layers button initiates the Drawing Layer Dialog that allows for
each Layer defined in the Design Environment to be turned on or off by
placing a check in the related box (to turn a Layer on). This can be used to
override Visibility settings in the Layer Manager.

Layers made Invisible in the Design Environment will be unchecked as is
shown at right for the Calculation Zones System Layer.

 

When the mouse cursor is over a grip (yellow boxes on the perimeter of an
object), a double-arrow will be displayed. Left-click any grip,  hold, and move the
mouse to change the size of the object. When the left-click is being held, the
mouse cursor will be a pointing finger. Release the mouse to apply the change.

 

As the mouse is moved when scaling, Visual displays different scales at the top
of a Drawing to aid in sizing to fit the Page. The blue size tag that will be used
as the scale when the mouse is released will have bold white text as in "10' " at
right.
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11.4.3 Working with Text-Based Objects
Regardless of where text occurs (Text, Notes, or text in part of an object), text is modified with the same methods.

To select text, left-click a Text object, a field in a table or Title Block, or text that is
part of another object. The selected text is highlighted for identification.

Text fields connected to data in the Design Environment cannot be edited for
content. For example, Luminaire Type information, Calculation Zone names, and
Calculation Zone statistical values.

 

Text can be edited by left-clicking the object (or field) once it is the Active Object (or
field). The mouse cursor changes to the standard I-bar used in Windows-based
applications when editing text. To close text editing of the object, simply left-click
anywhere in the Page Layout whitespace. For example, at right, a Luminaire
Schedule column header is modified.

 

 

Note that in this manual, "text" refers to alphanumeric characters. "Text" (when seen in bold) refers to the Text object that can be inserted.

 

Text Panel
The Text panel is shown in the Properties tab of the Ribbonbar whenever the Active Object contains a text component that can be modified with these features.

The Text panel provides access to the available formatting options for text in Visual.
Most functions and buttons are common to Windows-based applications.

Yellow highlighted buttons indicate currently selected options.

 

Font shows the currently selected style by name. Clicking the button initiates a sub-
menu showing the currently selected font and all available Windows system fonts.

 

Font Sizes shows the currently selected size.  Clicking the button initiates a sub-
menu showing the currently selected size in yellow and all available sizes.

 

Bold makes all text in the selected object bold.  
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Italic makes all text in the selected object have italic formatting.  

Underline makes all text in the selected object have an underline.  

Horizontal Alignment changes the alignment of all text in the selected object. Left,
center, and right alignment are available. A yellow highlighted button indicates the
currently selected option.

 

Vertical Alignment  changes the alignment of all text in the selected object. Clicking
the button initiates a sub-menu with top, middle, and bottom alignment options.

 

Font Color initiates a condensed version of the Color Dialog. See Using the Color
Dialog. The currently selected color is shown in the Color Dialog with a yellow
border.

The colored bar below the "A" on the button shows the currently selected color when
the dialog is collapsed. For example, red, green, and blue are shown at the far right.
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11.4.5 Working With Tabular Objects
Tabular objects (tables) in Visual Print Editor have common modification capabilities. This applies to Luminaire Schedule, Luminaire Locations, Statistics, Power Statistics, Surface
Schedule, and user-created Tables. Note that "tables" is the generic term used here, and Tables are the specific entity that can be inserted on a Page.

To modify a table, it must be made the Active Object by left-clicking it. The specific
location the mouse is clicked will place focus on one of the sub-elements of the table.
This may be one of the headers or a specific cell.

 

Left-clicking a particular field will put focus on that field for formatting. Visual highlights
the cell that the mouse is over for easier selection. Focus can be placed on other
fields by simply left-clicking them. This includes headers and table names.

 

The text in any cell can be formatted with the Text panel in the Print Editor
Ribbonbar. See Working with Text-Based Objects for more information.

 

Cell and table formatting (border, fill, etc) is modified with the Format panel. See
Using the Format Panel for more information.

 

Clicking the table name header will select the entire object for formatting. For example,
Border Color can be changed to blue.

Note: to change the fill of the title cell, select the title text and apply the formatting
desired, which has also been done in the example at right.

 

Formatting a single header row cell applies formatting to the entire header row.

When focus is placed on a header cell, Visual initiates the content editing mode, which
can be ignored and formatting can be applied as desired. At right the Fill for the header
row has been changed to blue.

 

file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Print_Editor_Objects/11.3.2_Luminaire_Schedule.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Print_Editor_Objects/11.3.3_Luminaire_Locations.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Print_Editor_Objects/11.3.5_Statistics.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Print_Editor_Objects/11.3.4_Power_Density_Statistics.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Print_Editor_Objects/11.3.6_Surface_Schedule.htm
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Print_Editor_Objects/11.3.15_Table.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Modifying_Pages_and_Objects/11.4.3_Working_With_Text-Based_Objects.htm
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Modifying_Pages_and_Objects/11.4.7_Using_the_Format_Panel.htm


To format the cell borders for the entire table, click any content cell (i.e. not a header or
title cell) and apply formatting as desired.

At right the Border Color for the data grid has been changed to blue.

 

Clicking the Hide button on the far left of a row will collapse the row and make it
invisible.

To make the row visible again, hover the mouse over one of the adjoining rows and
click the Unhide button that will appear when rows are hidden. This function
Unhides all rows.

 

Column widths can be changed individually by placing the mouse cursor in the header
row at the junction between two columns. The mouse cursor will change to a double
left-right arrow as is customary in Windows-based applications.

Row height cannot be edited as such; height is determined by the content.

 

The number of rows displayed in a tabular object can be increased or decreased by
using a left-click-drag operation to move the Rows button up or down. The mouse
cursor changes to a double arrow as is customary in Windows-based applications.

 

Once a table is selected, the Properties tab is displayed in the Print Editor
Ribbonbar.

The Text panel is displayed to modify text. See Working with Text-Based Objects.

A table panel will be displayed at the far-right end of the Ribbonbar that will have a
label equal to the object type selected.

 

Columns initiates a sub-menu that shows all available columns and the currently
visible columns as indicated by blue checkmarks.

Left-click a column name to either make it visible or invisible depending on the current
state as indicated by the checkmark.

See the manual sections for particular objects for a listing of columns for each object
type. At right, the sub-menu for a Power Density Statistics table is shown.
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Rows initiates a sub-menu with options to manipulate entire rows. The impact of
each choice is obvious based on the name.

When a standard tabular object is selected, some options are not valid. For example a
Luminaire Schedule row could not be inserted without defining a new Luminaire
Type in the Design Environment.

When a Table is selected, content is fully customizable, so Visual activates all options
as seen at far right.

 

Export initiates the standard Windows Save As Filename dialog for specification of a
filename and location to save a Microsoft Excel (*.XLS) format file of the content of the
Active Object.

Depending on specific systems, Microsoft Excel may produce a warning message
when the exported file is opened. It is fine to ignore this "trusted source" message.

 

When a right-click is issued on a tabular object, Visual adds a section near the top of
the Context-Sensitive Menu specific to the manipulation of tables. At right, the
example menu is related to a Surface Schedule; the blue bar will indicate which
type of object was clicked.

Add Column - add an unnamed column related to where the mouse was clicked

Hide Column [column name] - hide the current column; [column name] will change
depending on the column selected.

Hide Group [group name] - hide the entire group of columns of which the currently
selected column is part; [group name] will change depending on the object type and
column selected.

Expand All Rows - expand all rows that have been Hidden or opens sub-luminaire
definitions for a multi-head Luminaire Type when a Luminaire Schedule has
been clicked; See Luminaire Schedule.

Collapse All Rows - collapse all sub-luminaire definitions for a multi-head
Luminaire Type when a Luminaire Schedule has been clicked; See Luminaire
Schedule.

 

To scale a tabular object (which linearly increases or decreases content including font
size, use the grips to left-click-drag: Left-click the mouse on a yellow grip, hold the
mouse button, and drag until the desired size or scale is achieved.
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11.4.6 Using the Image Preview
The Image Preview provides an interface to modify some properties of an Image.

Once inserted, an Image can be modified using the Image button on the Properties
tab of the Print Editor Ribbonbar that is initiated after left-clicking the Image.

 

The Image button is dual-function. Left-clicking the lower portion initiates a sub-menu
with three choices:

Insert - initiates a file selection dialog to choose a file or to change the file
associated to the Image.

Modify - initiates the Image Preview Dialog; the same as clicking the upper half
of the button.

Clear - removes the associated Image file. Note that the title text will remain
unchanged.

 

Clicking the upper portion of the button initiates the Image Preview Dialog.

Browse - initiates a file selection dialog to change the file associated to the Image.

Crop - reduces the Image to a previously selected area. First left-click to start
defining a window and then left-click a second time to complete the window. Visual
shows the selected area with a dashed border. Click the Crop button to apply the
command.

Cancel - exits the dialog without any changes.

Accept - exits the dialog and applies changes.

File Menu - contains Open and SaveAs commands. This can be useful to save
Product Images from the Acuity Brands Database.

Edit Menu - contains Cut, Copy, Paste, and Clear (same as the button)
commands.

Tools Menu - contains Rotate, Crop (same as the button), and Reflection Effect
commands. The Reflection Effect provides augmentation with a horizontal mirror
line and an image modification that mimics a reflection.

Stretch Image to Fit - enlarges the image without changing aspect ratio.
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Other parameters can be modified in the Format Panel.
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11.4.7 Using the Format Panel
The Format panel is shown in the Properties tab of the Ribbonbar whenever an object has been selected in the Page Layout. See 7.2.4 Selecting Objects for information on making an
object the Active Object.

The Format panel provides access to the available formatting options for objects in
Visual. Most functions and buttons are common to Windows-based applications.  

Templates initiates a sub-menu that allows the Active Object to be saved as the
default to be used for that object type or simply as a Template as discussed in 7.6
Saving Templates and Defaults.

 

Properties launches the Properties bar on the right of the screen.  

Bring To Front moves the Active Object in front of all other objects on a Page.  

Send To Back moves the Active Object behind all other objects.  

Lock constrains the position of the Active Object so it cannot be moved. This button
is a toggle button in that when selected it will be highlighted in yellow and is then on.
Clicking the button again will turn off the feature. Locked objects will have a lock
symbol in the upper-left corner when they are made the Active Object.

 

Border Thickness initiates a sub-menu that provides various thickness options.
Thickness increases by one pixel per choice. The currently selected option is shown
with a blue highlight.

The button graphic shows the currently selected Border Thickness. Color does not
change.
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Border Color initiates a condensed version of the Color Dialog. See Using the
Color Dialog. The currently selected color is shown in the Color Dialog with a yellow
border.

The colored bar on the button shows the currently selected color when the dialog is
collapsed. For example, red, green, and blue are shown at the far right.

 

Fill initiates a condensed version of the Color Dialog. See Using the Color Dialog.
The currently selected color is shown in the Color Dialog with a yellow border.

The colored bar on the button shows the currently selected color when the dialog is
collapsed. For example, red, green, and blue are shown at the far right.

 

Image is a dual-function button that initiates a sub-menu or launches the Image
Preview.

Complete functionality is described in 7.4.5 Using the Image Preview
 

Some Format panel buttons will not be active for certain object types: Fill is not valid for an Image and is inactive, Image is not valid for a tabular object and is inactive, etc.
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11.5 Prin�ng
Once Pages include all desired objects and have been appropriately organized and formatted, Print completes the process by making paper or PDF versions of the Pages.

The Print command is accessed from the Home tab of the Print Editor
Ribbonbar. Additionally, the command can be found on the File menu and in the
Quick Access Toolbar.

 

Clicking the Print button initiates the Print Dialog.

The current Page (shown in the Page Layout Window) will automatically be
selected as the sole Page for printing.

 

The Select Pages pane shows all Pages and the printer associated to it. Left-click
the box next to a Page to select it for printing.

Alternately, click Select All to choose all Pages.

 

Clicking the Page name places a preview in the Preview Pane.

The bottom of the Preview Pane includes text describing the selected printer, paper
size name, and paper size numerically.

At right, two previews are shown for two different Setup scenarios.

 

The Copies textbox allows for the increase and decrease of the number of copies  
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with the up and down arrows respectively. Alternately, a numeric value may be input to
the textbox.

Click Print to execute the command. Click Cancel to exit without printing.  

See Creating a Page for information on changing printer associations and settings.
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11.6 Saving Templates and Defaults
Objects can be saved as the default object to be used for the related object type and can be saved as named Templates for use in common scenarios. "Default" means that the Page or object
will be used to define new insertions. "Template" means that the definition is saved to be used later if desired. The process for saving defaults and Templates is similar for Pages and objects; the
process is discussed individually below..

Page Templates and Defaults

To save a complete Page, as a default or Template, the Page must be the Active
Page in the Page Layout Window. Select the Page from the Print Editor
Sidebar.

See Sidebar for information on selecting specific Pages.

 

To save a complete Page as the default, select Save this page as the default page
from the bottom of the dialog that results from clicking the New Page button on the
Page panel of the Print Editor Ribbonbar or the New Page button in the
Sidebar.

 

To save a complete Page as a template, select Save this page as a template from the
bottom of the dialog that results from clicking the New Page button on the Page
panel of the Print Editor Ribbonbar or the New Page button in the Sidebar. A
dialog will be initiated to allow for naming of the Template.

 

See Manipulating Pages for information on using and managing Page Templates.

 

Object Templates and Defaults
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The Visual command reference is available in the program and on www.visual-3d.com. 

It has not been included here as a simple aid in reducing the page count if this PDF is printed. 



To make an object (for example a Luminaire Schedule or Note) a default or a
Template, it must be made the Active Object.

See Selecting Objects for information on selecting objects.

 

To save any object as a default, select Save as Default from the sub-menu initiated
after clicking the Templates button on the Format panel of the Print Editor
Ribbonbar.

 

To save an object as a Template, select Save as User Template from the sub-menu
initiated after clicking the Templates button on the Format panel of the Print Editor
Ribbonbar. A dialog will be initiated to allow for naming of the Template.

 

See Templates for information on using and managing object Templates.

javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Working_in_Print_Editor/11.2.4_Selecting_Objects.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_11_Print_Editor/Print_Editor_Objects/11.3.16_Templates.htm


Purge
Reduce file size by removing unused or unnecessary informa�on

Instruc�ons:
1. Select Purge from the File Menu
2. The Purge File Dialog will appear
3. Select any or all of the data types as described
4. Click OK

Command Keys:
None

Related Commands:
None

Related Help:
None

Related Videos:
None
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Save
Save the current Visual file (*.V SL)

Instruc�ons:
1. Select Save from the File Menu
2. If the current Visual file has not been previously saved the File Selec�on Dialog will appear so that a directory and filename may be specified
3. If the file has been previously saved, Visual will save the most recent informa�on
4. The progress in the save process is shown in the Status Bar

Command Keys:
Ctrl+S

Related Commands:
Save As

Related Help:
Saving a Project

Related Videos:
None
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13.1 Color
The Color Dialog is used in many instances in Visual to allow for Color selection.

Depending on the context, there are different ways to initiate the Color Dialog.
The button is a color swatch and often has a small down-arrow next to it; the color
of the swatch will vary based on default settings and user selection. Some
examples of where the button appears are shown at right.

 

 

javascript:TextPopup(this)
javascript:TextPopup(this)


13.1.1 Color Dialog
The Color Dialog> is used in the Layer Manager and the Luminaire Editor, as well as when constructing Solid and Background objects, Calculation Zones, and Statistical Zones.
For specific information on how the Color Dialog relates to those commands, see the relevant sections in this manual.

The Color Dialog is a flyout composed of four panels and three commands.  

Standard Colors is a set of readily accessible choices covering a range large
enough to allow for various objects to have different colors for easy reference.  

Default Shading is a set of gray shades in 10% increments for Reflectance
assignment when exact Color is not important.  

Recent Colors shows the last eleven Colors used. Each new Color chosen is
amended to the left end of the row.  

Favorite Colors are user-specified and saved as defaults to be used across multiple
projects. To save a Favorite Color it must be in the Recent Colors panel (i.e. the
Color must be previously selected for use). Right-click the mouse on the desired
Color in the Recent Colors panel and select Add to Favorites. To delete colors,
right-click the mouse on the desired color and select Remove.

 

The More Colors button initiates the Color Selection Dialog. See Using the Color
Selection Dialog for more information.  

The Select an Object… command allows for the Color to be set by selecting an
existing object.  

The By Entity command appears in the Color Dialog when initiated from the
Layer Manager and changes the assignment mode back to the default of Color
being determined by entity properties if the Layer has been assigned a Color. See
Layer Manager for more information.

 

To select a Color, initiate the Color Dialog, and then left-click the desired Color.
The dialog will be closed and the Color assignment will be made.   
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The choice of a Color is only necessary if Color Rendering is a desired output
from Visual. Grayscale choices yield the same numeric results as "colored" choices,
assuming the Reflectance value is the same.

The Color and Reflectance chosen for Solids is independent of the Layer Color.
The Layer Color is used to provide user feedback in the Design Environment and
the Color and Reflectance is used for calculation.

On the right, the objects with a black border have different Color (and therefore
Reflectance ) on the Solids System Layer (Color is ByLayer) and those with a
green border are on a separate Layer, also with different Color (and Reflectance ).
In Shaded Display Mode shown at the bottom, borders (drawn in the Layer
Color) are not shown. The gray, red, and blue all yield the same calculational result
because they are all 50% Reflectance .
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13.1.2 Using the Color Selec�on Dialog
 The Color Selection Dialog is initiated with the More Colors… command in the Color Dialog.  This dialog is a hybrid 2-D implementation of the 3-D hue, saturation, and lightness (HSL)
color model with red, green, and blue (RGB) inputs and information.

The dialog consists of a Preview Pane, a Hue Selector, a Color Grid
containing Color Swatches, and the Saturation Selector.

The Display Reflectance checkbox turns on or off the display of reflectance
values in the Color Grid.

The Preview Pane shows larger swatches and more information. The Red, Green,
and Blue (RGB) components are pre-loaded into text boxes for alternate modification
via that color model. The aggregate Reflectance of the RGB values in the text
boxes is shown below those fields. The currently assigned Color is shown as the
“Old” Color in the Preview Pane.

 

Clicking a button in the Hue Selector changes the grid to be (in effect) a more
detailed set of hues of the chosen base color. Since saturation values are pre-set
left-to-right (95% maximum on the right), the row of Saturation Selector buttons
are disabled.

This process allows for each angular "lune" of hue (color) to be isolated in the HSL
color model.

 

To reset the grid to display the original gamut of hues, click the multi-colored button
at the upper right of the Color Grid.  

Clicking a Color Swatch in the Color Grid places that Color in the Preview Pane for comparison and that Color will be applied if the OK button is clicked.

To close the dialog and apply the selected Color to the Object or Layer, click the
OK button. Clicking the Cancel button closes the dialog without making changes.  

Hue is what is most often referred to as “color” in English and this manual.
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13.1.3 HSL Color Model
A brief discussion of the HSL color model is appropriate to understand how user input to the Color Selection Dialog impacts what is displayed.

The HSL model is based upon traditional color mixing methods such as in mixing
paint; brightly colored pigments are mixed with black or white to achieve lighter, darker,
or in other words less colorful colors.

 

Hue is an attribute of visual sensation according to which an area appears to be
similar to red, yellow, green, or blue, or a combination of any two of those colors. Hue
is shown in the Hue Selector and the various columns in the Color Grid.

 

Saturation is the colorfulness of a stimulus relative to its own brightness. In Visual, this
is a percentage value controlled by the Saturation Selector buttons at the bottom of
the Color Grid. A saturation of 100% would yield the middle row in the Color Grid
being the most colorful. For example, in RGB color space, this would be a “red” that
was quantified as (255,0,0).

 

Lightness is the brightness relative to the brightness of a similarly illuminated white.
Lightness varies with each row in the Color Grid with the middle row having a
lightness of 0.5. Moving toward the top of the grid yields more mixture with white and
moving toward the bottom of the grid yields more mixture with black. For example, this
would respectively yield a “pink” and “burgundy” as shown at right.

 

 

For more discussion of color models see http://en.wikipedia.org/wiki/HSL_and_HSV and http://en.wikipedia.org/wiki/Comparison_of_color_models_in_computer_graphics
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13.2 Calcula�on Engine
This appendix contains discussion of the theory and methods used to generate calculations and renderings.

Introduction

Basic Calculation Procedure

Geometric and Photometric Analysis

Occlusion

Form Factors

Initial Flux

Final Illuminance

Processing Calculation Zones

Rendering

Daylighting
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13.2.1 Introduc�on
 

Scope of calcula�ons
The calculation engine used in Visual photometrically models the interaction of luminaires, sun, and sky in a user-specified environment that may consist of surfaces that absorb and reflect light
which have arbitrary orientations and planar shapes. The detail and accuracy of the photometric model is sufficient to predict direct and interreflected illuminances at any array of points.

Geometric input
Surfaces that block, reflect, and/or transmit light can be planar polygons.

Photometric input

Luminaires
For electric lighting calculations, light sources are luminaires that have a specified luminous extent and an arbitrary luminous intensity distribution.

IES files, Elumet file, TM14 files
Luminaire data is assumed to be contained entirely within any of the three most commonly used data files for the transfer of photometric information. At a minimum, these files give the
luminous extent, specify which of the standard coordinate systems is used to describe the luminous intensity distribution, list the angles of that coordinate system that are used, and
list the luminous intensity values of the luminaire at those angles.
The Visual calculation engine assumes that photometric data files are in that form defined by IES/ANSI standard LM-63-02. The user interface to Visual converts any of the user-
supplied photometric files to an equivalent LM-63-02 file and submits them to the Visual calculation engine.

Surfaces
Surfaces ("solids") specified by the user are single planar entities with a surface normal (perpendicular) derived from the order in which the user specifies the vertices of the polygon defining
the shape and orientation of the surface. Single user surfaces are treated in the calculation engine as two surfaces, back-to-back, separated by an internally-determined incremental
distance. They are assumed to have identical photometric properties.

Reflectance
Reflectance is assumed to be perfectly diffuse and can have values between 0.0 and 0. 999.  Reflectance is specified in the Visual user interface in percentage form and any value
specified as 100% is reduced to 0.999. Perfect diffusion permits the assumption that the amount and distribution of reflected light is independent of incidence direction.
Specular or so-called mixed reflectance cannot be modeled in Visual at this time.

Transmi)ance
Transmittance is assumed to be either perfectly diffuse or perfectly image preserving. Transmittance can have values between 0.0 and 1.0. Transmittance is specified in the Visual
user interface in percentage form.
Perfectly diffuse transmittance permits the assumption that the amount and distribution of transmitted light is independent of incidence direction and that transmitted light has a diffuse
distribution.
Perfectly image preserving transmittance preserves the direction of travel of the light, but reduces that amount. The value specified by the user is assumed to be that value of
transmittance perpendicular to the surface. If the user-specified value of transmittance is less than 1.0 (100%), then it is assumed that glass is being used, and that the transmittance
value depends on incident angle. In this case, the calculation engine automatically determines and uses the appropriate value of transmittance for the incidence angles involved.

Absorbtance
If the user-specified values of reflectance (r) and transmittance (t) do not sum to 1.0, then the absorbtance of the surface is assumed to be 1-r-t, and is the fraction of light lost by
absorption in the surface.

Spectral reflectance and transmi)ance
The Visual calculation engine makes "the gray assumption"; that is, all reflectances, transmittances, and flux from light sources are assumed to be spectrally flat. That is, the
photometric property is uniform throughout (and therefore independent of) visible wavelengths.
Although spectral uniformity is assumed, the values of reflectance and transmittance are not entirely uncoupled from a surface color specified by the user. The Visual user interface
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Although spectral uniformity is assumed, the values of reflectance and transmittance are not entirely uncoupled from a surface color specified by the user. The Visual user interface
estimates a wide-band reflectance from the RGB values that define a user-specified color. If the user chooses to keep the color and the reflectance linked, notice is given if the
specified color and reflectance are incompatible. For example, it is not possible for "brown" to have a high, wide-band reflectance.
Some surface colorizing effects can be generated in the renderings. See the section of Rendering.
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Wireframe view showing luminaire template  Wireframe view showing luminous volume
  
 

  

 

Rendered view showing luminous volume  Rendered view showing luminaire model

13.2.2 Basic Calcula�on Procedure
Luminaires as light sources
All photometric information about a luminaire is assumed to be contained in an IES/ANSI LM-63-02 formatted file. The luminous extent is specified with three local luminous dimensions: x, y, z. As
defined in the standard, various combinations of zero, positive, and negative values are used to indicate various luminous forms. Regardless of the form indicated in the photometric data file, ALL
luminaires are assumed to be luminous parallelepiped (rectangular boxes). The dimensions of the approximating luminous box are determined to best fit the values and shape provided in the
photometric data file. These boxes are considered at luminous volumes in the Visual calculation engine.

Luminous volumes
The luminous intensity distribution specified in the file is used to determine which of the six faces of the luminous volume are photometrically active. The "Luminous Volume" button in the
"Luminaire" tab of the Visual user interface toggles these faces on and off. Faces colored yellow are those the calculation engine has made photometrically active, those in blue are inactive.
The total luminous radiant power of the luminaire (luminous flux) is distributed among the active surfaces, with the total being equal to that of the entire luminaire. Individual faces have
individual distributions appropriate for their orientation and size. The sum of these distributions equals that of the entire luminaire.
Examples are the following.  A lensed troffer has only the local bottom surface photometrically active. A surface-mounted wraparound with have three faces active: the bottom and the two
long sides. A sharp-cutoff highbay will have 5 surfaces photometrically active: the bottom and four sides.  

 

Luminaire photometric informa�on and its extension
No form of commonly used photometric data file contains information about luminaire appearance or luminaire surface/opening luminance distribution. Therefore, the Visual calculation
engine assumes that the luminous power of any active face of a luminous volume is homogeneous; that is, on any luminous face, the per unit luminous radiant power and distribution are
everywhere the same. However, these values can and do differ from active face to active face.
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Accoun�ng for luminaire luminous areas (contour integra�on)
Advanced techniques are used to calculate either the illuminance at point or the incident flux on a surface produced by any one face of a luminaire luminous volume. These rely on the
assumed homogeneity of each active surface, account for the area of the active face, and eliminate the need to discretize the face into assumed point sources. Additionally, they are
computationally faster than the point discretization technique.

Illuminance at a point
The Visual calculation engine uses a procedure to calculate the illuminance at a point from a face of a luminaire luminous volume that was first discovered in 1994. A numerical contour
integration is performed around the edges of the face. Details can be found in the technical paper:  "Non-Diffuse Radiative Transfer 1: Area Sources and Point Receivers,"  D.L.
DiLaura and J. Quinlan, Journal of the Illuminating Engineering Society, Summer 1995, Vol. 24, No. 2, pp. 102-113.

Flux onto a surface
The Visual calculation engine uses a procedure to calculate the flux onto another surface from a face of a luminaire luminous volume that was first discovered in 1996. A numerical
double contour integration is performed around the edges of the face and the receiving surface. Details can be found in the technical paper:  "Non-Diffuse Radiative Transfer 4:
General Procedure for Planar Area Sources and Area Receivers," D.L. DiLaura and S.R. Santoro, Journal of the Illuminating Engineering Society, Winter 1997, Vol. 26, No. 1, pp. 188-
200.
 

Illuminance at a point
The illuminance calculated at any user-specified point in a calculation zone can be of several types: Directional, TV, Maximum Spill, LEEDS Trespass, Spherical, and Constrained Maximum.
These can be obtained from two types of basic illuminance calculations: with and without one or more illuminance normals. In the former, incident flux is weighted with the cosine of the angle
between the incidence direction and illuminance normals. In the latter, the incident flux is not weighted. Spherical Illuminance, for example, uses no illuminance normal, Directional Illuminance uses
one illuminance normal at each point oriented in a fixed user-specified direction, TV Illuminance uses an illuminance normal that changes orientation from point to point, and Maximum Sill use 6
illuminance normals, one in each of the cardinal directions.
Illuminance is determined in a two-step process. An illuminance is calculated using an appropriate method and assuming the light source has an unobstructed view of the illuminated point. Then, if
potential occluding objects are detected (surfaces, other luminaires) an occlusion factor is calculated, ranging from 0.0 to 1.0, from full occlusion to no occlusion, and is used as a multiplier for the
illuminance, reducing it if appropriate.
The occlusion factor is determined by ray-casting. An angularly uniform spray of rays is established between the illuminated point and the surface of the source. The angular separation is ½
degree. The number of rays intercepted by luminaires or surfaces is determined. If a ray is intercepted by an opaque or diffusely transmissive surface, the surviving ray count is reduced by one. If
the only surface(s) involved have an image-preserving transmittance, the ray count is reduced by the transmittance. The occlusion factor is the ratio of the remaining ray count to the total number
of rays.

Direct illuminance at a point
Direct illuminance is that produced by a luminaire and is calculated using the numerical contour integration method described above, assuming the light source has an unobstructed view of
the illuminated point. If possible occluding surfaces are present, an occlusion factor is determined.

Interreflected illuminance at a point
Interreflected illuminance is produced by: 1) the light reflecting from surfaces that are illuminated by sources or other reflecting surfaces and, 2) light transmitted through a diffusely
transmissive surface illuminated from the opposite side. In both cases, the source is assumed to be perfectly diffuse (either because it is diffusely reflective or diffusely transmissive) and
has a uniform exitance.
The illuminance at a point with an illuminance normal is calculated from the equation:

Where Ei is the illuminance at the point due to the ith diffusely luminous surface, Mi is the uniform surface exitance, Ci is the unoccluded geometric configuration factor from the point to the
luminous surface, and ai is the occlusion factor. The total interreflected illuminance at the point is the summation of that produced by all the diffuse surfaces:

The configuration factors are purely geometric quantities and the standard equation is used for a point and a planar polygon. Details can be found in the IES Lighting Handbook, Chapter 10.
The illuminance at a point with no illuminance normal is calculated from the equation:
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In this case, wi is the solid angle subtended at the point by the luminous surface. The total illuminance is the summation over all the diffuse surfaces.

Discrete Radia�ve Transfer (Radiosity)
Interreflected illuminance calculations require the exitance of diffusely reflecting and transmitting surfaces. The exitance of these surfaces originates from light incident directly from sources
(referred to as initial light or initial flux) which is increased by the interreflection of light between surfaces. This is known as Radiative Transfer Analysis and is also referred to as Radiosity.
The procedure is described, in outline in the IES Lighting Handbook, Chapter 10.
The computational procedure has two essential characteristics: otherwise continuous surfaces are broken up or discretized into small subsurfaces, and each subsurface is characterized
by a single exitance produced by initial and interreflected light. How accurately the collection of uniform, individual exitances represent the actual exitance distribution across a large surface
depends on the shape of the surface and its illumination conditions. The Visual calculation engine discretizes user-specified surfaces using several criteria and produces subsurfaces of
sufficient number to balance necessary accuracy with computational time. This discretization process and the other aspects of the radiative transfer analysis used in the Visual calculation
engine are described in the following sections.
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13.2.3 Geometric and Photometric Analysis
The first stage of user-specified surface discretization is purely geometric and involves two criteria: shape and proximity.

Discre�za�on based on shape
All surfaces handled by the Visual calculation engine are assumed to have four vertices, that is, they are planar quadrilaterals. User specified surfaces with more than four vertices are
analyzed with three discretization algorithms; the best discretization is a balance between subsurface shape and number.

An L-shape room with a partition and two suspended linear direct luminaires
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Shape discretization divides the floor and ceiling so that they are comprised of quadrilaterals.                                                                   

Discre�za�on based on proximity
The proximity criteria for discretization accounts for the presence of neighboring or intersecting surfaces are like to produce large exitance differences across the intersected surface.
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Proximity discretization further discretizes the floor and a wall since they are intersected by the partition.

Discre�za�on based on illuminance gradient
After geometric and proximity, a third criterion is applied to further discretize subsurfaces: a discretization is made along any large illuminance gradients on a subsurface. An array of low-
precision illuminances is calculated across a surface which consist of direct illuminance and illuminance produced by light reflected (only) once from other surfaces. Occlusion is accounted
for. Neighboring illuminances are compared and if the ratio is greater than 3:1, the subsurface is further discretized there.

 
Photometric discretization finds large gradients in illuminance and further discretized subsurfaces. In this case, the walls contain gradients caused by both shadowing from the partition and
the distribution of the luminaires.

Discre�za�on of image-preserving or diffusely transmissive surfaces
These surfaces are a special case. Any user-specified surface with an image-preserving transmittance is not discretized for any reason.
Any user-specified surface with a diffuse transmittance is, like other surfaces, considered as two surfaces, back-to-back. In this case, the original coupling between the two is maintained
throughout the entire computational process. If one surface of the pair is subjected to geometry or photometric discretization, that discretization is performed on its back-to-back partner.
Thus, both surfaces are subject to discretization due to factors that affect either side. The result is a set of back-to-back subsurface pairs.
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13.2.4 Occlusion
The three-part discretization process results in a set of subsurfaces used in the subsequent radiative transfer analysis. In most cases, any one subsurface of this system does not have an
unobstructed view of all other subsurface. Subsurfaces may be facing away from each other or the line of sight between partially or fully occluded by other surfaces.
An array of occlusion factors is found that describes view that all subsurfaces have of all other subsurfaces. Ray-casting is used to find these factors. Somewhat like the occlusion process
described above, an array of points is established on a subsurface; the density determined adaptively by the proximity of the other subsurface of the pair being considered. From each of these
points, an angularly uniform spray of rays is established to the other subsurface. The fraction of all these rays that are not either fully occluded (by opaque surfaces) or partially occluded (by image-
preserving transmissive surfaces) establishes the occlusion factor between the pair of subsurfaces.



13.2.5 Form Factors
The final determination of the exitance on each subsurface requires knowing the fraction of direct flux that the subsurface can radiatively exchange with all other subsurfaces. Since the surfaces
are assumed to be perfectly diffuse, these surface exchange factors are purely geometric and are called Form Factors. They are determined in a two-step process: the unoccluded form factor for
a pair of subsurfaces is determined and then modified by the occlusion factor for the pair.
Unlike configuration factors, there is no single, simple equation that can be used to calculate form factors. A numerical double contour integration process is used. See the technical article:
“Calculation of Occluded Radiative Exchange Form Factors,” DiLaura, D.L., LEUKOS, July 2006, Vol 3, No. 1, pp. 51-67.
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13.2.6 Ini�al Flux
The final determination of the exitance on each subsurface requires knowing the total initial or direct flux onto each subsurface. These fluxes are determined in a two-step process: the unoccluded
flux from a source onto a subsurface is determined and then modified by the occlusion factor for the source-subsurface pair.
The numerical double contour integration process described above is used to determine the unoccluded flux and the result multiplied by the appropriate occlusion factor. For flux accounting
purposes, the flux arriving to each subsurface from each source in the system is recorded.  If it is determined that a source is completely surrounded by subsurfaces, it is possible to check that
the total flux involved for the source is correct. The total flux to all surfaces from that source should equal the known total emitted by the source (luminaire lumens). Any imbalance is corrected on
each surface, the correction being weighted by the amount of flux onto the surface.  In this way and in most cases, the flux from each source distributed to all subsurfaces exactly equals the total
source emitted flux.
Using the initial flux and the subsurface area, the initial illuminance on each subsurface can be determined.
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13.2.7 Final Illuminance
Determining the exitance at each subsurface after all interreflections (called the final exitance) involves solving a system of equations that contain the initial illuminances, diffuse reflectances, and
radiative exchange form factors. Details are in the IES Lighting Handbook, Chapter 10.
If any of the subsurfaces are diffusely transmissive, the system of equations is expanded to include the flux that back-to-back diffusely transmissive subsurfaces exchange with each other,
modeling the flux that is transmitted through the original transmissive surface.
The system of equations is solved iteratively and the result is the final illuminance on each subsurface, accounting for all interreflections. Multiplication by the reflectance gives the final exitance.
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13.2.8 Processing Calcula�on Zones
When the radiative transfer analysis is complete, all information required to determine the direct and interreflected illuminance at points in a user-specified calculation zone is available. The
process used to determine the illuminances is described in the section "Illuminance at a Point" above.
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Rendering  Rendering showing component triangles

13.2.9 Rendering
The Visual calculation engine can produce most of the data required to display a photometrically accurate rendering of a project. The assumptions underlying the calculations are the same as
those for the general radiative analysis of the project; the most important are diffuse reflectance and spectral flatness. Since all surfaces are diffuse, the calculations required for a rendering can be
performed once and provide all the data required for any view of the project desired by the user. Thus, changing views or navigating through the project does not require recalculation, only a
change of the subset of data which is displayed.

Basic procedure
The basic procedure used in the Visual calculation engine to generate renderings has three steps: 1) generate arrays of triangles that cover user-specified surfaces and have exitances that are
photometrically accurate, 2) display these triangles in an appropriate geometric and screen-luminance manner, and 3) refine the rendering with multiple calculation passes  to more accurately
model surface exitance distributions.

Genera�ng triangles and their exitances

Illuminance arrays on user surfaces
The determination of the necessary triangles begins with an array of illuminances calculated on a user-specified surface. At each point in this array, the possibly-occluded direct and
interreflected illuminance is calculated. This is a double-pass process: after the illuminances at each grid point are determined, each 2-point x 2-point subsection of the grid is
examined for high gradients. If a high gradient is present, that subsection is arrayed with additional, more tightly spaced points. Illuminances are calculated at each of the points in each
such subgrid during a second pass. This brings out necessary detail in the exitance distribution on the surface while minimizing calculation time.

Contouring
Based on the project type, and the range and gradients of illuminance found in the array, points defining up to 256 iso-illuminance contour lines are determined. The points along a
contour vary in spacing; small spacing where the line is highly curved, and large where the line is straight.

Added illuminance points
To provide for necessary detail, additional illuminances are calculated along the lines that form the boundary of the surface and along lines defined by the intersection of the surface
with other surfaces in the project. These additional illuminances help define sharp shadows and accurately portray touching surfaces.

Triangulariza�on
A collection of triangles is built from the points along the contour lines and the added illuminance points. Constrained Delaunay triangularization is used. The constraints are the edges
formed by the sections of contour line, and the sections connecting the points along the additional lines of illuminance. The outline of resulting triangles can be toggled on and off in a
rendering with the 7-key.

Displaying and scaling triangle exitances to screen gray scales
     

Mul�ple rendering passes
As each surface to be rendering in the project is processed, a record is kept of the number and extent of high gradients. If adaptively determined re-rendering criteria are met, the surface is
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Rendering of a dome without curve approximation  Rendering of a dome with curve approximation

flagged for an additional rendering calculation pass.
After all surfaces have been processed, the Visual user interface takes the triangle data provided by the calculation engine and generates the rendering display. Meanwhile, the calculation
engine processes all surfaces that have been flagged for additional work. In this addition pass, the density of all illuminance points on the surface is incremented and the calculation-
triangularization process outlined above is repeated. Not all surfaces may require additional calculation.
When the engine completes processing these flagged surfaces, the Visual user interface updates the data it has on all surfaces, replacing previous data for a surface with any that was
generated during the addition rendering computation.
This entire process is repeated up to four times. Each time the rendering calculations are performed on a denser grid of points. It is usually the case that the list of surfaces that are
recalculated and updated gets smaller with each pass.

Approxima�ng the appearance of curved surfaces
Surfaces handled in the Visual calculation engine are planar. In many cases any array of these approximates the surface of a dome, or a column, or a curved wall. To make renderings of such
surfaces more realistic, special processing can be invoked, at the discretion of the user, to more faithfully render them by eliminating the abrupt change in exitance that is otherwise present on
either side of an edge shared by surfaces that meet at even a slight angle.
If a user-specified surface meets another at an angle less than 20-degrees then the illuminance normals used in the surface illuminance calculation are modified. All edges of a surface are
examined to see if the angle to the adjoining surface is less than 20-degrees. If so, the normal at the vertices involved are changed from that of the original planar surface (which is the default
case) to an average formed with the normals of the original surface and those adjoining it at the required small angle. These new, interpolated normals can spread outward, defining a convex
surface, or bend inward, defining a concave surface.
The position and orientation of the vertex normals are used to define a new, temporary convex or concave surface that passed through the original surface vertices. This temporary surface is used
to define new calculation points and illuminance normals than produce illuminances for a local, curved surface. These points and illuminances are used in the manner described above to generate
rendering triangles.
    

 

Colorized surfaces

Luminaire models
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13.2.10 Dayligh�ng
Visual can perform daylighting calculations and provide daylighting renderings in a single-instance mode; that is, for a particular place at a particular time. The basic calculation procedure is that
same as that described for electric lighting; with the sky and sun considered as additional light sources.

Addi�onal data
To add the sky and sun as light sources, additional user data is required; used to find either the appropriate weather data from the Visual Weather Database, or to calibrate a CIE sky
specified by the user. In addition, the diffuse reflectance of the surrounding ground plane must be specified, as well as glazing information.

Project loca�on
Location is specified by Longitude and Latitude, specified in degrees. Positive and negative values of Latitude specify north and south the equator, respectively. Positive and negative
values of Longitude specify east and west values from the Prime Meridian at Greenwich England. Longitude and Latitude are input by the user of come automatically from the Visual
user interface Site Locator.

Project orienta�on
The default orientation of the Visual project site is that sky and sun North (geographic North) corresponds to +y in local Visual coordinates. A project orientation angle changes the
relative angular position of the sky and sun with respect to the project. Positive values, in degrees, rotate the site clockwise when viewed from above. NB: this does NOT change the
significance of the local Visual coordinates nor does it rotate the Visual drawing.

Date and �me of analysis
Date and time are local civil time. If in effect, daylight saving time should be indicated.

Weather data
The Visual Weather Database is derived from all of the more than 2100 EnergyPlus data sets that cover most of the globe. For each location with a data set, only required radiometric or
photometric data has been extracted from the hourly data. If only radiometric data is available at a particular site, photometric data is derived using a process devised by Perez. See:
"Modeling Daylight Availability and Irradiance Components from Direct and Global Irradiance," R. Perez, P. Ineichen, R. Seals, J. Michalsky, and R. Stewart. Solar Energy. Vo. 44, No.5. pp
271-289.
In all cases, the primary photometric data that is extracted or generated for every available site are hourly values of direct solar illuminance and total horizontal sky illuminance for each data
of the year. Data in the EnergyPlus weather file for a particular site are usually constructed from several years of measurements, aggregated together to establish a Typical Meteorological
Year for that site.

Sun and Sky
The fundamental luminous properties of sun and sky are the direct solar illuminance and the total horizontal illuminance produced by the sky. These are either: 1) derived from weather data,
or 2) calculated using IES standard sun and sky parameters. See: IES Lighting Handbook, Chapter 7, Section 7.9 Formulary.
The sun is modeled as a luminous disc, ½-degree in diameter. Its luminous power is expressed as the direct, unoccluded illuminance produced on a surface with its normal pointed to the
sun. Solar position is determined from the location and local time. See: IES Lighting Handbook, Chapter 7, Section 7.1.5 Solar Position.
The sky is modeled as a luminous dome, with a relative luminance distribution determined according to ISO/CIE Standard 15469, 2nd edition. The parameters that determine the distribution
are either derived from the appropriate weather data or come directly from the standard set of parameters if the user specifies a specific CIE sky. See: "All-weather Model for Sky
Luminance Distribution – Preliminary Configuration and Validation," R. Perez, R. Seals, and J. Michalsky, Solar Energy, Vol 50, No 3, pp 235-245.
NB: Standard weather data aggregates the illuminance from a circum-solar 5-degree circular patch of the sky with the direct illuminance from the sun. Therefore, the sky is modeled with a 5-
degree hole centered on the sun.
The Visual calculation engine establishes a distance, based on the maximum extents of the project that defines the distance to the sun and the radius of the sky dome. The distance is such
that that parallax error over the extent of the project to any point on the sky dome is less than ½-degree. The sky is discretized into planar rectangles, accounting for luminance gradient.
Using the luminance distribution, element size, and sky dome radius, each discretized sky element is assigned a luminous power defined by the direct normal illuminance it produces at the
center of the Visual project.
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Sky dome approximated with planar rectangles, sized and distributed according to the luminance distribution of the sky. Notice the 5-degree hole left for the sun and its circum-solar
component.

Ground
A ground plane is automatically established around the project and horizontally positioned at Visual local z=0.0. Its reflectance is user-specified. The plane is automatically discretized into elements
that are truncated wedges surrounding the project.

Apertures, windows, and skylights
Skylight and sunlight illuminate any outward-facing user-specified surfaces and the elements of the ground plane. Occlusion by any other surfaces in taken into account. Skylight and sunlight
illuminate any surface of an otherwise inward-facing or closed set of surfaces if admitted by an aperture, window or skylight. An aperture is a user-specified opening in an otherwise opaque
surface. A window is an aperture into which a user has specified an image-preserving transmittance less than 100%. A skylight is an aperture into which a user has specified either an image-
preserving or a diffuse transmittance.

Glass transmi)ance
The image-preserving transmittance specified by the user is assumed to be the perpendicular or normal transmittance. The Visual calculation engine accounts for the reduction from this value due
to increased incident angles. The Fresnel Laws of Reflectance and Transmission are used to determine this transmittance value. This calculation is done automatically whenever flux is passing
through a surface with an image-preserving transmittance and uses the normal transmittance, the incidence angle, the number of glazing layers, and the assumed index of refraction for glass of
1.5.

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


 
Example of transmittance as a function of incidence angle for single, double, and triple glazing.
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13.3.1 Introduc�on
Visual includes the ability to display detailed Solid Models of Luminaires in Rendered and Shaded Display modes. This appendix describes the basics of building these models in Visual for
use in the program when they are not present. At the outset, the user who attempts to create a Solid Model should have a strong drafting background and be expertly familiar with both software
use and 3-D visualization and drawing.

Solid Models can be created in Visual or in any program capable of generating a
DWG file.

Note that Solid Models are included in the product database for Acuity Brands
Lighting products. The database is accessible when creating entries in the Luminaire
Schedule and model data is automatically included in Luminaire Type definitions.
See 3.2 The Luminaire Editor for more information.

 

Luminaire Solid Models are representations of Luminaires with much more
detail than the wireframe Symbols used in Visual, but yet less detail a solid model
that might be used in the mechanical engineering of a luminaire. They are related to
BIM files but are not interchangeable with those files.

 

Prior to constructing a Solid Model it is strongly suggested that models of similar
products be examined in Visual.

To view existing Solid Models, navigate to the desired product and click the Model
link in the Select a Photometric File dialog. See 3.1.z Selecting a Photometric File
for more information.

Clicking the link will open the file in the Windows application associated to DWG files
on the host computer.

 

Creating Solid Models is arguably the most advanced task in Visual and it should by no means be assumed that an advanced Visual user would be able to complete this process. The
information is provided for completeness and for the more adventurous users with drafting skills and 3-D visualization aptitude.

VISUAL SUPPORT IS NOT AVAILABLE FOR CREATING MODELS.

Unless otherwise noted, terminology used in this chapter is related to creating models in Visual. The necessary steps to create models in other software should be discernible from the Visual-
based text.
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13.3.2 Drawing Input
Creating a Solid Model will require dimensional information, and the source will vary depending on the luminaire manufacturer.

DWG files are often made available by luminaire manufacturers as part of their
Building Information Modeling efforts.

These files are a valid basis for a Visual Solid Model, but they will normally
contain a large amount of extraneous information: internal details, small parts,
material thickness, and other information that is excess baggage in Visual.

In most cases, BIM files have entirely more facets and segments than will be
necessary.

Creating a Visual Solid Model from a BIM file involves redrawing the desired
elements on top of the BIM information. It is possible to simply convert the
existing closed polygonal surfaces to solids using that command in Visual, but
this is not often practical as it will result in large files and some editing is still
necessary to ensure proper model content.

 

 

Manufacturer Specification Sheets include drawings that may not at the
outset look like they contain enough information but realize that, in Visual, Solid
Models only need to be the basic form and detail.

Most Specification Sheets are available in a PDF format that inherently has a
detailed drawing (top right) that can easily be printed on paper. The basic form
can be taken from this drawing and scaled using drafting techniques and
duplicated in Visual (bottom right)

This 2-D information is then extruded and modified (often by making logical
assumptions about product design) to achieve the desired result.

In a great deal of cases, assumptions will have to be made about louver spacing
and details in the longitudinal direction that are rarely dimensioned on
Specification Sheets. This can yield a more than acceptable model.
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13.3.3 Drawing Layers
Luminaire Solid Models will have multiple Layers to which different components and materials will be assigned.

Any number of Layers can be created to properly define the luminaire. Each different
material or component should be assigned to a different Layer.

For example, an outdoor decorative acorn luminaire would have the Layers shown at
right. These are the basics of the luminaire with additional Layers included for
available option components.

Note that internal detail not visible (i.e. reflectors behind lenses) do not need to be
drawn.

Layer creation outside of Visual is of course analogous.

 

CRITICAL:

For any luminaire that is recessed or semi-recessed, the CuttingPolygon  Layer must
be included and a solid must be constructed that indicates what portion of the surface
in which the luminaire is mounted should be removed. This allows the Solid Model to
be seen. The Color of this Layer is unimportant, but it is recommended that it be
assigned the magenta Color to avoid confusion with other elements; this color will not
likely be used for any realistic luminaire model.

This is basically the only requirement of a Luminaire Solid Model.

 

Layer Color is what is used to display the components. Any Color assigned
"ByObject" (in Visual or CAD software) is ignored.   

Recommended Colors for components are:  
Lamp - White
Refractor - White
Reflector 90% Gray (or White if a lamp is not included)
Housing - 70% Gray

What Layers are necessary is based on user preference for what components are included.
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13.3.4 Construc�on
How a Luminaire Solid Model is constructed is largely at the discretion of the creator but there are a few basic concepts to be used as a guide.

The amount of detail included should be logical. The rule of thumb would be to imagine
what basic parts of the luminaire are visible in a normal usage scenario, and most
importantly from normal viewing distances.

For example, a lensed troffer should certainly have a flange in the model, but it may
not be desirable to draw a flange and a door frame in lieu of one element that models
both components because the detail would not be seen in normal usage of Visual.

 

Models are drawn in units of inches, where "1" is one inch. In Visual, this is not the
same as the normal one foot or one meter in the normal lighting design process in the
Design Environment.

 

Ideally, files should be less than 500KB in size. Very complex models have been
created with a file size under 350KB.  

Each surface should be a "Solid" in Visual, or a 3DFace or Closed Polyline in other
software.

Surfaces can be polygonal but CANNOT be concave in shape. Every vertex must be
able to "see" all other vertices of the polygon.

Visual breaks down all surfaces into "child" triangles, so there is no direct benefit to
making high-vertex-count polygonal Solids. However, drawing nothing but triangles
can also be unnecessary; at far right, the triangles are correct but perhaps more effort
than logical. Construct what is convenient and logical.

 

Lines (Visual Background), XREFs, and blocks are ignored. This can be advantageous
in that some reference markers can be left in the file for later use. It is useful to draw
indicators of the X, Y, and Z axes on the CuttingPolygon Layer.

 

DO NOT model surfaces as having thickness. i.e. placing identical surfaces 0.060"
apart for cold rolled steel. This will effectively double the file size for detail that can't
possibly be seen in normal situations.
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Do not use too many facets (polygon sides) to model curved objects. Generally 3-6
facets per 90 degrees of arc is sufficient. This yields facet angular extent of 30
degrees or 15 degrees.

As can be seen at right, at this zoom level, 15 degrees of facet extent is more than
sufficient to approximate a circle. Zoomed out farther, 30 degrees would be
acceptable.

Use fewer facets for small details and more facets for larger details like curved
housings.

 

Do not include lamps if they aren't normally seen.

Striplights for example would include lamps. Metal halide highbays might include
lamps if extra detail was desired. Lensed troffers certainly do not need lamps in the
model.

There are numerous cases where lamps (or other details inside the luminaire might be
seen in abnormal situations (i.e. an occupant looks up at the ceiling), and in these
cases, it is up to the model creator to decide if the extra detail is of value.

LEDs can  be modeled individually, but collectively they produce a "glowing panel" in
most cases" and the recommendation is then to model an LED array as a single
Solid.

 

There is never a need to make a model look photo-realistic when it is filling the computer screen. There are remotely few situations where the model would ever be "seen" in Visual at that size.
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13.3.5 Alignment
The Luminaire Solid Model needs to be aligned properly so that the model and the Symbol coordinate.

The origin (0,0,0) should be at the center of the luminous area in all three dimensions.  

The model should have the lamp axis in line with the positive-y axis.  

Luminaires with an asymmetric distribution should have the asymmetry ("punch") in
the positive-y direction to agree with the photometric testing and reporting standards of
IES LM-63. This may require in-depth knowledge of how luminaire optics function.

 

Wall-mounted luminaires are a bit more complex in that the origin needs to be
positioned such that the Solid Model won't be stuck into a wall in Shaded or
Rendered Display Modes. This means that the origin should be at the bottom and
rear of the housing.

 

 

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


13.3.6 Verifica�on in Visual
A Solid Model should of course look correct when it is being built and Shaded Display Mode is active. It is however sometimes not obvious how luminaires are oriented in IES files.

Export the proposed Solid Model to a DWG file from Visual or other CAD software.  

To verify photometric alignment while constructing a model in Visual:   

Create a new Luminaire Type in the Luminaire Schedule.  

Import the DWG model file into the Luminaire Type definition in the Model
tab of the Luminaire Editor.  

Insert a Luminaire in the Design Window with the Place command. Make
sure the Photometric Web is on.  

Activate Shaded Display Mode and verify that the Luminaire and its
distribution are aligned properly. Switch between Wireframe and Shaded
Display Modes if necessary.
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13.4 UVGI Calcula�ons
Under construction. Contact Visual Support.
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Absolute coordinates 
Location information referenced to the global origin of (0,0,0). 

Active Plane 
The current Cardinal Plane which is the basis for coordinate information and actions. This is the plane of movement of the mouse pointer 
crosshairs. Working planes are restricted to the three cardinal orientation planes (X-Y, Y-Z, X-Z) in Visual. The working plane sequentially toggles 
through the three possibilities whenever the Tab key is pressed. The working plane may be moved incrementally in a perpendicular fashion using 
the up and down arrow keys and the Home key may be used to return the working plane to X-Y at Z=0 (grade level) at any time. 

Avg/Min 
The ratio of the average value divided by the minimum value of illuminance found within a statistical or calculation zone. Typically used as an 
indicator of lighting uniformity in area lighting projects. 

Ballast factor 
The flux of a fluorescent lamp operated on a ballast as a fraction of the flux when operated on the standard (reference) ballast specified for 
rating lamp lumens. Usually applied to Light Loss Factors. 

Base Point 
Coordinate location (X,Y,Z) used to define a starting location or direction (the base or basis) from where an object will then be placed afterward. 
Typically a Base Point is selected as part of an object such as the corner of a Wall or the center of a Luminaire. 

Boilerplate 
A standardized set of text that can be used repeatedly without being changed. For example, a specifier may use the same Luminaire Schedule or 
specification from project-to-project. 

Bulge vector 
A line that is drawn from a point to establish the tangency of an Arc segment passing through that point. 



CAD 
An acronym for Computer Aided Design, this term generally refers to graphical software used for drafting and solid modeling. Most commonly 
used in Visual to refer to imported or exported DWG and DXF files. 

Candela 
The unit of luminous intensity. 

Candlepower 
The luminous intensity of a Luminaire expressed in candelas. 

Cardinal 
Any of the fundamental directions defined by the Cartesian coordinate system (X,Y, or Z). The cardinal directions are orthogonal, or 
perpendicular in nature. 

Cartesian 
Referring to positive or negative numerical values used to define position in three-dimensional space based on the three orthogonal axes (X, Y, 
and Z) and an origin (0,0,0). Synonymous in Visual with "cardinal". 

CFL 
Compact fluorescent lamp: A low-pressure mercury electric-discharge lamp in which a fluorescing coating transforms some of the UV energy 
generated by the discharge into light. Usually shaped with two, four, or six bent tubes. 

Coefficient of variance 
A statistic that reports the ratio of the standard deviation divided by the mean value for a Calculation or Statistical Zone. 

Combo box 
An interface tool that couples a text box with a menu of choices. 

Context-sensitive 
Meaning that the referenced object may change based on different situations. 

Coordinate 
Location information usually provided in terms of (X,Y) or (X,Y,Z) components along Cartesian axes. 



Coordinates 
Location information usually provided in terms of (X,Y) or (X,Y,Z) components along Cartesian axes. 

Crosshairs 
Two thin, intersecting, orthogonal lines affiliated with the mouse pointer in the Design Environment. The crosshairs are used to pinpoint 
locations in the Design Environment and provide a 
visual cue to the plane in which the mouse pointer is moving via color. 

Destination point 
Coordinate location (X,Y,Z) used to define a relative location or direction where an object is to be placed. 

Dialog 
A window initiated on top of the main program. 

Diffuse 
Having hte properties of diffuse reflection or diffuse refraction. 

Direct component 
The portion of light from a Luminaire that arrives at a Calculation Zone without being reflected by any room surfaces. 

Downlight 
A small direct lighting Luminaire that is normally recessed into a ceiling. 

Drawing 
A graphical representation of a view of the Design Environment placed on a Page in the Print Editor. 

Drop-down menu 
A menu option revealed by left-clicking the mouse on an arrow shown on certain toolbar buttons. In Visual, the arrow is usually at the bottom of 
the button. 

DWG 
A file format commonly used in CAD software to store drawing information. Files of this type have .DWG as their file name extension and may be 
imported into Visual. 



DXF 
A file format used primarily in CAD software to transfer information from one program to another. Files of this type have .DXF as their file name 
extension and may be imported into Visual. 

Efficiency 
The ratio of lumens emitted by a Luminaire to that emitted by the lamp(s) used therein. 

Exitance 
The area density of the luminous flux leaving a surface. 

Fence 
A selection technique whereby objects are added to the selection set based upon their inclusion within a drawn rectangular (fence) region. 
Objects lying at least partially within the fence are added to the selection set. 

Floodlighting 
A system designed for lighting a large area in most cases. 

Footcandle 
A unit of illuminance. Equal to one lumen per square foot, or 10.76 lux. 

Grips 
Yellow boxes at the edges and corners of object in Print Editor that can be "grabbed" by left-click-dragging the mouse. 

Hotkey 
A keyboard link to a common command. 

Icon 
Any graphical symbol used as a means of communication in the computer interface. 

Illuminance 
The area density of the luminous flux incident on a surface. 

Interreflected 
The portion of the luminous flux from a luminaire arriving at the workplane after being reflected one or more times from room surfaces. 



Interreflection 
The multiple reflection of light by the various room surfaces before it reaches the workplane or other specified surfaces of a room. 

Iso-candela line 
A curve plotted on any appropriate set of coordinates to show the distances in various directions in space, about a source of light at which the 
intensity is the same. 

Iterative 
Repetitious or cyclical. 

Label 
An alphanumeric designation used to establish a unique correspondence between Luminaire Symbols and their associated Luminaire Type 
entries in the Luminaire Schedule 

Lamp 
A generic term for an artificial source of light. Often incorrectly called a "light bulb". 

Lamp Lumen Depreciation factor 
The fractional loss of lamp lumens at rated operation conditions that progressively occurs during lamp operation. A critical non-recoverable 
performance component of the Light Loss Factor. 

Light Loss factor 
A performance multiplier that is usually less than 1.0 accounting for recoverable and non-recoverable losses due to system degradation and 
other components. Typically composed of Lamp Lumen Depreciation, Ballast Factor, Luminaire Ambient Temperature Factor, and Luminaire Dirt 
Depreciation, but may also include numerous other factors. 

Linear 
Being along a line or straight path. 

List box 
An entry field with a down-arrow to the right indicating a finite list of options. Left Click on the down-arrow button to reveal and select from 
among the list of options. 

Lumen 
The unit of luminous flux. 



Lumen Method 
A lighting design procedure used for predetermining the relation between the number and types of lamps or Luminaires, the room 
characteristics, and the average illuminance on the workplane. It takes into account both direct and interreflected flux. 

Luminaire 
Any light emitting object, or configuration of light emitting objects, referenced within the Luminaire Schedule in Visual. Consists of photometric, 
graphical, and descriptive information. 

Luminaire Ambient Temperature Factor 
The performance multiplier accounting for temperature effects on the Luminaire. This is a non-recoverable factor and is critical for some 
Luminaires and some applications, for example, large freezers. 

Luminaire Dirt Depreciation Factor 
The fractional loss of task illuminance due to luminaire dirt accumulation over time. 

Luminaire Type 
See Luminaire. 

Luminaires 
Any light emitting object, or configuration of light emitting objects, referenced within the Luminaire Schedule in Visual. Consists of photometric, 
graphical, and descriptive information. 

Luminance 
The area density of the luminous flux leaving a surface through a given solid angle. 

Lux 
The metric standard unit of illuminance. One lux is equal to one lumen per square meter. 

Masking 
The process of removing calculation points from an existing Calculation Zone by selecting a polygonal exclusion region. 

Max/Min 
The ratio of the maximum value to the minimum value of illuminance found within a statistical or calculation zone. Typically used as an indicator 
of lighting uniformity in area lighting projects. 



Model 
The entire lighting system composed of Luminaires, Solid Objects (perhaps), and Calculation Zones. 

Models 
The entire lighting system composed of Luminaires, Solid Objects (perhaps), and Calculation Zones. 

Mounting Height 
The distance from the floor (or workplane if specified as such) to the light center of the luminaire. This may be the ceiling height in recessed 
cases. 

Page 
The electronic information representing what will be printed to make what is normally called a drawing. 

Panel 
Subdivision of the Ribbonbar menu system that group related commands using vertical dividers. 

Panels 
Subdivisions of the Ribbonbar menu system that group related commands using vertical dividers. 

Pendant 
A Luminaire suspended from the ceiling or other structure. 

Photometric 
Referring to a data file containing information related to the photometric distribution of lighting equipment. Valid files of this type typically have 
a .IES extension and adhere to the format outlined in IES LM-63. 

Photometric file 
A data file containing information related to the photometric distribution of lighting equipment. Valid files of this type typically have a .IES 
extension and adhere to the format outlined in IES LM-63. 

Photometrics 
Referring to a data file containing information related to the photometric distribution of lighting equipment. Valid files of this type typically have 
a .IES extension and adhere to the format outlined in IES LM-63. 



Pick-box 
A small square located at the center of the mouse pointer crosshairs when in selection mode. The size of the pick-box establishes the precision 
with which objects must be selected, it can be adjusted within the Options Form. 

Planar 
Two-dimensional in nature. All components lie within a single plane. 

Plane 
A two-dimensional and flat object. 

Planes 
Two-dimensional and flat objects. 

Pole 
A standard support generally used for area and site lighting projects. 

Polygon 
A closed planar figure composed of line segments with multiple angles and sides. 

Polygonal 
See Polygon. 

Polyline 
A graphical entity composed of one or more line segments continuously connected at the endpoints. 

Radius 
Related to arcs, circles, and spheres. The radius may be used to define the curvature by virtue of fact that all points on the object are equidistant 
from a center point. Any straight line from the center to a point on an arc, circle, or sphere. 

Reflectance 
The ratio of the flux actually reflected by a sample surface to that which would be reflected into the same reflected-beam geometry by an ideal, 
perfectly diffuse standard surface irradiated in exactly the same way as the sample. 

Reflection 
When light bounces off of a surface. 



Register 
A list of information kept in Visual. 

Relative coordinates 
Location information referenced to a Base Point. Usually used in commands to specify displacement. 

Specular 
A characteristic of a surface that reflects light in a directional fashion that is often image-preserving. Gloss finishes exhibit specular reflective 
characteristics as do mirrors and chrome. 

Symbol 
The graphic symbol associated with a Luminaire Type. Used to specify the location, orientation, and type of lighting equipment in drawings. 

Tab 
A user interface object found in the Ribbonbar or Sidebar comprised of graphic and text buttons grouped based on function. 

Tabs 
A user interface object found in the Ribbonbar or Sidebar comprised of graphic and text buttons grouped based on function. 

Tangent 
Related to a point on a curve, the tangent is given by the direction of a line passing through the point with an orientation perpendicular to the 
radius at that point. The tangent intersects the curve at only that location. 

Template 
A graphical representation of the illuminance produced by a single luminaire object. Lines are used to represent all points of a given illuminance 
level similar to elevation contours on a topographical map. Iso-illuminance templates are useful in determining the spacing and orientation of 
lighting equipment prior to system analysis. 

Text box 
An entry field that anticipates text entry via the keyboard. Text boxes are activated with a left-click of the mouse and present an "I-beam" cursor 
for text editing. 

Toggle button 
A button that turns a feature on when highlighted in yellow and off when not highlighted. Successive left-clicks of the mouse cycle the on/off 
state. 



Transmittance 
Transmission is when light passes through a material. 

Troffer 
A recessed lighting unit, usually long and installed with the opening flush with the ceiling. "2x4" 

Uniformity gradient 
A statistic that measures the rate of change of illuminance over a Calculation or Statistical Zone expressed as a ratio between the illuminance 
level of adjacent calculation points. 

Vector 
A linear entity having both length and directional properties. 

Vertex 
The intersection of two lines or the corner of a Solid Object. 

Vertices 
The plural of vertex. 

Window 
A selection technique whereby objects are added to the selection set based upon their inclusion within a drawn rectangular (window) region. 
Objects lying entirely within the window are added to the selection set. 

Workplane 
The plane at which work is usually done, and on which the illuminance is specified and measured. 
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Absolute Coordinates 
1.1.6 Status Bar 
2.1 Cartesian Coordinates 

Aim 
7.4.3 Place and Aim Luminaires 
7.4.4 Reaiming Luminaires 

Align Cursor and Plane to Current View 
1.1.6 Status Bar 
9.6 Align to View 

Align Cursor to Plane 
1.1.6 Status Bar 
9.5 Align to Plane 

Align to Plane 
9.5 Align to Plane 

Align to View 
9.6 Align to View 

Angle (tool) 
10.4.1 Angle Tool 

Angular Extent 
6.1 Array Polar 

Angular Separation 
6.1 Array Polar 

Arcs 
5.1.1 Arcs 

Area Tool 
10.2 Design Tools 

Array  

Polar 
6.1 Array Polar 

Rectangular 
6.2 Array Rectangular 

Audit 
4.1 Audit 

Auto Calculate 
8.5.2.2 Automatic Calculation Feature 

Automatic Recovery 
2.6 Automatic Recovery and File Backup 

Autosave 
2.6 Automatic Recovery and File Backup 

Axes, XYZ 
2.1 Cartesian Coordinates 

Axis 
5.1.2 Axis 

Background Objects 
3.1 Background Objects 
4.3.3 Circles, Rectangles, and Polygons 

Brightness 
8.6 Rendering 



CAD 
2.7 Importing and Exporting Files 
Chapter 4 - Model Construction 

Calculation Engine 
13.2 Calculation Engine 

Calculation State 
4.3.1 Calculation State 

Calculation Status and Mode 
1.1.6 Status Bar 

Calculation Type 
1.1.6 Status Bar 

Calculation Zones 

Calculation Types 
8.1.5 Calculation Types 

Color-Coding 
8.5.2.4 Color-Coding Illuminance Values 

Contours 
8.5.2.3 Setting and Displaying Contours 

Decimal Precision 
8.1.4 Calculation Zone Parameters 

Masking 
8.3.1 Masking Calculation Zones 

Offset points 
8.1.4 Calculation Zone Parameters 

On a Line 
8.1.3 Line Calculation Zones 

Parameters 
8.1.4 Calculation Zone Parameters 

Point spacing 
8.1.4 Calculation Zone Parameters 

Point Style 
8.1.4 Calculation Zone Parameters 

Power Zones 
8.2 Power Zones 

Statistical Zones 
8.4 Statistical Zones 

Unmasking 
8.3.2 Unmasking Calculation Zones 

Calculations tab 
1.1.4 Command Tabs 

Cartesian coordinates 
2.1 Cartesian Coordinates 

Circles 
5.1.3 Circles 
5.2.1 Circles 

Color 

Color Dialog 
13.1.1 Color Dialog 



HSL Color Model 
13.1.3 HSL Color Model 

Layers 
4.3.2 Colors 

Using the Color Selection Dialog 
13.1.2 Using the Color Selection Dialog  

Command Line 
1.1.6 Status Bar 
1.1.9 Command Line 
2.10.3 Command Line Entry 

Construct tab 
1.1.4 Command Tabs 

Constructing Solid Objects 
5.1.3 Circles 
5.2 Constructing Solid Objects 

Contours 
8.5.2.3 Setting and Displaying Contours 

Convert Objects 
6.3 Convert To Background 
6.4 Convert To Solid 

Coordinates 
2.10 Entering Coordinates 

Command Line Entry 
2.10.3 Command Line Entry 

Entering Coordinates 
2.10 Entering Coordinates 

Mouse Pointer Navigation 
2.10.1 Mouse Pointer Navigation 

Object Snap 
2.10.2 Object Snap 

Copy 
6.5 Copy 

Crossing window 
2.11 Selecting Objects 

Customize 
10.1 Customize Dialog 
10.6 Settings Dialog 

Design Environment 
1.1 Design Environment 

Design Manager 
4.2 Design Manager 

Design Window 
1.1.5 Design Window 

Display Mode 
9.3 Display Mode 

Distance (tool) 
10.4.2 Distance Tool 

Dollhouse 
9.3 Display Mode 

Download 
Installation, Registration and Technical Support 



Dynamic Panning 
9.1 Mouse Navigation 

Dynamic Zoom 
9.1 Mouse Navigation 

Economic Tool 
10.2 Design Tools 

Edit Text 
6.6 Edit Text 

Editability 
4.3.3 Editability 

Erase 
6.7 Erase 

Exitance 
8.1 Calculation Zones 
8.5.1.3 Exitance 

Explode 
6.8 Explode 

Export 
2.7 Importing and Exporting Files 

Extend 
6.9 Extend 

Extrude 
6.10 Extrude 

Fence (selection) 
2.11 Selecting Objects 

File 

Backup 
2.6 Automatic Recovery and File Backup 

Export 
2.7 Importing and Exporting Files 

Import 
2.7 Importing and Exporting Files 

Menu 
1.1.3 File Menu 

Firewall 
Windows Firewall 

Flatten 
6.11 Flatten 

Flood Tool 
10.2 Design Tools 

Global Axis 
9.2 Basic Viewing 

Group 
6.12 Group 

Home tab 
1.1.4 Command Tabs 

Hot Keys 
2.3 Keyboard Commands 

Illuminance 
8.1 Calculation Zones 



8.5.1.1 Illuminance 
8.5.1.2 The Components of Illuminance 

Import 
2.7 Importing and Exporting Files 

Importing and Exporting Schedules 
3.1.7 Importing and Exporting Schedules 

Incremental Snap 
4.2.2 Incremental Snap 

Interior Tool 
10.2 Design Tools 

Join 
6.13 Join 

Keyboard Commands 
2.3 Keyboard Commands 

Label 
7.1.2 Modifying a Schedule Entry 
7.4.5 Luminaire Display Options 

Layer Manager 
1.1.8 Sidebar 
4.3.5 Manager 

LEED Trespass 
8.1.5 Calculation Types 

License 
10.3 Help Tools 
Installation, Registration and Technical Support 
Visual License Agreement 

Light Loss Factor 
7.1.2 Modifying a Schedule Entry 

Light Trespass 
8.1.3 Line Calculation Zones 
8.1.5 Calculation Types 

Lines 
5.1.4 Lines and Polylines 

LLF 
7.1.2 Modifying a Schedule Entry 

Lumen Method 
10.2 Design Tools 

Luminaire 
3.3 Luminaires 
Chapter 7 - Luminaire 

Model 
13.3.1 Introduction 
7.2.2 Model Tab 

Placing and Orienting 
7.4 Placing and Orienting Luminaires 

Schedule 
1.4 Luminaire Schedule 
7.1 Luminaire Schedule 

Columns 
7.1.5 Modifying Columns 

Copying an Entry 
7.1.3 Copying a Schedule Entry 



Creating an Entry 
7.1.1 Creating a Schedule Entry 

Expanding an Entry 
7.1.4 Expanding a Schedule Entry 

Importing and Exporting 
7.1.7 Importing and Exporting Schedules 

Modifying an Entry 
7.1.2 Modifying a Schedule Entry 

Rows 
7.1.6 Modifying Rows 

Symbol 
7.2.1 Symbol Tab 

Luminaire Counter 
1.1.6 Status Bar 

Luminaire tab 
1.1.4 Command Tabs 

Luminance 
8.1 Calculation Zones 
8.5.1.4 Luminance 

Luminous Volume 
7.4.5 Luminaire Display Options 

Mask 
8.3.1 Masking Calculation Zones 

Max Spill calculation 
8.1.5 Calculation Types 

Minimize Ribbonbar 
10.5 Minimize Ribbonbar 

Mirror 
6.14 Mirror 

Modify tab 
1.1.4 Command Tabs 

Mouse 

Cursor 
2.2 Using the Mouse 

Double-click 
2.2 Using the Mouse 

Left-click 
2.2 Using the Mouse 

Right-click 
2.2 Using the Mouse 

Move 
6.15 Move 

Notes Editor 
7.3.8 Adding and Editing Text 

Object Filters 
2.11 Selecting Objects 

Object Snap 
1.1.6 Status Bar 
2.10.2 Object Snap 



Objects 

Background 
3.1 Background Objects 

Calculation Zones 
3.2 Solid Objects 

Luminaires 
3.3 Luminaires 

Solid 
3.2 Solid Objects 

Offset 
6.16 Offset 

Offset points 
8.1.4 Calculation Zone Parameters 

Origin 
2.1 Cartesian Coordinates 

Orthogonal Mode 
1.1.6 Status Bar 
2.9 Incremental Snap 

Orthographic 
9.3 Display Mode 

Panning 
9.1 Mouse Navigation 

Perspective 
9.3 Display Mode 

Photometric File 
7.1.8 Selecting a Photometric File 

Photometric File Dialog 
3.1.2 Modifying a Schedule Entry 

Photometric Report 
10.2 Design Tools 

Photometric Webs 
7.4.5 Luminaire Display Options 

Place & Aim Luminaire 
7.4.3 Place and Aim Luminaires 

Place Luminaire 
7.4.1 Place Luminaires 

Polar coordinates 
2.1 Cartesian Coordinates 

Polygons 
5.1.5 Polygons 
5.2.2 Polygons 

Polylines 
5.1.4 Lines and Polylines 

Power Density Statistics 
11.3.4 Power Density Statistics 

Power Zone 
11.3.4 Power Density Statistics 

Previous 
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